Table of Contents

Preface ........................................................................................................ viii
1. Foreword ................................................................................................. viii
2. System Requirements ................................................................................ viii
   2.1. Server(s) ............................................................................................. viii
   2.1.1. Hardware ......................................................................................... viii
   2.1.2. Software ........................................................................................... viii
   2.2. Client Workstations ............................................................................. ix
   2.2.1. Hardware ........................................................................................... ix
   2.2.2. Software ........................................................................................... ix
   2.2.3. Optional Software ............................................................................ ix
3. Content Central Concepts .......................................................................... ix
   3.1. Documents ........................................................................................... ix
   3.2. Document Types .................................................................................. x
   3.3. Catalogs ................................................................................................ x
   3.4. Capture Types ...................................................................................... xi
   3.5. Coding Methods ................................................................................... xii
4. Server Modules .......................................................................................... xii
   4.1. Web Application Server(s) .................................................................. xiii
   4.2. MS SQL Database Server(s) ................................................................. xiii
   4.3. Catalog Service ..................................................................................... xiii
   4.4. Capture Service .................................................................................... xiii
   4.5. Workflow Service ................................................................................ xiii
   4.6. Document Storage Area ....................................................................... xiii
   4.7. Search Indexes ...................................................................................... xiv
Revision History ............................................................................................ xv
I. Installation Guide ........................................................................................ 1
1. Software Installation .................................................................................. 2
   1. Introduction .............................................................................................. 2
   2. Installing Content Central ..................................................................... 2
   3. Evaluating Content Central .................................................................. 4
2. Production Configuration .......................................................................... 5
   1. Introduction .............................................................................................. 5
   2. Data Folders ............................................................................................ 5
      2.1. System Folder and Subfolders ........................................................... 5
   2.2. Incoming Folder ................................................................................... 6
   2.3. Documents Folder ............................................................................... 7
   3. Adding Proper Security Credentials to Data Folders ......................... 8
   4. Optimizing Performance ....................................................................... 8
      4.1. The ASP.NET State Service .............................................................. 8
      4.2. ASP.NET Impersonation ................................................................. 9
5. Configuration Manager ............................................................................ 10
   5.1. SQL Settings ....................................................................................... 11
   5.2. System Folders ................................................................................... 11
   5.4. Licensing ............................................................................................ 12
   5.5. External Applications [Enterprise Edition] ....................................... 13
II. Administration Guide .............................................................................. 17
3. Catalog Manager ....................................................................................... 18
   1. Introduction ............................................................................................. 18
   2. Catalog Manager .................................................................................... 18
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.1. Creating a New Catalog</td>
<td>18</td>
</tr>
<tr>
<td>2.1.1. Using the Wizard to Create a New Catalog</td>
<td>19</td>
</tr>
<tr>
<td>2.2. Managing Catalogs</td>
<td>21</td>
</tr>
<tr>
<td>2.2.1. Capture Jobs</td>
<td>22</td>
</tr>
<tr>
<td>2.2.2. Advanced Catalog Settings</td>
<td>26</td>
</tr>
<tr>
<td>4. Web Site Administration</td>
<td>27</td>
</tr>
<tr>
<td>1. Introduction</td>
<td>27</td>
</tr>
<tr>
<td>2. Web Site Configuration</td>
<td>27</td>
</tr>
<tr>
<td>2.1. The Admin Menu</td>
<td>27</td>
</tr>
<tr>
<td>2.2. System Settings</td>
<td>28</td>
</tr>
<tr>
<td>2.3. External Data Sources (ODBC) [Enterprise Edition]</td>
<td>35</td>
</tr>
<tr>
<td>2.3.1. Adding or Modifying a Data Source</td>
<td>36</td>
</tr>
<tr>
<td>2.3.2. Deleting a Data Source</td>
<td>37</td>
</tr>
<tr>
<td>2.4. Users</td>
<td>37</td>
</tr>
<tr>
<td>2.4.1. Adding User Accounts Manually</td>
<td>38</td>
</tr>
<tr>
<td>2.4.3. Modifying an Existing User's Profile</td>
<td>40</td>
</tr>
<tr>
<td>2.4.4. Adding a Group to a User Account</td>
<td>40</td>
</tr>
<tr>
<td>2.4.5. Modifying Document-Type Permissions</td>
<td>41</td>
</tr>
<tr>
<td>2.4.6. Assigning Catalogs to a User</td>
<td>41</td>
</tr>
<tr>
<td>2.4.7. Deleting a User Account</td>
<td>42</td>
</tr>
<tr>
<td>2.5. Groups</td>
<td>42</td>
</tr>
<tr>
<td>2.5.1. Adding or Modifying a Group</td>
<td>43</td>
</tr>
<tr>
<td>2.5.2. Adding a User to a Group</td>
<td>44</td>
</tr>
<tr>
<td>2.5.3. Modifying Document-Type Permissions</td>
<td>44</td>
</tr>
<tr>
<td>2.5.4. Deleting a Group</td>
<td>45</td>
</tr>
<tr>
<td>2.6. Global Fields</td>
<td>45</td>
</tr>
<tr>
<td>2.6.1. Adding or Modifying Global Fields</td>
<td>46</td>
</tr>
<tr>
<td>2.6.2. Field Details</td>
<td>46</td>
</tr>
<tr>
<td>2.6.3. Deleting a Global Field</td>
<td>50</td>
</tr>
<tr>
<td>2.7. System Fields</td>
<td>50</td>
</tr>
<tr>
<td>2.8. Catalogs &amp; Document Types</td>
<td>52</td>
</tr>
<tr>
<td>2.8.1. Creating a New Catalog or Document Type</td>
<td>52</td>
</tr>
<tr>
<td>2.8.2. Renaming a Catalog or Document Type</td>
<td>53</td>
</tr>
<tr>
<td>2.8.3. Deleting a Catalog or Document Type</td>
<td>54</td>
</tr>
<tr>
<td>2.8.4. Setting a Default Document Type</td>
<td>55</td>
</tr>
<tr>
<td>2.8.5. Membership</td>
<td>55</td>
</tr>
<tr>
<td>2.8.6. Permissions</td>
<td>57</td>
</tr>
<tr>
<td>2.8.7. Document-Type Fields</td>
<td>59</td>
</tr>
<tr>
<td>2.8.10. Approval Processes [Enterprise Edition]</td>
<td>67</td>
</tr>
<tr>
<td>2.8.11. Workflow [Enterprise Edition]</td>
<td>76</td>
</tr>
<tr>
<td>2.8.13. Folder &amp; File Building</td>
<td>76</td>
</tr>
<tr>
<td>2.8.16. Default Search Fields</td>
<td>82</td>
</tr>
<tr>
<td>2.8.17. Default Results Fields</td>
<td>83</td>
</tr>
<tr>
<td>2.9. Packet Templates [Corporate Edition and higher]</td>
<td>84</td>
</tr>
<tr>
<td>2.9.1. Adding or Modifying a Packet Template</td>
<td>85</td>
</tr>
<tr>
<td>2.9.2. Deleting a Packet Template</td>
<td>86</td>
</tr>
<tr>
<td>2.10.1. Adding or Modifying Message Templates</td>
<td>87</td>
</tr>
</tbody>
</table>
2.10.2. Message-Template Details ......................................................... 87
2.10.3. Duplicating a Message Template ........................................... 88
2.10.4. Deleting a Message Template ................................................... 89
2.10.5. Message-Template Codes ......................................................... 89
2.11. Workflow [Enterprise Edition] .................................................... 91
   2.11.1. Introduction ................................................................. 91
   2.11.2. Workflow Triggers .......................................................... 92
   2.11.3. Workflow-Trigger Types ................................................... 94
   2.11.4. Workflow-Trigger Requirements and Options ......................... 98
   2.11.5. Workflow Actions ........................................................ 105
   2.11.6. Workflow-Action Types ................................................... 107
   2.11.7. Workflow Rules .......................................................... 109
   2.12.1. Adding or Modifying Templates .......................................... 112
   2.12.2. Adding or Modifying Data Elements .................................... 113
   2.12.3. Changing the Order of Data Elements .................................... 114
   2.12.4. Deleting a Data Element ................................................ 114
   2.12.5. Renaming a Template ..................................................... 114
   2.12.6. Deleting a Template ..................................................... 115
   2.13.1. Adding or Modifying Templates .......................................... 116
   2.13.2. Downloading a Report ..................................................... 123
   2.13.3. Deleting a Template ..................................................... 123
   2.14.1. Adding or Modifying Custom Menu Items ............................... 124
2.15. Themes [Enterprise Edition] .................................................... 125
   2.15.1. Adding or Modifying Themes ............................................. 126
   2.15.2. Deleting a Theme ......................................................... 129
2.16. Event Viewer ................................................................. 129
3. Finishing Up ............................................................................. 130
III. User Guide ........................................................................... 132
   5. Introduction ........................................................................... 133
   1. User Interface ........................................................................ 133
   2. The Main Menu ....................................................................... 133
   3. The Dashboard ....................................................................... 133
   4. The Results Grid ..................................................................... 134
   5. User Options .......................................................................... 135
      5.1. User Profile ....................................................................... 135
      5.2. Preferences ....................................................................... 136
      5.3. Downloads and Installers ..................................................... 137
      5.4. Address Book .................................................................... 138
         5.4.1. Adding or Modifying a Contact ....................................... 139
         5.4.2. Deleting One or More Contacts ....................................... 139
      5.5. Saved Searches .................................................................. 139
         5.5.1. Modifying a Saved Search ............................................. 139
         5.5.2. Deleting a Saved Search ............................................... 140
      5.6. Default Document Types .................................................... 140
      5.7. Search Fields .................................................................... 140
      5.8. PIN ................................................................................ 141
      5.9. DocType Results Fields ....................................................... 141
      5.10. Grid Results Fields ......................................................... 142
      5.11. Event Viewer .................................................................... 143
   6. Getting Help .......................................................................... 144
   6. Capturing Documents ............................................................ 145
1. Capturing Paper Documents - DirectScan™ .......................................................... 145
   1.1. Pre-Capture Coding ..................................................................................... 145
   1.2. Post-Capture Coding ............................................................................... 146
   1.3. Versatile Coding ....................................................................................... 146
   1.4. OCR Only .................................................................................................. 147
   1.5. Using The DirectScan™ Applet ................................................................. 148
       1.5.1. Image Reviewing Tools ...................................................................... 149
2. Capturing Paper Documents - QCards™ .............................................................. 149
   2.1. Pre-Capture Coding ............................................................................... 149
   2.2. Post-Capture Coding ............................................................................... 151
   2.3. Versatile Coding ....................................................................................... 152
   2.4. OCR Only .................................................................................................. 153
3. Capturing Paper Documents - Document-Type QCard™ .................................... 154
   3.1. Creating a Document-Type QCard™ ......................................................... 154
4. Capturing Paper Documents - QCard™ Packet ..................................................... 155
   4.1. Creating a QCard™ Packet ....................................................................... 155
5. Capturing Paper Documents - Custom Barcode .................................................... 156
6. Capturing Electronic Documents ......................................................................... 157
   6.1. Using the Capture Frame ......................................................................... 157
       6.1.1. Pre-Capture Coding ......................................................................... 158
       6.1.2. Post-Capture Coding ....................................................................... 159
       6.1.3. Versatile Coding ............................................................................... 159
       6.1.4. Capture Only .................................................................................... 160
   6.2. Using the Drag & Drop Upload Applets ....................................................... 161
       6.2.1. Using the Context Menu or File Menu .............................................. 161
       6.2.2. Using the Results-Frame Upload Area .............................................. 162
7. Creating New Documents From PDF-Form Templates ........................................... 163
8. The Coding Queue .............................................................................................. 164
7. Searching for Documents .................................................................................... 166
   1. Search Procedures ...................................................................................... 166
   2. Searching by Packet ................................................................................... 168
   3. QuickSearch ............................................................................................... 168
   4. Saving Search Results ................................................................................ 168
8. Managing Documents .......................................................................................... 170
   1. Introduction .................................................................................................. 170
   2. Viewing a Document in the Browser ............................................................ 170
   3. Streaming a PDF Document ....................................................................... 171
   4. Downloading Documents .......................................................................... 171
   5. E-mailing Documents .................................................................................. 172
   6. Faxing Documents ...................................................................................... 173
   7. Appending to a Document .......................................................................... 174
       7.1. Appending by DirectScan™ ................................................................. 174
       7.2. Appending by QCard™ ....................................................................... 175
       7.3. Appending by Electronic Upload ......................................................... 175
   8. Replacing a Document ................................................................................ 175
       8.1. Replacing by DirectScan™ ................................................................. 176
       8.2. Replacing by QCard™ ....................................................................... 176
       8.3. Replacing by Electronic Upload ........................................................... 177
9. Editing Documents .............................................................................................. 177
   9.1. Content Director ...................................................................................... 177
       9.1.1. Installation ....................................................................................... 177
       9.1.2. Settings ........................................................................................... 178
   9.2. Content Central Office Integration ............................................................... 178
       9.2.1. Settings ........................................................................................... 179
 Contents

 9.2.2. Capturing New Documents .................................................. 180
 9.2.3. Checking Out a Local Document ............................................ 181
 9.3. Editing a Document ................................................................. 181
 9.4. Uploading Changes using CCOI .................................................. 181
 9.5. Uploading Changes without using CCOI ....................................... 182

10. Editing Document Properties ...................................................... 182
12. Viewing a Packet ................................................................. 184
13. Renaming a Document File Name ................................................ 185
14. Deleting Documents ............................................................... 185
15. Uploading Revisions ............................................................... 186
16. Checking Out/Checking In Documents ........................................... 186
   16.1. Checking Out Documents .................................................... 186
   16.2. Checking In Documents ..................................................... 188

17. The Approval Queue [Enterprise Edition] ....................................... 190
   17.1. Approving ................................................................. 191
   17.2. Rejecting ............................................................... 191
   17.3. Assigning to an Approval Process ....................................... 192
   17.4. Setting Priorities ....................................................... 193
   17.5. The Admin Queue [Administrators] ....................................... 193
   17.6. History [Administrators] ................................................... 193

   18.1. Assigning or Moving Documents to a Work Queue ....................... 194
   18.2. Sharing Documents ........................................................ 195
   18.3. Removing Documents ..................................................... 196
   18.4. The Admin Queue [Administrators] ....................................... 196
   18.5. Changing Expirations ...................................................... 196

   19.1. Defining Custom Retention Policies ..................................... 197

20. The Catalog Browser ............................................................... 198
   20.1. Cut, Copy, & Paste ....................................................... 199
       20.1.1. Cut & Paste (Move) ................................................ 199
       20.1.2. Copy & Paste (Copy) ............................................. 200
   20.2. The Context Menu ........................................................ 200
   20.3. Assigning Document Types to Folders [Administrators] ............ 200

9. The Messages Folder .................................................................. 202
10. Mobile Site ............................................................................. 204
   1. Connecting to the Mobile Site ................................................. 204
   2. The Main Menu .................................................................. 204
   3. The Approval Queue ........................................................... 205
   4. The Catalog Browser ........................................................... 206
       4.1. Folder View ............................................................... 206
       4.2. File View .................................................................. 206

IV. Advanced Features ................................................................ 207
11. Creating Multiple Catalogs from a Template (Batch Creation) .......... 208
A. Supported File Types with Existing Content .................................. 213
   B. Advanced Search Syntax ...................................................... 215
       1. Search Requests ........................................................... 215
       2. Words and Phrases ........................................................ 215
       3. Wildcards .................................................................. 216
       4. Fuzzy Searching ........................................................... 216
       5. Phonic Searching ........................................................... 216
       6. Stemming .................................................................. 216
       7. Numeric Range Searching ................................................. 217
8. AND Connector ................................................................. 217
9. OR Connector ............................................................... 217
10. W/N Connector ............................................................. 217
11. NOT and NOT W/N .......................................................... 218
C. Supported Bar Code Symbologies ...................................... 219
D. Supported ODBC Providers .............................................. 220
Preface

1. Foreword

When we at Ademero set out to design a document management system, we wanted to provide the framework and feature set that you the user have requested over the years. We believe Content Central has accomplished just that. We respect your thoughts and opinions and consider all feedback we receive from our customers. Always feel free to drop us a line via phone, Web, or e-mail. Customer satisfaction is our primary goal.

We’ve attempted to write this documentation in a way that provides concepts and definitions first and foremost before instructions. If for any reason any part of this document is unclear or the product does not perform as indicated or expected, please contact our support center below for a quick response and resolution to the issue you’re experiencing. We pride ourselves on customer service; that's why we offer our support to you 24 hours-a-day, 7 days-a-week on any day of the year.

Ademero Support Channels

Phone (863) 937-0272
Toll-Free (888) 276-2914
E-mail support@ademero.com
Web Site http://www.ademero.com/

2. System Requirements

2.1. Server(s)

Content Central requires at least one PC-based server platform for product installation.

2.1.1. Hardware

Minimum Requirements

• 2GHz Dual-Core Processor
• 2GB RAM
• 80GB Redundant Storage Space

Recommended Hardware

• Quad-Core Intel® Xeon® Processors
• 4GB RAM
• 250GB Redundant Storage Space

2.1.2. Software

Content Central (server software) runs only on Microsoft® Windows® operating systems.
• Microsoft® Windows® XP Professional or higher (Windows Server 2008 or higher recommended)
• Microsoft® Internet Information Services (IIS) 5.0 or higher (7.0 or higher recommended)
• Microsoft® .NET Framework 3.5 or higher (included in the Content Central installation package)
• Microsoft® SQL Server 2005 or higher (SQL Server 2008 Express Edition included in the Content Central installation package)

2.2. Client Workstations

Content Central does not require software to be installed on client workstations. The client should contain an operating system and a Web browser. An optional PDF viewer (such as Adobe® Reader®) can be used to view captured paper documents.

2.2.1. Hardware

**Minimum Requirements**
• 2GHz Processor
• 1GB RAM

**Recommended Hardware**
• 2.5GHz Dual-Core Processor
• 2GB RAM

2.2.2. Software

• Microsoft® Windows® 2000 or higher (Microsoft® Windows® XP Pro or higher recommended); or
• Mac® OS X or higher
• Microsoft® Internet Explorer 7.0 or higher; or
• Mozilla Firefox® 3.0 or higher
• Sun Microsystems® Java™ runtime environment (JRE) 6.0 or higher

2.2.3. Optional Software

• Browser-based PDF viewer
• TWAIN driver for any scanner you wish to use with the DirectScan™ applet

3. Content Central Concepts

This section identifies the key concepts behind how this document management system operates. This information will help you throughout the rest of this document.

3.1. Documents

A document is represented as a file on the file system. What sets a document apart from other files is its use. documents usually contain text or other data that can be searched for retrieval. Common document formats
include PDF [Definition: Portable Document Format], Microsoft® Word®, and Microsoft® Excel®. Some document formats contain content and/or metadata that may be inherited when imported. For a full list of these file types, see Appendix A, Supported File Types with Existing Content.

Document properties, also known as index fields, tags, or metadata, provide a classification system that helps you find documents more quickly and accurately in Content Central.

Note
Ademero strongly recommends the use of document properties when capturing information.

When paper images have been captured from a scanner or other input device, Content Central converts them to PDF files. The PDF format conveniently stores images, text, and document properties in one file.

3.2. Document Types
Each document is described by a document type, which serves as a template for the document. Unique security permissions, fields for document properties, and more can be defined at the document-type level. Each document inherits these settings when captured.

3.3. Catalogs
A catalog contains information about a related set of documents in the system. You can create as many catalogs as needed. Catalogs usually take the form of an existing business department or business process. The information stored in a catalog is as follows:

- Document types
  - User & Group Permissions
  - Fields (metadata)
  - Text-Recognition Zones (Zonal OCR)
  - Barcode-Recognition Zones (Zonal Barcode)
  - Field-Lookup Integration
  - Approval Processes [Enterprise Edition]
  - Workflow Rules [Enterprise Edition]
  - Message Templates [Enterprise Edition]
  - Folder & File Building
  - Capture Forms
  - Retention Policy
  - Search & Results Display Fields
- Documents
  - Document Name (file name)
Catalogs are created and managed by Content Central and are stored within the SQL database designated for Content Central.

### 3.4. Capture Types

<table>
<thead>
<tr>
<th>Capture Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DirectScan™ (Browser)</td>
<td>This Java™ applet allows users to scan paper into the Web browser using a TWAIN-compliant scanner.</td>
</tr>
<tr>
<td>QCard™ (Browser, Monitored Folder, E-mail)</td>
<td>QCards™ contain barcodes used to identify individual paper documents in a batch. Users can create and print QCards™ from their Web browser. QCard™-attached documents can be scanned to the Web browser using the DirectScan™ applet, saved to a monitored folder, or sent to a monitored e-mail address.</td>
</tr>
<tr>
<td>CustomBarcode (Browser, Monitored Folder, E-mail)</td>
<td>Pages containing barcodes may be used to identify the beginning of paper documents in a batch. The information provided within the barcodes may be assigned to field data automatically. The paper documents can be scanned to the Web browser using the DirectScan™ applet, saved to a monitored folder, or sent to a monitored e-mail address.</td>
</tr>
<tr>
<td>PDF Form (AcroForm/XFA) (Browser)</td>
<td>New documents can be generated by filling out a PDF form based on a template in the system.</td>
</tr>
<tr>
<td>Drag &amp; Drop Upload (Browser)</td>
<td>Users can drag one or more folders and files to one of two Java™ applets in the Web browser.</td>
</tr>
<tr>
<td>Single Upload (Browser)</td>
<td>Users can browse to a single file, classify it if desired, and upload it using the Web browser.</td>
</tr>
<tr>
<td>Multi Upload (Browser)</td>
<td>Users can browse to one or more folders and files and upload them using the Web browser.</td>
</tr>
<tr>
<td>Electronic (Monitored Folder, E-mail)</td>
<td>Files can be saved to a monitored folder or sent to a monitored e-mail address. They will be left in their native format and can be routed to either the Coding Queue or directly to a catalog.</td>
</tr>
<tr>
<td>Image-Only (Monitored Folder, E-mail)</td>
<td>Scanned images (TIFF, PDF, JPEG, BMP, PNG, GIF) can be saved to a monitored folder or sent to a monitored e-mail address. They will be converted to fully-searchable PDF files and can be routed to either the Coding Queue or directly to a catalog.</td>
</tr>
<tr>
<td>XML (Monitored Folder, E-mail)</td>
<td>Files can be identified with XML descriptors and saved to a monitored folder or sent to a monitored e-mail address. The XML file can contain document properties used to classify the document when captured. The target catalog and document type can also be defined in the XML file. For more information on</td>
</tr>
</tbody>
</table>
3.5. Coding Methods

**Pre-Capture Coding**

Users select a catalog and document type and provide document properties before the capture process. Content Central automatically converts and routes these documents to their storage areas without the need for further user intervention.

**Post-Capture Coding**

Users designate the catalog, document type, and document properties after the capture process. Content Central routes these documents to the user's Coding Queue where they await catalog and document type selection and document properties coding. After a user codes a document in the Coding Queue, the document is routed to the storage area. Users who capture with this method will find the documents in their personal Coding Queue. The nature of a Post-Capture Coding QCard™ allows the user to reuse the same QCard™.

**Versatile Coding**

Users select a catalog, document type and Coding Queue Destination to which the document should be sent, and are given the option to provide document properties before and/or after capture. Documents will be routed to the Coding Queue for review and additional document properties before being routed to the storage area.

**OCR Only / Capture Only**

Users select a catalog and document type before capture, but document properties will not be added to these documents. Only the OCR process (images) or capture process (electronic) will be performed, and each document will be routed to its storage area using the filename from the original image or electronic file.

4. Server Modules

The complete Content Central application consists of seven server modules. Each server module can reside on separate, physical servers or be combined on one server. In high-volume environments, e.g., more than 100 active users and/or more than 10,000 captured pages per day, it may be wise to provide a server for each of the modules. This will greatly improve performance. In low to medium-volume environments all modules can typically run on the same physical server without any performance degradation. When more than one server will be used, each should be connected to the same local network.

**Content Central Server Modules**

- Web Application Server(s)
- MS SQL Database Server(s)
- Catalog Service
- Capture Service (includes the Configuration Manager application)
- Workflow Service
- Document Storage Area (includes Coding Queue Documents, Deleted Content, Unprocessed Content)
- Search Indexes (includes the Catalog Manager application)
Important

Search Indexes and the Catalog Service should exist on the same machine for the best performance.

4.1. Web Application Server(s)

This module delivers the content that each user of Content Central interacts with on a regular basis. As a browser-based document management system, most of the administrative and user tasks will be performed within this module.

Requirements: IIS 5.0 or higher; Microsoft® .NET 3.5 Framework

4.2. MS SQL Database Server(s)

Content Central uses Microsoft® SQL Server to store all information related to the application, including user accounts, system configuration settings, document records, logging, and notifications.

Requirements: Microsoft® SQL Server 2005 or higher

4.3. Catalog Service

Both the Catalog Service and Capture Service are Windows® services, each of which can be dedicated to a physical server. The Catalog Service is responsible for updating catalogs with information about new, modified, or deleted documents. This service also removes documents from the system when their specified retention period has expired.

4.4. Capture Service

The Capture Service performs Optical Character Recognition (OCR) on captured images to provide full-text search capabilities and then converts those images to PDF documents. It also handles the capture process for electronic files obtained from monitored folders. Zonal recognition operations and data-source field lookups are also handled in this service.

4.5. Workflow Service

The Workflow Service performs automated operations based on live events and scheduled processes.

4.6. Document Storage Area

The subfolders beneath the System root are necessary for Content Central to run properly. They can each grow in size, and may need to be checked periodically.

- CodingQueue: This subfolder will hold documents that are awaiting user coding and have not been committed to their appropriate storage areas.

- DeletedContent: This subfolder will contain documents that have been removed from the Content Central database by user action or by an enforced retention policy.

- Indexes: This subfolder will contain a subfolder for each catalog. These subfolders store the Index information used to provide quick search results. For more information, see Section 4.7, “Search Indexes”.
• **Unprocessed**: This subfolder will hold documents that have not been successfully captured by the Capture Service.

**Incoming**

The Incoming folder will contain one or more subfolders for each catalog and document type. Each of these subfolders are monitored by the Capture Service to import images and other content.

• **IncomingQCard**: This subfolder is the drop point for image files acquired from a scanning device using QCards™. The images will be converted into searchable PDF files.

• **IncomingImage**: This subfolder is the drop point for image files acquired from a scanning device *without using* QCards™. The image files will be converted into searchable PDF files.

• **IncomingElectronic**: This subfolder is the drop point for electronic files. Files dropped in this folder will be captured as-is.

• **IncomingXML**: This subfolder is the drop point for XML files that describe other files dropped in the same folder. The XML file can define document boundaries, document properties, and more. For more information, visit [http://www.ademero.com/XmlSchemas/ContentCentral/XmlCaptureDescriptor/](http://www.ademero.com/XmlSchemas/ContentCentral/XmlCaptureDescriptor/).

**Documents**

The Documents folder will contain a subfolder for each catalog. These subfolders are the root storage location for documents and other content. This storage space should be fully redundant and backed up on a regular basis for data security and integrity. The space required will vary by organization. At least 80 gigabytes of storage space is recommended for even the smallest operation.

### 4.7. Search Indexes

Each catalog, containing document types describing documents, lives within the Content Central SQL database. A search Index is also generated (as a flat file on the file system) for each catalog. Storage-space requirements should be taken into consideration. A typical Index will require an additional 10 to 20 percent of the amount of space the documents within a catalog require. For example: An estimated 100-gigabyte catalog of documents will require an additional 10 to 20 gigabytes of storage space for the Index.
## Revision History

**2013-04-15**  
**User Guide**  
*Default Capture Catalog* in [Preferences](#)  
*Catalog Filtering* in [Approval/Work Queue](#)  

**Administration Guide**  
*Merge Field Values* in [Workflow Action Types](#)  
*Combine Notes* in [Approval Processes](#)  
*Hide After Assignment* in [AP Groups](#)  
*Inactivity Logout* in [System Settings](#)  
*Catalog Gathering Performance* in [System Settings](#)  
*Search Synonym Character* in [System Settings](#)  
*Minimum Annotations* in [Dynamic Capture Forms](#)  
*Workflow-only Lookups* in [Field Lookups](#)  

**2012-12-12**  
**User Guide**  
*Subfolder paging* in [Catalog Browser](#)  
*Streaming PDF Documents*  

**Administration Guide**  
*Combine Field Values* in [Workflow Action Types](#)  
*Field-Lookup Bypass* in [System Settings](#)  
*PDF Streaming Viewer Settings* in [System Settings](#)  
*Allow Limitations on Fields in AP* in [System Settings](#)  
*Catalog Browser Paging in Folder* in [System Settings](#)  
*Auto Open Properties in Folder* in [System Settings](#)  
*Combo-box Paging in Grid-Results* in [System Settings](#)  
*Enable Thumbnails in Grid-Results* in [System Settings](#)  
*Allow non-admin system fields* in [System Settings](#)  
*Allow capture-form field updates* in [System Settings](#)  
*Lookup Column* in [Packet Templates](#)  
*Thumbnail Creation* in [Managing Catalogs](#)  
*Pages Captured* in [System Fields](#)  
*Approval-Process Timeframe* in [Report Templates](#)  
*$	ext{clickid}$* in [External Applications](#)  
*Field Permissions* in [Approval Processes](#)  
*Deleted-Content XML Compliance* in [System Folders](#)  
*Dynamic Capture Forms*  

**Barcode Symbologies**  
*Added Code 128 (EAN-128)*  

**2012-08-31**  
**User Guide**  
*Added Mobile Site*  
*Document-Type Filtering* in [Approval/Work Queue](#)  
*2010 64-bit* in [Office Integration](#)  

**Administration Guide**  
*Global-Field in DocType Update* in [Trigger Types](#)  
*Report Scheduler* in [Trigger Types](#)  
*Calculate Range* in [Workflow Action Types](#)  
*Export Data* in [Workflow Action Types](#)  
*Generate Report* in [Workflow Action Types](#)  
*Capture-Type Visibility* in [System Settings](#)  
*Hide Auto Capture-Date Properties* in [System Settings](#)  
*Allow Properties DocType Change* in [System Settings](#)  
*Always Use Full-Text Search Engine* in [System Settings](#)  
*ODBC drop-down list* in [Field Details](#)  
*Added Export-Data Templates*  
*Added Report Templates*
Revision History

Session Expiration in Capture Forms
Priority in Capture Jobs
Disable ODBC/Workflow in Capture Jobs

Added Advanced Search Syntax Appendix

2011-04-29 User Guide
Refresh Grid on DocProp Update in Preferences
Added Saved Searches in Searching
Office® 2010 compatibility in Editing
Key-field lookup at capture in QCards

Administration Guide
PIN in Approval-Process System Settings
Include Creator Folder Setting in System Settings
Notification Settings in System Settings
Size columns to fit in Grid-Results System Settings
Blank-page removal in Image-Capture System Settings
Wildcard/Row Search Settings in System Settings
Thread & 2-pass OCR Settings in System Settings
Run External App for Custom Menu Items
Packet lookups in Field-Lookup Integration
Allow View in AQ in DocType Permissions
New Document option in Zonal Recognition
Remove Page option in Zonal Recognition
Regular Expressions in Zonal Recognition
Use only left portion of field in Folder Building
File Version in System Fields
Limit duplicates by other field in Field Details

Added Advanced Search Syntax Appendix

2010-06-17 Updated Recommended Requirements for Server(s)

2010-05-28 User Guide
Limit Expiration (Work Queue) in System Settings
Guest User option in Users
Allow Document Sharing in Permissions

2010-04-15 User Guide
Added Address Book
Added Grid-Results Fields
Added Event Viewer
Added Document-Type QCard™
Added Content Central Office Integration
Icon info for Approval Queue(Messages
DirectScan™ and Electronic for Append/Replace
System-Field info in Document Properties
Missing Document-Type info in Viewing Packets

Administration Guide
Drag-and-Drop settings in System Settings
PDF Capture settings in System Settings
RelayFax Response Capture in System Settings
Administration Permissions for Users/Groups
Added System Fields
Document Creator Permissions
Peer-Review routing type for Approval Processes
**Revision History**

*Starting Member* option for Approval Processes  
*Creator* member type for Approval Processes  
*No-Deadlines* for members in Approval Processes  
*Custom Member Names* option for Approval Processes  
*System Field* option for Approval Processes  
*Global-Field Update* in Workflow Trigger Types  
*Equals Current Date* for Workflow Field Evaluation  
*<= Current Date (+ Offset)* for Field Evaluation  
*Perform Field Lookup* in Workflow Action Types  
*Merge Packet Field Values* in Workflow Action Types  
*Duplicate* for Triggers, Actions, Rules, & Templates  
*System Field* option for Packet Templates  
Added *Custom Menu Items*  
Appendices: Added *Supported ODBC Providers*  
2010-01-07 Updated *Requirements* for Server(s) and Client Workstations
Part I. Installation Guide
Chapter 1. Software Installation

1. Introduction

You will now load the Content Central software on your server(s). When you’ve completed the steps in this chapter, you will have installed all necessary software components of Content Central and will be ready to either evaluate the software or begin configuring for production.

2. Installing Content Central

Launch the installation program, ContentCentral_Setup.exe. Content Central requires several supporting packages to be installed prior to installation. Select the Install button to proceed. Be patient as the installer will load several prerequisites, including a new instance of Microsoft® SQL Server Express Edition.

You may be provided with an option to install additional packages. Choose the appropriate selections for your organization.

Installation Prerequisites

After the prerequisites have finished installing, the InstallShield Wizard will appear and prepare for installation.

InstallShield Wizard Preparation
To begin the installation of Content Central, select the **Next** button. You will be presented with the Ademero End-User License Agreement. Select the **Next** button if you wish to proceed.

![InstallShield Wizard Welcome Screen](image1)

**InstallShield Wizard Welcome Screen**

You may now choose your **Destination Folder** for the Content Central software. After choosing the appropriate location, select the **Next** button to continue.

![Content Central Destination Folder](image2)

**Content Central Destination Folder**

You now have the opportunity to go back and make changes if necessary, otherwise select **Install**.

![InstallShield Wizard - Begin Installation](image3)

**InstallShield Wizard - Begin Installation**

Be patient as the application is installed.
When the installation is complete you will be presented with a Finish button to exit the InstallShield Wizard. You can optionally choose to View Release Notes, which will be opened when the wizard closes. Content Central is now installed.

3. Evaluating Content Central

If you've installed Content Central for evaluation purposes, you may login to the Web site immediately and begin using the product with the installed demonstration catalogs and documents.

Launch the Web site by selecting the Content Central shortcut on your desktop. In most cases, the URL is http://localhost/ContentCentral/Login.aspx.

Login with the Username demo and Password demo.

You can proceed directly to the User Guide.
Chapter 2. Production Configuration

1. Introduction

In this chapter, you will create several file folders on your server(s) for system data, incoming content, and documents.

2. Data Folders

Content Central requires three main folders to be created on your file system: System, Incoming, and Documents. These folders are often found together under a main Content Central folder. For more information, see Section 4.6, “Document Storage Area”.

2.1. System Folder and Subfolders

The System folder and its subfolders need to be created for Content Central processing data. In multi-server environments these will usually be created on the server you've designated to house documents and other content.

1. Launch an instance of Windows® Explorer.

   Tip
   Use the Windows Key-E key combo.

2. Browse to, or create the root folder where you would like to create these System folders, e.g., D:\ContentCentral\System\.

3. Create the following folders inside the System folder:

   - CodingQueue: This folder will hold documents captured with a Post-Capture Coding or Versatile Coding QCard™ until they have been fully coded and archived.
• **DeletedContent**: This folder will contain documents that have been removed from the database either by user action or an enforced retention policy. The XML files produced alongside documents are compliant with the Capture Service and can be used to recapture the document by moving the entire package to an XML-based capture folder.

• **Indexes**: This folder will contain one subfolder for every Index.

• **Unprocessed**: This folder will contain any captured documents that are unable to be processed due to one or more problems with the incoming file.

• **Reports**: This folder will contain any reports generated by the workflow engine.

• **Thumbnails**: This folder will contain thumbnails when thumbnails have been enabled.

---

### 2.2. Incoming Folder

The **Incoming** folder can contain subfolders for each catalog or document type you create. These subfolders will temporarily hold images and other content to be imported by the Capture Service.

1. Launch an instance of Windows® Explorer or use the existing Explorer window from the previous section.

   ![Windows Explorer Screenshot]

   **Tip**

   Use the **Windows Key-E** key combo.

2. Browse to, or create the root folder where you would like your incoming images and other content to be routed, e.g., *D:\ContentCentral\Incoming*.
2.3. Documents Folder

The Documents folder will contain a subfolder for each catalog you create. These subfolders will store the documents and other content for your organization.

1. Launch an instance of Windows® Explorer or use the existing Explorer window from the previous section.

   Tip
   Use the Windows Key-E key combo.

2. Browse to, or create the root folder where you would like your documents and other content to be stored, e.g., D:\ContentCentral\Documents\.
3. Adding Proper Security Credentials to Data Folders

This step permits Content Central to write documents and other content to the data folders.

Perform the appropriate task below for each of the following data folders:

- \System\CodingQueue\  
- \System\DeletedContent\  
- \System\Indexes\  
- \System\Unprocessed\  
- \System\Reports\  
- \System\Thumbnails\  
- \Documents\  

Windows® XP Professional  
Add the ASPNET system account or the impersonation account to each folder and grant Full Control to this account. Inheritance should be enabled.

Windows® Server 2000, Server 2003, Vista  
Add the Network Service system account or the impersonation account to each folder and grant Full Control to this account. Inheritance should be enabled.

4. Optimizing Performance

The following adjustments can improve system performance and response.

4.1. The ASP.NET State Service

The ASP.NET State Service improves performance by maintaining session data between the server and client(s). To enable it, access the Services dialog on the machine you've designated for the Web site. Locate the service named, ASP.NET State Service, and set the Startup Type to Automatic. If the service is not currently running, start the service. You may now exit the Services dialog.

Access the Internet Information Services dialog on the same machine. This can be found from within the Administrative Tools section of the Control Panel or inside the Management dialog of My Computer (right-click, Manage). Expand the computer-name node to reveal the Web Sites node. Continue expanding until you locate the ContentCentral node. Access the properties of ContentCentral (right-click, properties) and select the ASP.NET tab. Select the Edit Configuration button. When the ASP.NET Configuration Settings dialog appears, select the State Management tab. Choose the StateServer option from the Session state mode drop down list.

If you would like to also enable ASP.NET Impersonation (the next optimization), remain in this dialog and skip to the next section. Otherwise, select the OK button to save the ASP.NET configuration settings. Select the OK button to save the changes to the ContentCentral Web site. You may now exit the Internet Information Services dialog.
4.2. ASP.NET Impersonation

When users make requests to Content Central, Internet Information Services will use an ASP.NET process identity to access resources such as the SQL Server. Perform the following if you would like to define a different Windows® account for these operations.

**Note**

When operating Content Central in a multi-server environment, impersonation is mandatory.

Within the **Application** tab of the **ASP.NET Configuration Settings** dialog for the **ContentCentral** virtual directory, add a check to the **Local impersonation** checkbox and provide a pre-defined user account for impersonation. Select the **OK** button to save the ASP.NET configuration settings. Select the **OK** button to save the changes to the **ContentCentral** Web site. You may now exit the **Internet Information Services** dialog.
Once impersonation has been enabled, the account used must be allowed permissions to read and write within a few of the previously-defined data folder(s) (See Section 3, “Adding Proper Security Credentials to Data Folders”). The account will also need read and write access to the database in SQL (described later).

5. Configuration Manager

The Configuration Manager is responsible for defining the SQL database, linking each server in a multi-server environment, enabling Active Directory integration, and managing licensing.

⚠️ Important

Because the Configuration Manager stores the OCR license, it must be installed on the server containing the Capture Service.

Begin by launching the application using the desktop shortcut labeled Configuration Manager.
5.1. SQL Settings

Select the **Server Name** of your installed SQL Server. If your SQL Server is installed on a non-standard port, you may enter the port number in the **Port Number** field. Choose the correct **Version** of SQL Server you have installed.

The **Database Name** field defaults to `ContentCentral`, but you may change it if you desire.

- **SQL Admin Login**: Choose the method of authentication for accessing SQL with `Admin` rights. This security level is necessary to create the Content Central database.

- **SQL User Login**: Choose the method of authentication you would like Content Central to access SQL with during production. When using **SQL Authentication**, the username and password provided will be *created*, i.e., the user does not need to exist in SQL. When using **Windows Authentication** you will need to access the database and provide db_datareader/db_datawriter access to the system account being impersonated through ASP.NET. This will either be the `ASPNET` or `Network Service` account when **Local Impersonation** is disabled (default) or the system account provided when enabling impersonation as described in Section 4.2, “ASP.NET Impersonation”.

Complete the **SQL Settings** configuration by selecting each of the three buttons at the bottom of the **SQL Settings** tab. The **Create/Edit Database** button will create the database for Content Central, and the **Test User Login** button will create the user when using **SQL Authentication**.

The **SQL Settings** Dialog

5.2. System Folders

Proceed to the **System Folders** tab.

Browse to the appropriate folders created in Section 2.1, “**System Folder and Subfolders**”.
The System Folders Dialog

5.3. Active Directory [Enterprise Edition]

Content Central can be integrated with Microsoft® Windows® Active Directory so that users can be added to the system easily. Active Directory users will use their existing Windows® account name and password to login to Content Central.

Select the Add button to add an Active Directory domain to Content Central. To enable this domain, select the Enable Active Directory Authentication checkbox, enter the Fully Qualified Domain Name, and provide an Active Directory User name and Password. Select the Test Login button to verify Content Central can access the Active Directory server.

For information on how to add Active Directory users to Content Central, see Section 2.4.2, “Adding Active Directory User Accounts [Enterprise Edition].”

The Active Directory Dialog

5.4. Licensing

You should have received both a user license and OCR license from Ademero Select the Enter License Key button to enter the User License key and the Import OCR License button to load the OCR License file. You may select the OK button when you've completed this step to save your changes.
External applications are used as Workflow Actions in Workflow Rules. An external application can be started in response to one or more Workflow Triggers meeting their conditions. For more information on how to use these external applications, see Run External Application.

Select the Add button to add an external application to Content Central. Provide a descriptive Name to help identify the application later.

An application can be bound to a catalog or document type by selecting the appropriate item(s) from the Visibility drop-down list. To make an application available globally, select All Catalogs.

Choose the location of the application by selecting the Browse button to locate the executable.

An optional list of Arguments may be provided. The following list identifies the variables that may be used in the argument list. All variables are case sensitive.

- $object: Returns the file path when return object is an item of content or coding-queue content. Returns a number when return object is an integer.
- $clickid: Returns a unique id associated with a user click from a menu. This variable is valid only when an external application is activated from a custom menu item.
- $docfolder: Returns the folder path when return object is an item of content or coding-queue content.
- $docfilename: Returns the file name when return object is an item of content or coding-queue content.
- $docid: Returns the internal identifier for the item of content or coding-queue content.
- $catalog: Returns the catalog for the item of content or coding-queue content.
- $doctype: Returns the document type for the item of content or coding-queue content.
$field:[field name] Returns the value of an index field from an item of content or coding-queue content. Enter the field name inside the square brackets.

$packetname The name of the packet template

$packetfieldname The name of the key field of the packet template

$packetfieldvalue The value of the key field of the packet

$packetstatus One of the following indicators for the packet

Packet is complete.
Packet is incomplete. The following document types are missing: doctype1, doctype2...doctypeN.

$actingusername The username of the user causing the action

$actingfirstname The first name of the user causing the action

$actinglastname The last name of the user causing the action

$actingemailaddress The e-mail address of the user causing the action

$apname Returns the name of the approval process when the return object is an item of content and the workflow trigger is of type: Approval Processes: Movement on Process.

$apaction One of the following approval-process actions when the workflow trigger is of type: Approval Process: Movement on Process

Assigned to Process
Approved
Rejected
Process Completed
Rejected from Process
Removed from Process

$apdate Returns the date of the approval-process event when the return object is an item of content and the workflow trigger is of type: Approval Processes: Movement on Process.

$aptime Returns the time of the approval-process event when the return object is an item of content and the workflow trigger is of type: Approval Processes: Movement on Process.

$appriority Returns the current priority of the approval-process event when the return object is an item of content and the workflow trigger is of type: Approval Processes: Movement on Process.

$apnote Returns the note of the approval-process event when the return object is an item of content and the workflow trigger is of type: Approval Processes: Movement on Process.

$apassignerusername Returns the username of the user who began the approval process when the return object is an item of content and the workflow trigger is of type: Approval Processes: Movement on Process.
$apassignerfirstname Returns the first name of the user who began the approval process when the return object is an item of content and the workflow trigger is of type: Approval Processes: Movement on Process.

$apassignerlastname Returns the last name of the user who began the approval process when the return object is an item of content and the workflow trigger is of type: Approval Processes: Movement on Process.

$apassigneremailaddress Returns the e-mail address of the user who began the approval process when the return object is an item of content and the workflow trigger is of type: Approval Processes: Movement on Process.

Some applications require argument data to be enclosed in single or double quotes. Example: -argument "$object". Likewise, it may be necessary to escape double quotes (") existing within the data that a variable represents, such as when a user enters double quotes in an approval-process note. In these cases you can Use Escape Character for Double-Quotes. The character used depends on the application. Batch files in Windows® use an additional double-quote to escape a double-quote. Example: "This is a ""quoted"" line." Other applications may use a backslash character. Example: "This is a \"quoted\" line."

Select the Delete button to remove one or more applications from the list.

The External Applications Dialog

5.6. Export Data [Enterprise Edition]

The Export Data area allows you to specify files on the server that will be used to export document information in Content Central using workflow rules.

Select the Add button to add a new file. Provide a Name that will be used to reference this file in the Web application. Select the Browse button to select an existing file on the server or specify a new one. This file can be a CSV or TXT file.

⚠️ Warning

New information will be appended to the selected file. Do not choose an existing file that contains important information.

For details on how to export data in Content Central, see Section 2.12, “Export-Data Templates [Enterprise Edition]”.

15
The Export Data Dialog
Part II. Administration Guide
Chapter 3. Catalog Manager

1. Introduction

At this point you should have a functioning Content Central implementation. In multi-server, distributed environments, the Catalog Service should be installed on the machine designated to contain the Catalog Indexes data module for best performance.

The Catalog Manager application can be used to create and modify catalogs; however, catalogs can be created within the Admin area of the Web application and you may choose to bypass this application for now. For more information on creating catalogs from the Web interface, see Section 2.8, “Catalogs & Document Types”.

Note

You will need to access the Catalog Manager if you need to define and modify capture jobs which monitor folders for new documents.

The Catalog Manager stays transparent to the user. Only an administrator should have access to the application, and the application is seldom used after the installation and configuration processes.

2. Catalog Manager

The Catalog Manager application controls the creation, modification, and deletion of Content Central catalogs.

Begin by launching the application using the desktop shortcut labeled Catalog Manager.

2.1. Creating a New Catalog

1. Select the New button. The Create New Catalog dialog will launch.

Note

This dialog will use default data folders (see Section 5.2, “System Folders”) and requires only a Catalog Name and optional Description. If you wish to create a catalog with custom folder locations and settings, select the Use Wizard button and proceed to Section 2.1.1, “Using the Wizard to Create a New Catalog”.

2. Enter a name and description for your catalog. Both may contain spaces, e.g., "Student Records".
2.1.1. Using the Wizard to Create a New Catalog

1. The **New Catalog Wizard** will launch when the **Use Wizard** button has been selected from the **Create New Catalog** dialog.

2. Enter a **Catalog Name** and optional **Catalog Description** for your catalog. Both may contain spaces, e.g., "Student Records".

3. The default **Index Location** will be based on the previously-defined folder settings and should be sufficient. Select the **Next** button to proceed to the **Folders to Catalog** dialog.
4. The **Folders to Catalog** dialog allows you to specify one or more document folders to index. Select the **Add Folder** button to create a subfolder for the catalog in the previously-defined Documents folder, e.g., D:\ContentCentral\Documents\Student Records\. After creating and selecting the new subfolder, you may add additional folders on your network that may contain pre-existing documents.

The **Destination Folder** should be set to one of the listed **Folders to Catalog**. The Capture Service will route all captured documents for the catalog to this base folder.

5. Select the **Next** button to proceed to the **Update Catalog Schedule** dialog.

6. When documents are captured, modified, checked in, or deleted, the Catalog Service will automatically update the catalog to which the document belongs. The only time a catalog would not know about one or more files being added, modified, or deleted from the system is when they were added, modified, or deleted outside of Content Central. Because of this possibility, it's a good practice to perform a complete system check at least once per day during non-business hours.

Make the necessary changes to the frequency and start-time settings, then click **Next** to continue to the **New Catalog Summary**.

---

**Creating and Selecting the Folders to Catalog**

**The Update Catalog Schedule Dialog**

**The New Catalog Summary Dialog**
7. Review your settings. If you would like to change any settings, use the Back button. You may choose to disable the Add documents now checkbox if desired (not recommended). When you are satisfied with your choices, select the Finish button to complete the wizard. You should receive a Catalog Update confirmation message. Click OK to close the message and return to the Catalog Manager.

The Catalog Update Confirmation Message

You have now created a catalog for use with Content Central. You may continue reading the next section on managing catalogs, or you may skip to the next chapter to continue the installation process. If you choose to skip to the next chapter, select the Close button at the bottom of the Catalog Manager.

2.2. Managing Catalogs

You can launch the Catalog Manager whenever you wish to modify an existing catalog or view status details about a catalog. You can also delete a catalog or perform an immediate update.

To access the management dialog, select the Manage Catalogs button after launching the Catalog Manager.

The drop-down list at the bottom of the management dialog allows you to update catalogs in several ways:

Add docs to selected/all catalogs
- New files that have been created outside of the Content Central interface will be added to the database.

Rebuild selected/all catalogs' indexes
- The selected catalogs' search indexes will be completely rebuilt. All files will be examined. This operation may take a while to complete.

Refile selected/all catalogs
- The documents within the selected catalogs will be filed according to the Folder & File Building rules defined in each document type.

⚠️ Warning

This will rename and possibly move all files in the selected catalogs.

🤔 Note

This command requires an authorization code from an Ademero, Inc. support technician.

Make Searchable selected/all catalogs
- The documents of the selected file types within the selected catalogs will be made fully searchable. You can choose to convert the image files to PDF files or leave the images in their native format while still making them searchable.

🤔 Note

This command requires an authorization code from an Ademero, Inc. support technician.
Create selected/all catalogs’ missing thumbnails

When thumbnail creation is enabled (see Grid-Results Settings), this command will start production of thumbnails that are missing for documents that were created while thumbnail creation was disabled.

Rebuild selected/all catalogs’ thumbnails

When thumbnail creation is enabled (see Grid-Results Settings), this command will create thumbnail images for every document in the system. Existing thumbnails will be overwritten.

The Catalog Manager Management Dialog

Modifying an existing catalog will allow you to modify everything you had originally defined when creating the catalog as well as additional settings that were not part of the New Catalog Wizard.

2.2.1. Capture Jobs

You may create one or more Capture Jobs for this catalog. Each job corresponds to a source that will be monitored regularly for new documents. Select the Add button to create a new job.

The Capture Jobs Dialog

2.2.1.1. General

Provide a Name and optional Description for the job.

Choose the Document Type that will be used when no other descriptor defines it. Examples are the non-descriptor Image and Electronic processing types.

Select the Capture Source. The following list describes each source.

Folder       Content Central will monitor a folder path for new documents. The captured documents will be removed from this folder.
E-mail Content Central will monitor an e-mail address for new documents. All captured e-mails will be removed from the e-mail server.

You can choose a Priority level for this capture job. The priority determines whether documents from this capture job will be processed before or after other capture jobs.

Choose whether or not this job is enabled by selecting or deselecting the Capture Job Enabled checkbox.

2.2.1.2. Descriptor

Select an appropriate Document Descriptor and optional Processing Type for this job. Several combinations can exist:

- **Document Descriptor: None, Processing Type: Image**
  - Files dropped into the Incoming Folder will be converted to documents, one per input file, and routed to the Coding Queue for the catalog. QCards™ are not processed and should not be used. Each file will be processed as an image file and converted into a searchable PDF. If the Bypass Coding Queue checkbox is selected, the newly converted documents will be routed directly to the Documents data folder for the catalog.

- **Document Descriptor: None, Processing Type: Electronic**
  - Files dropped into the Incoming Folder will be captured as-is, and routed to the Coding Queue for the catalog. If the Bypass Coding Queue checkbox is selected, the electronic documents will be routed directly to the Documents data folder for the catalog.

- **Document Descriptor: QCard**
  - Captured Files will be converted to documents. QCards™ determine document boundaries.

- **Document Descriptor: XML**
  - Captured Files will be converted to documents. Associated XML files determine document boundaries. For more information, visit [http://www.ademero.com/XmlSchemas/ContentCentral/XmlCaptureDescriptor/](http://www.ademero.com/XmlSchemas/ContentCentral/XmlCaptureDescriptor/).

- **Document Descriptor: CustomBarcode**
  - Captured Files will be converted to documents. Custom Barcodes determine document boundaries.
By default, captured documents with no descriptor or using the CustomBarcode descriptor will be routed to the Coding Queue for review. Selecting the Bypass Coding Queue checkbox will disable this behavior and route the documents directly to the catalog.

When a Descriptor is selected, you can choose to Disable ODBC Lookups and/or Disable Workflow Processing.

Capture Job Descriptor

2.2.1.3. Details (Capture Source: Folder)

Browse to the appropriate Incoming Folder and create a subfolder for the catalog and a subfolder specifically for this job, e.g., D:\ContentCentral\System\Incoming\StudentRecords\IncomingQCard\ and select the OK button.

Selecting the QCard Folder
2.2.1.4. Details (Capture Source: E-mail)

Provide the Hostname, Username, and Password for the e-mail address to be monitored. The default Port, based on the Encryption selection, will be entered automatically. You may change this Port for non-standard server implementations. If your server requires Secure Password Authentication, select the named checkbox.

Select the Test Server Settings button to test the settings. A successful test will return the number of e-mails currently queued to be processed.

By default, the attachments within the e-mails will be captured and converted into documents. If you instead wish to use the e-mail message itself, select the Capture e-mail message itself checkbox.

You may map e-mail fields, such as From, To, and Subject, to document-type fields within the E-mail Field Settings section.
2.2.2. Advanced Catalog Settings

Here you may choose to define filename filters. When defining filename masks in the **Include filters** box, only files matching those filename masks will be added to the catalog. When defining filename masks in the **Exclude filters** box, files matching those filename masks will not be added to the catalog. Examples of filename masks are as follows: *\.pdf, *\.doc, *\.xls.

**Note**

Filename filters only affect files that will be imported and/or examined by the Catalog Service. Content Central will allow users to capture any type of file while logged in to the Web site.
Chapter 4. Web Site Administration

1. Introduction

You will now access the Web Site module and complete configuration of the Content Central system. This portion of the installation may be completed from any client machine on the network with a Web browser.

2. Web Site Configuration

You will first need to gain access to Content Central by logging in with the default administrator username and password.

Username (not case sensitive): Admin
Password (case sensitive): AdminPassword

2.1. The Admin Menu

The Admin menu can be accessed only by users belonging to the Administrators group, users who have the Document-Type Administrator permission on one or more document types, or users who have any selective Administration Permission via their user account or assigned groups. As an administrator you can access the Admin menu at any time by selecting the button on the main menu located in the top frame of Content Central.
2.2. System Settings

The System Settings screen is used to define items such as the e-mail server, fax server, and number of days to purge log entries. Access it by selecting the icon from the Admin main menu.

System Settings

Administrator-Permission Settings

These settings affect the selective administrator permissions that can be defined on a user profile or group profile. For more information, see Section 2.4.1, “Adding User Accounts Manually” and Section 2.5.1, “Adding or Modifying a Group”.

- Limit user access in Users & Groups by the administrator's group membership.
- Limit catalogs presented in Catalogs & DocTypes to only those assigned to the administrator.

This setting applies to users having the User and/or Group administrator permissions. When selected, the administrator having these permissions will only have access to users that do not belong to any group and users that are in one of the administrator's assigned groups. The administrator will not have access to create new groups or delete existing groups.

This setting applies to users having the Catalogs & DocTypes administrator permission. When selected,
the administrator will have access to manage only the catalogs that have been assigned to the user on the user's profile. Catalogs will be assigned automatically to the administrator who creates them. For more information, see Section 2.4.6, “Assigning Catalogs to a User”.

Limit user and group access in Catalogs & DocTypes by the administrator's group membership. This setting applies to users having the Catalogs & DocTypes administrator permission. When selected, only users that are in one of the administrator's assigned groups as well as those assigned groups can be managed in Catalog Membership.

Catalog-Administrator Allowed Permissions These settings apply to users having the Catalogs & DocTypes administrator permission. This type of administrator will have access to manage only the permissions selected in this area.

Approval-Process Settings Selecting Allow documents to be checked out while on an approval process will enable the Check Out/In menu item from the Modify menu inside of the Approval Queue.

When the previous is selected, you may also Hide checked-out documents in the Approval Queue from other users of the same group. This will effectively lock the document from others who may share in the approval of a document. For example, in an approval-process group of three users requiring only a single approval, all three users are instructed to check out the documents before working on them. After the first user has checked it out, the other users will not see it in their Approval Queue. This prevents multiple users from working on the same document simultaneously.

Selecting the Hide documents from Search & Catalog Browser when on an Approval Process checkbox will prevent documents in any Approval Queue from showing up in a search or when browsing.

If you would like to enable PIN verification when users approve or reject documents, select Require PIN for Approval. Specify the PIN Length in the box provided.
While documents are on an approval process, it may be desirable to prevent some fields from being modified. Select **Allow limitations on field editing** to globally enable this feature. By default, all fields can be modified unless field permissions for specific member stages in an approval process have been modified.

**Capture Settings**

Deselecting any capture type under the **Capture-Type Visibility** will prevent that capture type from appearing on the **Capture** screen.

**Image-Capture Settings**

You can optionally choose to **Enable black page removal**. This will cause the Capture Service to remove any blank pages while processing captured documents. To refine this feature, you can specify a minimum amount of data on any given page that will allow the page to be kept. Enter this value in **Remove pages smaller than X bytes**.

Select **Enable capture throttling** to limit the amount of file data the Capture Service brings into the database while processing new documents. This can be helpful when you want to keep the database size from expanding and shrinking by large amounts in a small amount of time. The amount of megabytes allowed to be captured at one time can be defined by modifying the **Throttle Limit in MB**.

**OCR Settings**

If you have purchased multi-threaded OCR, enter the total number of threads you would like the Capture Service to use on the server.

Selecting or deselecting **Enable OCR and auto-rotate** enables or disables the OCR engine.
<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Web Site Administration</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Selecting the</strong></td>
<td>Selecting the <strong>Store OCR in database</strong> checkbox will cause all OCR data to be stored in the Content Central database (as well as in the index files). This data can be used for integration purposes.</td>
</tr>
<tr>
<td><strong>Enable 2-Pass OCR processing</strong></td>
<td>The <strong>Enable 2-Pass OCR processing</strong> feature can provide improved OCR quality.</td>
</tr>
<tr>
<td><strong>PDF Electronic Capture Settings</strong></td>
<td>Select the options you want presented to users when they capture a PDF document.</td>
</tr>
<tr>
<td><strong>Conversion Settings</strong></td>
<td>Selecting the <strong>Enable Conversion File Building</strong> checkbox will append random alphanumeric suffixes to the end of filenames in an attempt to increase performance of processing content coming from a legacy-system conversion.</td>
</tr>
<tr>
<td><strong>Data-Table Settings</strong></td>
<td>The <strong>Number of results to display on each page</strong> may be modified as desired.</td>
</tr>
<tr>
<td><strong>Document-Properties Settings</strong></td>
<td>When the <strong>Allow document-type changes</strong> checkbox is checked, users will be able to change the document-type assignment of a document.</td>
</tr>
<tr>
<td><strong>Document-Type Administrator Settings</strong></td>
<td>Deselecting the <strong>Allow changes to date fields populated automatically during capture</strong> checkbox will hide these fields from view on the document properties screen.</td>
</tr>
<tr>
<td><strong>Document-Properties Settings</strong></td>
<td>By default, document properties may not be modified when a document is checked out. This behavior can be changed by selecting <strong>Allow document properties to be modified when documents are checked out</strong> checkbox.</td>
</tr>
<tr>
<td><strong>Document-Properties Settings</strong></td>
<td>Selecting the <strong>Allow empty values in updates</strong> checkbox allows document properties to be set to an empty value during updates.</td>
</tr>
<tr>
<td><strong>Document-Properties Settings</strong></td>
<td>If you'd like some system fields reserved for administrators to be viewed by all users, select <strong>Allow non-admin users to view admin-only system fields</strong>.</td>
</tr>
<tr>
<td><strong>Document-Properties Settings</strong></td>
<td>By default, all capture-form submissions will update like-named document properties even when the user submitting the document does not have the <strong>field edit</strong> permission for the document type. If you would like to disable this behavior, uncheck <strong>Allow field updates from capture-form updates regardless of field-edit permission</strong>.</td>
</tr>
</tbody>
</table>
| **Document-Type Administrator Settings**     | Setting this checkbox will allow users with document-type **Administrator** permission(s) to manage document-type
membership. All system users and groups will be visible to such users. For more information, see Section 2.8.6, “Permissions”.

<table>
<thead>
<tr>
<th>Drag-and-Drop Settings</th>
<th>Select the Enable Drag-and-Drop applet on results frame checkbox to enable the Java-based drag-and-drop applet in each results frame.</th>
</tr>
</thead>
<tbody>
<tr>
<td>E-mail Server Settings</td>
<td>These settings, when specified, provide the E-mail menu item in the File menu. The server provided is used for sending all outgoing e-mails, including those used in workflow rules.</td>
</tr>
<tr>
<td>Event Log Settings</td>
<td>Entries for the Event Log are stored for seven years by default. Setting this value to zero disables the event log.</td>
</tr>
<tr>
<td>Fax Server Settings</td>
<td>These settings, when specified, provide the Fax menu item in the File menu. Content Central currently supports only RelayFax fax-server implementations. The settings provided are used for sending all outgoing fax transmissions, including those used in workflow rules.</td>
</tr>
<tr>
<td></td>
<td>Send All Faxes Through Single Account When enabled, all fax transmissions will be routed to the provided Send-Account E-mail Address.</td>
</tr>
<tr>
<td></td>
<td>Capture and Distribute Fax Confirmations When enabled, the Workflow Service will monitor the provided e-mail account for RelayFax responses. All valid responses (successes and failures) will be routed to the sending-user's Messages folder. Selecting the Send Copy to User's E-mail Address checkbox will send a copy to the e-mail address on the user's account.</td>
</tr>
<tr>
<td>Field-Lookup Settings</td>
<td>Selecting Bypass Field Lookup when Any Lookup Item is Empty will cause the lookup engine to skip a database lookup when one or more items is blank. This can help prevent errors with external data sources that expect values for each item.</td>
</tr>
<tr>
<td>Folder-Deletion Settings</td>
<td>The Delete folders when emptied setting determines whether file-system folders will be removed when they become empty from deletions. By default, folders will be displayed based only on document-type permissions. If the current user does not have permission to view any of the files in a folder based on the document types represented, the folder will not display. Selecting Check for documents created by user when displaying folder names will cause Catalog Browser folder displaying to include a permission</td>
</tr>
</tbody>
</table>
check for files created by the current user. Enabling this feature can decrease performance due to the increased amount of permission checking that will occur.

Likewise, **Check for documents created by user when gathering Catalogs** will include the permission check for files created by the current user whenever a list of accessible catalogs is gathered for the user. When selected, this can decrease performance when accessing areas like the Search area and Folders area.

You can **Enable Paging in the Catalog Browser** to improve performance. The associated **Page size** determines how many subfolders will be displayed at one time. If any folder contains a total number of subfolders less than or equal to this page size, the system will bypass the paging mechanism.

If you'd like to have the **document-properties** frame open immediately whenever a user enters the *Coding Queue*, select **Automatically Open Document Properties when in the Coding Queue**.

**Grid-Results Settings**

The **Number of results to return in a search** and **Number of results to display on each page** may be modified as desired.

Selecting **Size columns to fit in all grids** will improve display performance in some browsers, such as Google Chrome and Mozilla Firefox. By default, columns are displayed in equal width. This option will prevent column data from being truncated.

Selecting **Use combo box for quick access to specific pages** will change the default paging mechanism above the results grid with a drop-down list containing all available page numbers.

Thumbnails will be created and available for display in the results grid when you choose to **Enable Thumbnails**. The **Thumbnail height** textbox allows values from 50 to 250 (pixels) and defaults to 66, which is a perfect scaling value for letter-sized pages. Whenever adjusting the height to a higher value after thumbnails have already been created, you may wish to rebuild all existing thumbnails. To do this, see Section 2.2, “Managing Catalogs”.

**Note**

Thumbnails will not be created when the **Enable Thumbnails** checkbox is disabled; however, missing thumbnails can be created later by using the Catalog Manager.

**Login Logout Settings**

Selecting the **Login page should remember usernames** checkbox prevents users from having to enter the username for each login.

Selecting the **Allow users to stay logged in** checkbox allows users to bypass the login screen completely unless the **Logout** button is selected.
Users can be logged out automatically after a period of inactivity. To enable this, enter a value larger than 0 in **Inactivity Logout Delay in Minutes**.

**Notification Settings**

Selecting **Override server URL in outgoing notifications** will change the default server hostname with the provided **Server URL**. This is sometimes necessary when the internal server name does not reflect an alias or other hostname for external access.

**Search Settings**

Selecting the **Always Use Full-Text Search Engine** checkbox will may improve performance when performing searches. You will not be able to perform date-range searches while this option is checked.

Selecting the **Allow Stemming** checkbox will increase the chances of finding content when searching. The search engine will perform a search for the root word as well as its various forms.

**Example 4.1. Stemming**

*Root word*: Process; *Stemmed variants*: Processes, Processed, Processing

**Note**

Stemming is available only when using the **Full-Text search box**.

Select the **Append (*) wildcard to all drop-down list entries** checkbox will cause a wildcard to be appended to all values entered in drop-down lists. This will allow results such as *John Smith* to be returned automatically when the user enters only *John*.

The value in the **Number of results to return in a search** textbox will limit the total number of results returned when performing a full-text search. The actual number of results that match a full-text query may be higher than the number entered here.

The **Number of catalogs to display in drop-down list** can be increased or decreased, controlling the height of the **Catalogs** selection box on the **Search** frame.

By default, an ampersand (&) character is used as a signal to the full-text search engine that you are enabling synonym searching. If you need to search for values in the full-text search engine that contain an ampersand, you can change the value of the **Synonym Character**.

**Viewer Settings**

You can **Enable PDF Streaming** to reduce network bandwidth of **PDF previews**. When enabled, only the first page of any **PDF** will be sent to the client machine and an additional menu **PDF Streaming** will appear above the results grid.
Selecting **Stream only when PDFs contain more than x pages** will result in the full PDF being sent to the client when the number of pages is equal to or less than the threshold value provided.

PDF bookmarks from the original file can be transferred to the streamed PDF file if you select **Extract and Add PDF Bookmarks**. Only the bookmarks relevant to the pages streamed will be included. This may affect the performance of streaming delivery.

**Work-Queue Settings**

Selecting the **Hide documents from Search & Catalog Browser when in a Work Queue** checkbox will prevent documents in any Work Queue from showing up in a search or when browsing.

Select the **Limit expiration** checkbox to limit the amount of time a document can exist in the Work Queue.

Enter the appropriate information for your organization, then click **Apply** to save your changes.

### 2.3. External Data Sources (ODBC) [*Enterprise Edition*]

One or more external data sources (ODBC [Definition: Open Database Connectivity] sources) can be linked to Content Central and used for automating field input in document types. After configuring one or more sources, you will need to map document-type fields to the source(s) (see Section 2.8.9, “Field Lookup Integration [*Enterprise Edition*]”).

For a list of supported ODBC providers, see Appendix D, Supported ODBC Providers.

Access the External Data Sources screen by selecting the **icon** from the Admin main menu.
2.3.1. Adding or Modifying a Data Source

After confirming your external data source exists in the ODBC management tool on the same machine containing the Web-site module, select the [Add Source] button to add the source.

To modify an existing data source, select the [ ] icon in the appropriate row.

**External Data Source Details**

- **Name (required)**: This name will be used to identify the correct data source when mapping fields.
- **Description (optional)**: Use this textbox to add a description for the source.
- **Select System DSN**: This drop-down list will contain a list of available ODBC System DSN data sources.
- **Username (if required)**: If required, enter the username to connect to the DSN.
- **Password (if required)**: If required, enter the password to connect to the DSN.
- **Clear stored password**: Select this checkbox to remove the password stored for this external data source.

After entering the appropriate information for the data source, select [Apply] to save your changes. To test the connection, select the [Test] button in the row of the data source you would like to test.
2.3.2. Deleting a Data Source

To delete a data source, select the icon in the appropriate row.

When you are sure you would like to delete the data source, select the button.

2.4. Users

Access the Users screen any time you wish to Create, Modify, Disable, or Delete a user by selecting the icon from the Admin main menu.
2.4.1. Adding User Accounts Manually

To add user accounts manually, select the button and provide the following information.

**User Fields**

Username (required)  Usernames may be a minimum of 6 characters and may only contain letters (a-Z), numbers (0-9), atmark (@), hyphen (-), underscore (_), and period (.).

Password (required)  Passwords should be a minimum of 4 characters and a maximum of 50 characters in length.

First Name (optional)  The user's first name should only contain those characters allowed for Usernames.

Last Name (optional)  The user's last name should only contain those characters allowed for First Names.

E-mail Address (optional)  The e-mail address will be used to send notifications and check-in requests.

**User Options**

Guest User  Selecting this checkbox limits access to only the Work Queue. The user will be sent directly to the Work Queue upon logging in.

Account Disabled (not visible when creating a new user)  Selecting this checkbox will disable the user's access to Content Central.

Clear User's PIN  Selecting this (and applying changes) will clear the user's PIN, which may be required for document approval and rejection. For more information, see Approval-Process Settings and Section 5.8, "PIN".

Allow user to update profile  By selecting this checkbox, users will have access to modify their first and last names, and e-mail address.
Allow user to change password  When selected, users will have access to modify their passwords.

Force user to approve/reject only first item in the Approval Queue  Selecting this checkbox will force a user to work on only the first record in the Approval Queue. Users with this setting will not be able to select any other rows. They will not be able to approve/reject more than one document at a time. After selecting this option, choose the appropriate Column to sort by.

Theme  You can choose a Theme other than the System Default if any have been created or imported.

Administrator Permissions  You can choose to make the user a selective administrator by enabling one or more Administrator Permissions. The user will have access to the selected areas when selecting the button on the main menu.

Note  Some System Settings can alter the behavior of one or more of these permissions.

Note  Any user that belongs to the Administrators group will have access to all administrative areas.

When you've finished entering the user's information, select the button to add the user account.

2.4.2. Adding Active Directory User Accounts [Enterprise Edition]

To add user accounts from Active Directory, select the button. For more information on enabling Active Directory integration, see Section 5.3, “Active Directory [Enterprise Edition]”.

Adding a User Account Manually
Select the checkbox for each user account in Active Directory that you wish to add to Content Central. Use the Filter textbox to narrow the list of visible user accounts.

When you've finished selecting user accounts, select the button to add the user account(s).

![Adding an Active Directory User Account]

**2.4.3. Modifying an Existing User’s Profile**

To modify an existing user profile, select the icon in the user’s row.

**2.4.4. Adding a Group to a User Account**

To add a group to a user account, select the icon in the user’s row.

Add a check to the checkboxes representing the group(s) you would like the user to have membership in. Select when finished.
Adding Group Membership to a User

2.4.5. Modifying Document-Type Permissions

To modify document-type permissions for a user, select the icon in the user's row.

Add a check to the checkboxes representing the permissions you would like the user to have. Removing all permissions for a document type will also remove membership to that document type. For more information on document-type permissions, see Section 2.8.6, “Permissions”. Select when finished.

![Image of Document-Type Permissions](image)

Modifying Document-Type Permissions

2.4.6. Assigning Catalogs to a User

To assign one or more catalogs to a user account for administration purposes, select the icon in the user's row.

Note

This feature is available only when catalog administration is limited by the user's catalog assignments. (See Administrator-Permission Settings.) Even when a user has one or more catalogs assigned, the user needs the Catalogs & DocTypes Administrator Permission before they can manage the assigned catalogs.

To add one or more catalogs, select the button. Add a check to the checkboxes representing the catalogs you would like the user to have access to administer.

To remove a catalog assignment, select the icon in the row of the catalog you would like to remove from the user.

Select when finished.
2.4.7. Deleting a User Account

To delete a user account, select the icon in the user's row.

When you are sure you would like to delete the user, select the button.

2.5. Groups

Access the Groups screen any time you wish to Create, Modify, Disable or Delete a group by selecting the icon from the Admin main menu.
2.5.1. Adding or Modifying a Group

After installation, only the Administrators group will exist. To add more groups, select the button. To modify an existing group, select the icon in the group's row.

**Group Fields**

- **Group Name (required)**: Group names may contain a minimum of 6 characters and may only contain letters (a-Z), numbers (0-9), atmark (@), hyphen (-), underscore (_), and period (.).

- **Group Description (optional)**: Use this field to add a description to the group.

- **Administrator Permissions**: You can choose to make all user members in the group selective administrators by enabling one or more Administrator Permissions. The users in the group will have access to the selected areas when selecting the button on the main menu.

**Note**

Some System Settings can alter the behavior of one or more of these permissions.

**Note**

Any user that belongs to the Administrators group will have access to all administrative areas.

After entering the appropriate information for the group, select to save your changes.
2.5.2. Adding a User to a Group

To add a group to a user account, select the icon in the user's row. Add a check to the checkboxes representing the group(s) you would like the user to have membership in. Select when finished.

2.5.3. Modifying Document-Type Permissions

To modify document type permissions for a group, select the icon in the group's row. Add a check to the checkboxes representing the permissions you would like the group to have. Removing all permissions for a document type will also remove membership to that document type. For more information on document-type permissions, see Section 2.8.6, “Permissions”. Select when finished.
Modifying Document-Type Permissions

2.5.4. Deleting a Group

To delete a group, select the icon in the group's row.

When you are sure you would like to delete the group, select the Confirm button.

2.6. Global Fields

The Global Fields screen allows you to create, modify, and delete fields for the entire system. Access it by selecting the icon from the Admin main menu.
Global Fields

2.6.1. Adding or Modifying Global Fields

To add a global field, select the Add Field button from the Global Fields screen. To modify an existing field, select the icon in the row of the field you would like to modify.

See Section 2.6.2, “Field Details” below for information on the field details.

When you've finished, select the Apply button to save your changes.

Global Field Details

2.6.2. Field Details

Settings

Name (required) The name of the field as it appears here will be used for captured documents and search queries.
<table>
<thead>
<tr>
<th>Type</th>
<th>Fields may be of type <strong>Text</strong>, <strong>Numeric</strong> or <strong>Date</strong>.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Format</td>
<td>The field <strong>Format</strong> depends on the field <strong>Type</strong>.</td>
</tr>
<tr>
<td><strong>Text</strong></td>
<td><strong>Free Entry</strong> Field values do not contain any masks or requirements.</td>
</tr>
<tr>
<td><strong>Custom</strong></td>
<td>A custom mask may be designated. See <strong>Mask (Text Type, Custom Format)</strong>.</td>
</tr>
<tr>
<td><strong>SSN</strong></td>
<td>Field values conform to a social-security mask, i.e., 123-45-6789. Hyphens are automatically inserted.</td>
</tr>
<tr>
<td><strong>ID1</strong></td>
<td>Field values conform to an identification-number mask of type 123-456-789. Hyphens are automatically inserted.</td>
</tr>
<tr>
<td><strong>ID2</strong></td>
<td>Field values conform to an identification-number mask of type 12-345-6789. Hyphens are automatically inserted.</td>
</tr>
<tr>
<td><strong>Phone1</strong></td>
<td>Field values conform to a telephone number <em>without</em> extension, i.e., (123) 456-7890. Parentheses, spaces, and hyphens are automatically inserted.</td>
</tr>
<tr>
<td><strong>Phone2</strong></td>
<td>Field values conform to a telephone number <em>with</em> extension, i.e., (123) 456-7890 Ext. 12345. Parentheses, spaces, and hyphens are automatically inserted.</td>
</tr>
<tr>
<td><strong>ZipCode1</strong></td>
<td>Field values conform to a five-digit postal code, i.e., 12345.</td>
</tr>
<tr>
<td><strong>ZipCode2</strong></td>
<td>Field values conform to a Zip+4 postal code, i.e. 12345-1234.</td>
</tr>
<tr>
<td><strong>ZipCodeCanada</strong></td>
<td>Field values conform to a Canadian postal code, i.e., K1K 2T3.</td>
</tr>
<tr>
<td><strong>Date</strong></td>
<td>Several date formatting masks are allowed from <strong>MM/DD/YYYY</strong> to <strong>YYYY/MM/DD</strong> and <strong>YY-MM-D</strong></td>
</tr>
<tr>
<td><strong>Mask (Text Type, Custom Format)</strong></td>
<td>Use this textbox to enter a custom mask for the current field. Any combination of the following characters may be used to create the mask:</td>
</tr>
<tr>
<td><strong>L</strong></td>
<td>Letter (required)</td>
</tr>
<tr>
<td><strong>?</strong></td>
<td>Letter (optional)</td>
</tr>
</tbody>
</table>
# Digit (required)
9 Digit (optional)
A Letter or Digit (required)
a Letter or Digit (optional)
> All letters to the right will be converted to the upper case
< All letters to the right will be converted to the lower case

Literals Static characters A-Z, a-z, 0-9, Braces { }, Brackets [ ], Underscore (_), Period (.), Hyphen (-), and Space

Note To use the literal characters L, 9, A, or a place a backslash character (\) before the literal.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left-pad with character</td>
<td>When using a custom mask, the specified character will be used to left-pad</td>
</tr>
<tr>
<td></td>
<td>values which do not contain the full number of allowed/required characters.</td>
</tr>
<tr>
<td>Right-pad with character</td>
<td>When using a custom mask, the specified character will be used to right-pad</td>
</tr>
<tr>
<td></td>
<td>values which do not contain the full number of allowed/required characters.</td>
</tr>
<tr>
<td>Use multi-line text entry</td>
<td>Allows multiple lines of text input. (text only)</td>
</tr>
<tr>
<td>Wrap Text</td>
<td>Text input will be wrapped to the next line when exceeding the current line.</td>
</tr>
<tr>
<td>(n) lines high</td>
<td>This number determines how many lines of input will be shown at one time.</td>
</tr>
<tr>
<td>Auto Increment Value</td>
<td>Automatically increments the value of the field for each document captured</td>
</tr>
<tr>
<td></td>
<td>by a user or committed by a user in the Coding Queue. When enabled on a new</td>
</tr>
<tr>
<td></td>
<td>field, enter the Start Value in the box below. (numeric only)</td>
</tr>
<tr>
<td>Decimal Length</td>
<td>Allows up to eight digits to the right of the decimal point. (numeric only)</td>
</tr>
<tr>
<td>Zero fill decimal</td>
<td>Zero-filling a decimal will add the appropriate number of zeros after the</td>
</tr>
<tr>
<td></td>
<td>last digit entered and up to the Decimal Length. (numeric only)</td>
</tr>
<tr>
<td>Group thousands</td>
<td>Commas will be automatically inserted in field values to separate groups of</td>
</tr>
<tr>
<td></td>
<td>thousands. (numeric only)</td>
</tr>
<tr>
<td>Auto-populate date</td>
<td>The date the Capture Service begins processing a document will be added to</td>
</tr>
<tr>
<td></td>
<td>this field. This field will not be displayed during QCard™ creation or</td>
</tr>
<tr>
<td></td>
<td>DirectScan™ scanning. (date only)</td>
</tr>
</tbody>
</table>

48
### Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create drop-down list from external data source</td>
<td>When this option is selected, you will be able to select a column of data from an available <a href="#">External Data Source</a>.</td>
</tr>
<tr>
<td>Create drop-down from choices</td>
<td>The choices in the accompanying <strong>Field Entry Choices</strong> text box will be used to create a drop-down selection when capturing and searching fields.</td>
</tr>
<tr>
<td>Allow new entries</td>
<td>If the previous option is enabled, you have the option of allowing entries that do not appear in the <strong>Field Entry Choices</strong> list to be entered by a user during capturing, searching or editing.</td>
</tr>
<tr>
<td>Add new entries to choice list</td>
<td>If the previous option is enabled, you can allow the new entries to be permanently added to the <strong>Field Entry Choices</strong> list.</td>
</tr>
<tr>
<td>Use this field when capturing/editing</td>
<td>The field will be available for user input when capturing documents and editing document properties.</td>
</tr>
<tr>
<td>Allow user to modify value</td>
<td>The field will automatically increment its value, but the user may override the value provided. (numeric, Auto-Increment only)</td>
</tr>
<tr>
<td>Require entry</td>
<td>If the field is being used for capturing/editing, you can require that data be input in the field before capturing, searching or editing takes place.</td>
</tr>
<tr>
<td>Disallow duplicate value</td>
<td>Duplicate values are always checked on Auto-Increment numeric fields. This option will prevent duplicate values from being entered in the capture frame or Coding Queue. (numeric, Auto-Increment only)</td>
</tr>
<tr>
<td>Only if the following field has an entry</td>
<td>If the previous option is enabled, you have the option of requiring the current field only when the selected field is not empty.</td>
</tr>
<tr>
<td>And the above field's entry equals</td>
<td>If the previous option is enabled, you have the option of requiring the current field only when the selected field has a specific value.</td>
</tr>
<tr>
<td>Print field on QCards™</td>
<td>If the field is being used for capturing/editing, you can have the field value printed on QCards™ used to capture documents. Disabling this option will hide values on QCards™ (beneficial for social-security numbers).</td>
</tr>
<tr>
<td>Check for duplicate value on update/commit</td>
<td>If enabled, the user will be notified if another document of the same document type already has the value entered for the current field. This warning occurs each time the value for the current field is modified. Users can bypass the warning by submitting the page containing the duplicate value a second time. This is always enabled with Auto-Increment numeric fields.</td>
</tr>
<tr>
<td>Limit duplicates by other field</td>
<td>If enabled, the previous duplicate-checking feature will not consider the current field to be duplicated unless another document is found with matching values for the current field and the value from the selected field.</td>
</tr>
<tr>
<td>Use free entry when searching</td>
<td>If the previous option, <strong>Create drop-down from choices</strong>, is enabled, the drop-down will not be used when searching for documents.</td>
</tr>
</tbody>
</table>
Default Entry

The value in this textbox will be automatically inserted in the field as a default when capturing or editing blank fields.

Use current date

The current date will be inserted in the field as a default when creating QCards™ or scanning with DirectScan™. (date only)

Field Entry Choices

Field Entry Choices

Enter one field value to a line in this text box. The values may be used to create a drop-down selection.

Keep choices sorted

Enabling this checkbox will alphabetize the Field Entry Choices list.

Sort now

This may be used to perform an immediate alphabetization of the Field Entry Choices list.

2.6.3. Deleting a Global Field

To delete a Global Field, select the icon in the row of the field you would like to delete.

When you are sure you would like to delete the field, select the Confirm button.

Deleting a Global Field

2.7. System Fields

The System Fields screen allows you to enable or disable system fields. Access it by selecting the second icon from the Admin main menu.

Two types of system fields exist. Static system fields are part of the system and cannot be removed. Dynamic system fields are managed by administrators and are fully searchable.
### Static Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date Created</td>
<td>Displays the date the document was created.</td>
</tr>
<tr>
<td>Date Modified</td>
<td>Displays the date the document was last edited, including document properties.</td>
</tr>
<tr>
<td>File Path</td>
<td>Displays the full path of the document on the server's filesystem.</td>
</tr>
<tr>
<td>File Size</td>
<td>Displays the file size of the current version of the document.</td>
</tr>
<tr>
<td>File Version</td>
<td>Displays the major version of the document.</td>
</tr>
<tr>
<td>Modified-By User</td>
<td>Displays the user that last edited the document, including document properties.</td>
</tr>
<tr>
<td>Pages Captured</td>
<td>Displays the number of pages captured for the document. This value may not be accurate with non-image file types.</td>
</tr>
</tbody>
</table>

### Dynamic Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approval-Process Status</td>
<td>Displays the last-known status of a document on a specific approval process.</td>
</tr>
<tr>
<td>&lt;blank&gt;</td>
<td>The approval process does not apply to the document.</td>
</tr>
<tr>
<td>Approved</td>
<td>The document has been fully approved.</td>
</tr>
<tr>
<td>Rejected</td>
<td>The document has been rejected off the approval process.</td>
</tr>
<tr>
<td>In Progress</td>
<td>The document has is currently on the approval process.</td>
</tr>
<tr>
<td>Removed</td>
<td>The document has been prematurely removed from the approval process.</td>
</tr>
<tr>
<td>Never Approved</td>
<td>The document has never been placed on the approval process.</td>
</tr>
<tr>
<td>Packet Completion Status</td>
<td>Displays the completion status of the document for a specific packet template.</td>
</tr>
<tr>
<td>&lt;blank&gt;</td>
<td>The packet template does not apply to the document.</td>
</tr>
<tr>
<td>Complete</td>
<td>All required document types for the packet have been added.</td>
</tr>
<tr>
<td>Incomplete</td>
<td>One or more document types for the packet have not been added. A list of missing document types will be provided.</td>
</tr>
</tbody>
</table>

When you've finished, select the ![Apply](Apply) button to save your changes.
2.8. Catalogs & Document Types

Access the Catalogs & Document Types screen by selecting the icon from the Admin main menu.

Select a catalog and document type from the drop-down lists to configure that document type.

2.8.1. Creating a New Catalog or Document Type

To create a new catalog or document type select the button to the right of the drop-down list. Provide a Name and optional Description.

If you would like to import the settings from another catalog or document type, select the checkbox to copy all document types and properties [catalog] or copy all properties [document type]. This option will
make an exact copy of only the configuration settings (including permissions, fields, approval processes, etc.). Any documents associated with the existing catalog or document type will not be copied.

A default document type will be provided when creating an empty catalog.

Select the [Apply] button when you are satisfied with your selections.

**Note**

Default system folders and settings will be used when creating a catalog from the browser interface. For more information, see Section 2.1, “System Folder and Subfolders”.

2.8.2. Renaming a Catalog or Document Type

To rename a catalog or document type select the [Apply] button to the right of the drop-down list. Provide a new **Name** and optional **Description** and select the [Apply] button when finished.
2.8.3. Deleting a Catalog or Document Type

To delete a catalog or document type select the button to the right of the drop-down list followed by the button if you wish to proceed.

Note

You cannot delete a catalog or document type when at least one document is associated with that catalog or document type.
2.8.4. Setting a Default Document Type

The default document type is used by the Catalog Service when it finds new content during a folder scan. These files do not have a descriptor defining the document type to which the content belongs, and the default document type will be applied.

To select a default, first choose the document type you wish to set, and select the button to the right of the document type drop-down list. Select the button if you wish to proceed.

2.8.5. Membership

The Document-Type Membership screen allows you to select which users and groups have access to the selected document type. Access it by selecting the icon from the Catalogs & Document Types screen.
2.8.5.1. Adding a User or Group to a Document Type

The Add User(s) and Add Group(s) screens can be accessed from the Document-Type Membership screen by selecting the Add User or Add Group buttons, respectively.

Place a check in the box for the User(s) or Group(s) you would like to add to the document type.

When you've finished, select the Apply button to save your changes.

Note

After adding a user or group to a document type, that user or group will have default permissions to Search and View documents in that document type.

Adding a Group to a document type

2.8.5.2. Deleting a User or Group from a Document Type

To delete a User or Group from the Document-Type Membership screen, select the icon in the row of the User or Group you would like to delete.

When you are sure you would like to delete the user or group, select the Confirm button.
Deleting a Group from a document type

2.8.6. Permissions

The Document-Type Permissions screen allows you to select which actions a User or Group can perform on documents in a document type. Access it by selecting the icon from the Catalogs & Document Types screen.

Assign permission to a user or group by selecting the icon in the appropriate row. Creator permissions apply to the specific user that adds a document to the system.

Place a check in the box for the Permissions you would like to assign to the user or group.

Document-Type Permissions

Allow Document Searching User can perform searches for documents in the document type.
### Allow Document Viewing Everywhere
User can view, save or e-mail documents in the document type represented in any list of results.

### Allow Document Editing
User can check out, modify, and check in documents, append to documents, and replace documents in the document type.

### Allow Document Sharing
User can assign documents of the document type to the *Work Queue* of any new or existing user. This permissions allows users to create new guest users in the system using the *Share* feature when providing an e-mail address that does not already exist in the system.

### Allow Document Adding
User can capture documents of the document type.

### Allow Document Deleting
User can delete documents of the document type.

### Allow Field Editing
User can modify document properties of documents in the document type.

### Allow Approval-Process Assignment [*Enterprise Edition*]
User can assign and set priorities to documents of the document type to approval processes.

### Allow Work-Queue Assignment [*Enterprise Edition*]
User can assign documents of the document type to the *Work Queue* of any user or group member on the document type.

### Allow Approval-Process Administration [*Enterprise Edition*]
User can access the *Admin Queue* and approval-process *History* within the *Approval Queue*.

### Allow Work-Queue Administration [*Enterprise Edition*]
User can access the *Admin Queue* within the *Work Queue*.

### Allow Retention Overrides [*Enterprise Edition*]
User can override the document-type retention policy with custom retention policies on one or more documents of the document type.

### Allow Document Viewing in Approval Queue
User can view documents only in the *Approval Queue*. This permission is available only when *Allow Document Viewing Everywhere* is not enabled.

### Document-Type Administrator [*Enterprise Edition*]
User can manage the document-type settings. Managing document-type membership is determined by a system setting. See Section 2.2, "System Settings".

---

When you've finished, select the **Apply** button to save your changes.
2.8.7. Document-Type Fields

The Manage Fields screen allows you to create, modify, and delete document fields in a document type.

Access it by selecting the icon from the Catalogs & Document Types screen.

2.8.7.1. Adding or Modifying Document-Type Fields

To add a field to a document type, select the button from the Fields screen. To modify an existing field, select the icon in the row of the field you would like to modify.

If you would like to use a Global Field, select the Use Global Field checkbox and choose the appropriate field. Otherwise, see Section 2.6.2, “Field Details”.

When you've finished, select the button to save your changes.
Field Details

2.8.7.2. Changing Capture/Edit Fields Order

The Capture/Edit Fields Order box controls the order that fields are displayed when capturing documents and modifying document properties.

To move a field's position, select the field in the list then use the \( \uparrow \) and \( \downarrow \) icons to move the field up or down, respectively.

2.8.7.3. Deleting a Document-Type Field

To delete a document-type field, select the \( \times \) icon in the row of the field you would like to delete.

When you are sure you would like to delete the field, select the Confirm button.

The Zonal Recognition screen allows you to create, modify, and delete zones used to automatically populate fields in a document type using Zonal OCR or Zonal Barcoding during the capture process. This feature works best when capturing documents with consistent formatting, e.g., Orders, Invoices, Applications.

Access the Zonal Recognition screen by selecting the icon from the Catalogs & Document Types screen.

2.8.8.1. Adding or Modifying Zones

To add a recognition zone to a document type, select the button from the Zonal Recognition screen. To modify an existing zone, select the icon in the row of the zone you would like to modify.
Selecting the **Enabled** checkbox will cause this zone to be active during document capture. Text extracted from the captured image matching the criteria specified for this zone will be written to the **Field to Populate** (selected below).

### Zone Type
Select either **OCR** to read printed text on the page or **CustomBarcode** to read a printed barcode on the page.

### Use Regular Expression to further qualify zone
If selected, you can specify a regular expression to pattern-match the obtained value. A value that does not match the pattern represented by the regular expression will be considered invalid. For more information on regular expressions, see [Regular-Expressions.info](http://www.regular-expressions.info/).

### Remove page from document if qualified zone is recognized
The page containing the value will be removed from the document.

### Begin new document for each qualified zone that is recognized
If selected, the Capture Service will generate a new document each time a qualifying value is found in the location specified.

### Only if zone value changes
If selected, the previous document-break function will occur only when a new value differs from the previous value.

### Custom-Barcode Settings
These settings are available when the **CustomBarcode** type has been selected.

- **Barcode Type**
  - Select the appropriate barcode type from the list. For a list of available symbologies, see [Appendix C, Supported Bar Code Symbologies](http://www.regular-expressions.info/).

- **Minimum Length**
  - If a barcode contains fewer characters than the value specified, it will be disregarded. A value of 0 disables the check.

- **Maximum Length**
  - If a barcode contains more characters than the value specified, it will be disregarded. A value of 0 disables the check.

### Field to Populate
The field selected from this list will be populated during the capture process when criteria for this zone is matched. A field defined without a condition (below) will not appear in this list a second time.

### Zone Location
These values specify the location and dimension for this zone. The Capture Service will extract data from the boundaries defined.

- **Left Position**
  - Defines the left coordinate of the zone measured from the left edge of the page.

- **Top Position**
  - Defines the top coordinate of the zone measured from the top edge of the page.

- **Width (OCR)**
  - Defines the width of the OCR zone.
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Height (OCR)</td>
<td>Defines the height of the OCR zone.</td>
</tr>
<tr>
<td>Horizontal Tolerance (barcodes)</td>
<td>Defines the horizontal tolerance of the barcode zone.</td>
</tr>
<tr>
<td>Vertical Tolerance (barcodes)</td>
<td>Defines the vertical tolerance of the barcode zone.</td>
</tr>
<tr>
<td>Page Number to Recognize</td>
<td>This defines which page number of the captured document will be used to extract data.</td>
</tr>
<tr>
<td>Zone Condition</td>
<td>The use of conditions determines whether or not documents will be separated by types when performing zone extraction. The Field to Populate may be defined in only one of two scenarios:</td>
</tr>
<tr>
<td>Single Zone</td>
<td>Creating a zone without a condition will cause every document captured to use this same zone when populating the selected field. In this scenario, only this one zone may be defined.</td>
</tr>
<tr>
<td>Multiple Zones</td>
<td>Creating a zone with a condition will cause only those documents matching the condition to use this zone when populating the selected field. In this scenario, several zones may be defined for the same Field to Populate. Each additional zone defined is required to use the same condition field. Each condition defined for the Field to Populate must be unique.</td>
</tr>
</tbody>
</table>

To establish a condition, select the Enable Condition checkbox followed by the appropriate field, match type (contains or equals), and value to match.

**Note**

The Zone Condition does not apply when the zone is set to the CustomBarcode type and documents are captured using a Capture Job.

Zones may be ordered using the ↑ and ↓ icons in the zone grid, determining the order that the Capture Service extracts the text. This is useful when one zone is conditional based on the value of a previous zone.

When you've finished, select the Apply button to save your changes.
2.8.8.2. Deleting a Zone

To delete a recognition zone, select the icon in the row of the zone you would like to delete.

When you are sure you would like to delete the zone, select the button.

2.8.9. Field Lookup Integration [Enterprise Edition]

The Field Lookups screen allows you to create, modify, and delete lookups used to automatically populate fields in a document type using information from an External Data Source (ODBC). At least one data source will be needed to establish a field lookup. For more information on how to add an external data source, see Section 2.3, “External Data Sources (ODBC) [Enterprise Edition]”.
Note

A field lookup performed by a user will first check if any Packet information is available. The External Data Source will be queried afterwards and will overwrite any existing values obtained from packets.

Access the Field Lookup screen by selecting the icon from the Catalogs & Document Types screen.

Field Lookups

2.8.9.1. Adding or Modifying Field Lookups

To add a lookup to a document type, select the button from the Field Lookup screen. To modify an existing lookup, select the icon in the row of the lookup you would like to modify.

Selecting the Enabled checkbox will cause the lookup to be active for capture processes, document properties updates, and coding-queue coding.

Field to Populate  This field will be automatically populated after the user enters information in the various key fields.

Data Source  This drop-down list provides the available data sources configured from the Admin main menu.

Data Table  This table will be the source of the records that will be queried.

Populate Field with  This value from this table column will be used to populate the Field to Populate.

Each lookup must have at least one lookup item. The first one will be generated for you. One or more lookup items or lookup groups can be added to the configuration using the Add Item and Add Group buttons. Lookup groups are the equivalent of parentheses grouping together one or more clause items in a database query. Boolean terms at the beginning of each lookup item determine the combine method between itself and the previous item. A static value may be entered in place of a document-type field value.
If you want to allow field lookups to overwrite existing field values when updating document properties or coding data in the Coding Queue, select the **Overwrite existing field data** checkbox.

If you want this lookup to be available only for workflow actions, select **Make available for workflow actions only**. This can be helpful if you have multiple lookups but only want one to appear in the user interface. It also allows multi-value selection from the user-interface when more than one lookup is defined in the document type.

When using the *Capture* area, updating document properties, or coding data in the *Coding Queue*, data entered in each of the document-type fields used in the lookup items will be used to query the data source, and the **Field to Populate** will be populated automatically.

When you've finished, select the **Apply** button to save your changes and return to the list of field lookups. An example of the back-end query represented by the lookup will be presented in the *Query* column.

Field lookups may be ordered using the **↑** and **↓** icons in the lookup grid. Lookups will be performed in the displayed order. This is useful when desiring to populate more than one field automatically.

The **Maximum Results** textbox can be changed from 1 to the maximum number of results you would like to present to each user when multiple matches exist for a field lookup. When more than one result is found, the user will be presented with a dialog to choose the appropriate value.

---

### Field Lookup Details

#### 2.8.9.2. Deleting a Field Lookup

To delete a field lookup, select the *x* icon in the row of the lookup you would like to delete.

When you are sure you would like to delete the lookup, select the **Confirm** button.
2.8.10. Approval Processes [Enterprise Edition]

The Approval Processes screen allows you to create, modify, and delete processes used to move a given document or packet along a path of users and/or groups. Documents and packets can be placed on an approval process using workflow rules (Enterprise Edition only) or the Start Approval Process menu item from the File menu. A single item can exist on more than one approval process simultaneously.

Members listed in the Members grid of an approval process will receive the item in their Approval Queue. When a member has completed necessary tasks related to the item, the member will either Approve or Reject it. Approving an item will send it to the next member in the process. Rejecting an item will send it to the previous member or specified earlier member.

Approval-Process Groups can be created to organize several related approval processes and simplify the creation of workflow rules.

Access the Approval Processes screen by selecting the icon from the Catalogs & Document Types screen.
Approval Processes

2.8.10.1. Adding or Modifying Approval Processes

To add an approval process to a document type, select the button from the Approval Processes screen. To modify an existing process, select the icon in the row of the process you would like to modify.

Selecting the Enabled checkbox will cause this process to be active in the document type.

Approval-Process Details

Process Name (required) This is a descriptive name for the approval process.

Priority Items placed on this approval process will have this priority as their default priority.

Members Select one or more users, groups, or document creators as members of this approval process by selecting the appropriate button.

Note

The creator of a document does not change during the document lifecycle.

Use the and icons after selecting more than one member to change the order the members will receive an item that has been placed on this process. To remove a member, select the icon in the row of the member you would like to remove.

The checkbox in the member grid located to the right of the member's position number indicates the member that will first receive all new items. Only one member can be selected.

Routing Type When the member is a group, one of the following can be specified.

68
Single User Assignments, Approvals, and Rejections will require the acting user to select a user from the group. Only the selected user will receive the item in his or her Approval Queue. (See Section 17, “The Approval Queue [Enterprise Edition].”)

Multi User All users in the group will receive the item in their Approval Queue.

Peer Review This routing type is available for groups containing only two users. When an item arrives to this member, both users in the group will receive the item in their Approval Queue until one either approves or rejects it. When approved, it will be routed to the other user (peer) in the group for approval to the next member. If the second user rejects the item, it will move back to the first user who approved it.

Requirement You may specify a number of required votes when the member is a group and the Approval Requirement for Multi-User Groups is set to Specified Number of Users in Group (see below).

Reject To You may choose a specific earlier member that will receive the item upon rejection when the Allow rejections to selected earlier members option has been set (see below).

Deadline You may specify a deadline for each member when member deadlines are enabled. If a deadline is not required for a member, select None.

Fields When selective field-editing is enabled, you can select Edit Permissions to restrict certain fields from being modified by the specific stage. Each field on the document type will be shown with an Allow Edit checkbox checked
by default. Unchecking a box next to a field will prevent the stage members from making any changes even when a document is in their queue.

### Deadlines

To enable deadlines, select the **Enable Deadlines** checkbox.

- **Approval Process Only**
  - Only the approval process as a whole will have a deadline. An optional message can be sent to administrators when deadlines are reached.

- **Approval Process and Members**
  - Both the approval process and each member of the process will have a deadline. An optional message can be sent to members and/or administrators when deadlines are reached.

- **Members Only**
  - Each member in the process will have a deadline. An optional message can be sent to these members when their individual deadlines are reached.

When a process deadline is enabled, choose an appropriate **Process Deadline** duration. When both the process and members have deadlines, you can optionally select the **Divide Process** checkbox to split the process deadline evenly among each member.

### Deadline Messaging

A message can be sent to the member and/or administrator(s) indicating the expiration of a member or process deadline. The messages can be either internal or e-mail, depending on the **Messaging Type** option.

- **No Messaging**
  - No deadline messages will be distributed.

- **Members Only**
  - Only members will receive messages about their expired deadlines.

- **Members and Approval-Process Administrators**
  - Members will receive messages about their expired deadlines, and a copy will be sent to users with the **Allow Approval-Process Administration** permission of the current document type (see Section 2.8.6).
Members and Document-Type Administrators

Members will receive messages about their expired deadlines, and a copy will be sent to administrators with the *Allow Document-Type Administration* permission of the current document type (see Section 2.8.6, “Permissions”). These administrators will also receive messages regarding expired process deadlines.

Members and System Administrators

Members will receive messages about their expired deadlines, and a copy will be sent to system administrators. System administrators will also receive messages regarding expired process deadlines.

Members and All Administrators

Members will receive messages about their expired deadlines, and a copy will be sent to all administrator types listed above. These administrators will also receive messages regarding expired process deadlines.

Approval Requirement for Multi-User Groups

This will be presented when at least one group is selected as a member. The setting only applies to multi-user group routing.

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single User in Group</td>
<td>Approvals occur when any user in the group approves the item.</td>
</tr>
<tr>
<td>Majority of Users in Group</td>
<td>Approvals occur when the majority of users in the group have approved the item.</td>
</tr>
<tr>
<td>Specified Number of Users in Group</td>
<td>Approvals occur when the Requirement of the current stage has been satisfied. When this is selected, a</td>
</tr>
</tbody>
</table>
new column will appear in the **Members** grid, and the total number of allowed votes will reflect the current number of members in the group.

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Users in Group</td>
<td>Approvals occur when all users in the group have approved the item.</td>
</tr>
<tr>
<td>Messaging Type for Notifications and Deadlines</td>
<td>This option affects arrival and deadline notifications. Choosing the <strong>Internal</strong> item causes all approval-process messages to be sent as an internal message. Choosing the <strong>E-mail</strong> item causes all approval process messages to be sent to the e-mail address on the users' Profile.</td>
</tr>
<tr>
<td>Allow rejections by first member</td>
<td>Selecting this option allows the first member to reject items on this process. Items rejected by the first member will be removed from the process. In a group-member scenario, a rejection by any user in the group will cause the item to be rejected and removed from the process.</td>
</tr>
<tr>
<td>Allow rejections to selected earlier members</td>
<td>Selecting this option allows you to specify each member's <strong>Reject To</strong> member in the grid (see above).</td>
</tr>
<tr>
<td>Notify member of new arrivals</td>
<td>Selecting this option causes each member to receive a notification when an item arrives in their <strong>Approval Queue</strong>. The message can be either an internal message or e-mail, depending on the <strong>Messaging Type</strong> setting below. This notification will be sent independently of the <strong>User Preference</strong>.</td>
</tr>
<tr>
<td>Automatically start this process on all captured content</td>
<td>Selecting this option will cause all captured documents of the document type (and documents...</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Remove from this process when assigned to any other process</td>
<td>Selecting this option will cause an item on the approval process to be removed from the process if placed on a different process.</td>
</tr>
<tr>
<td>Require note on all assignments and stage changes</td>
<td>Selecting this option will cause all interaction with this process to require a note entered by the user.</td>
</tr>
<tr>
<td>Combine notes from previous member and current member when approving</td>
<td>Selecting this option will combine any note entered on a previous stage with any note entered on the current stage when approving a document.</td>
</tr>
<tr>
<td>Allow custom member names</td>
<td>Selecting this option provides an additional column in the member grid to provide custom names to describe the member. Any provided names will override the original name of the member in all locations where it appears, including the Approval Queue.</td>
</tr>
<tr>
<td>Enable system field</td>
<td>Selecting this option will create a searchable System Field that also can be used as a results-grid column and informational document property.</td>
</tr>
<tr>
<td>Allow selective field editing by active member only</td>
<td>Selecting this option allows field values to be modified only by the active member. A new column named committed in the Coding Queue) to be placed on this approval process automatically. Do not select this option if you wish to route only a portion of captured documents based on specific criteria; you can create a custom Workflow Rule to accomplish routing with more specific requirements.</td>
</tr>
</tbody>
</table>
Fields will be added to the Members grid to further restrict field editing by the active member. Prevent field editing by all non members when document is on this process. When selected, any user that does not have an affiliation with this approval process will not be able to modify any field values for a given document until that document has left the process.

When you've finished, select the button to save your changes.

---

**Approval Process Details**

2.8.10.2. Adding or Modifying Approval-Process Groups

To add an approval-process group to a document type, select the button from the Approval-Process Groups screen. To modify an existing group, select the icon in the row of the group you would like to modify.

**Approval-Process Group Details**

- **Group Name (required)**: This is a descriptive name for the group.
- **Description (optional)**: This is a detailed description for the group.
- **Approval Processes**: Select one or more processes for this group. To remove a process, select the icon in the row of the group you would like to remove.
- **Options**: Create assignment drop-down list for documents. Selecting this option will allow an approval-process to
be assigned to individual documents of the document type. The drop-down list appears in the Capture area and Document Properties area, including the Coding Queue.

Automatically start assigned process on all captured content of this document type

Selecting this option will cause all captured documents of the document type (and documents committed in the Coding Queue) to be placed on the assigned approval process automatically.

Automatically start assigned process when document assignment updated

Selecting this option will cause an updated approval-process assignment on a document of the document type to be placed on the assigned approval process automatically.

Hide drop-down list after document has been routed to any approval process in this group

Selecting this option will cause the drop-down list to be hidden from a document after the document has been assigned at least one time to one of the approval processes in this group.

Require entry

Selecting this option will require that an approval process from the group be assigned to all documents of the document type.

When you've finished, select the [Apply] button to save your changes.

2.8.10.3. Deleting an Approval Process or Approval-Process Group

To delete an approval process or approval-process group, select the [ ] icon in the row of the process or group you would like to delete.

When you are sure you would like to delete the process or group, select the [Confirm] button.
2.8.11. Workflow [Enterprise Edition]

For complete information on Workflow, see Section 2.11, “Workflow [Enterprise Edition].”


For complete information on Message Templates, see Section 2.10, “Message Templates [Enterprise Edition].”

2.8.13. Folder & File Building

The Folder & File Building screen controls how documents will be stored and named within the Documents data folder during the capture process. Access it by selecting the icon from the Catalogs & Document Types screen.

There are two separate functions: Folder Building and File Building. To enable one or both functions, select the appropriate checkbox at the top of the screen.

If you would like to allow users to choose whether or not these rules will apply during field updates, select the Allow users to bypass checkbox. When the option is presented to a user, the default behavior is to bypass these rules.

The Invalid folder/file substitution character will be used in place of any document-property characters not allowed in Windows® folder and file names (\ / : * ? " < > | ). The text entered in the Folder name when field is empty text box will be used to name a folder when an optional document property is left blank while capturing a document. After configuring your folder and/or file name templates, select the Apply button at the bottom of the screen.
2.8.13.1. Building a Folder-Structure Template

This function allows you to create a template of the folder structure that will be generated when storing each captured document. You may combine one or more fields along with custom text values for each folder level. In a typical configuration, the primary identifying field, such as Name or Number, will be used for the first folder level. You may create the structure as many levels deep as necessary.

1. Locate the Folder Building Items section.
2. Select the Type of data you would like to be added to the current folder level.
3. If you've selected the Field type, select the appropriate field from the drop-down list.
4. If you've selected the Field type, you may optionally choose to use only a left portion of the field value.
5. Select the Add Item button to add the selected item to the template.
6. Repeat steps 2-4 to continue adding items to the current folder level.

7. To add a new folder level, select the `New Folder` button. Repeat steps 2-5 for this new folder level.

   To change the order of the items within the template, use the ⬆️ and ⬇️ icons in the template grid. To remove an item from the template, select the ✖️ icon in the item's row.

**2.8.13.2. Building a File-Name Template**

This function allows you to create a template of the file name that will be generated when storing each captured document. You may combine one or more fields along with custom text values for the file name. In a typical configuration, the primary identifying field, such as Name or Number, will be used to begin the file name. Custom text values, such as a hyphen, space, or underscore, are typically used to separate the different fields used in the file name.

1. Locate the **File Building Items** section.

2. Select the **Type** of data you would like to be added to the file name.

3. If you've selected the **Field** type, select the appropriate field from the drop-down list.

4. Select the `Add Item` button to add the selected item to the template.

5. Repeat steps 2-4 to continue adding items to the file name.

   To change the order of the items within the template, use the ⬆️ and ⬇️ icons in the template grid. To remove an item from the template, select the ✖️ icon in the item's row.


The **Capture Forms** screen allows you to upload and manage one or more static PDF forms containing one or more fields and at least one submit button. These forms can be used as templates to generate new documents in the catalog.

As an alternative to static forms, the entire document type can be defined as a dynamic capture form. In this scenario, all PDF files of the associated document type will be displayed with a submit button based on the configuration. This is useful when you would like documents to receive signatures or other annotations and then resubmitted to Content Central with the click of a button.

Access the **Capture Forms** screen by selecting the ⌁ icon from the **Catalogs & Document Types** screen.
2.8.14.1. Adding or Modifying Static Forms

To add a static PDF AcroForm to the document type, select the button from the Capture Forms screen. To modify an existing form, select the icon in the row of the form you would like to modify.

Upload a form template by browsing to its location followed by selecting the button.

**Important**

Only AcroForms (Acrobat Forms) and XFA forms through version 2.4 (Acrobat 7) are currently supported.

Selecting the Enabled checkbox will cause this form to be active during document capture.

Provide a Name and optional Description to identify your uploaded form.

Select the appropriate Submit Button within the form that will be used to generate the new document upon selection by a user.

Choose a Session Expiration value. This controls how long a given form will be available for submission whenever a form is created or downloaded and contains a submit button.

Select Allow field updates from document-properties updates if you would like field-value commits to change the values inside the PDF files that match this form.

Finally, select whether or not you would like to Allow revisions via submit button. Disabling this option will prevent the submit button from displaying on forms when viewing a document created with this form.

When you've finished, select the button to save your changes.
2.8.14.2. Defining a Dynamic Form

The document type can be defined as a dynamic form only when no other capture forms have been added. Select *Create submit-ready forms from all PDFs* to add the configuration details for the dynamic form.

**Note**

This will affect only PDF files and they will appear as AcroForms to PDF viewers.

Selecting the *Enabled* checkbox will cause this functionality to be active when viewing any PDF files of the document type.

Provide a name for *Submit Button* along with the location and dimensions you desire for the button. When entering *Left* and *Top* coordinates, be careful to consider the dimensions of the smallest-sized first-page image of the documents in consideration.

Choose a *Session Expiration* value. This controls how long a given form will be available for submission whenever a form is downloaded for submission.

If you would like to prevent a form from being submitted from a mobile device (or other device) without a signature (or other annotation), select *Accept submissions only when they contain a minimum number of new annotations*. Then choose a *Minimum Number of New Annotations*.

When you've finished, select the *Apply* button to save your changes.

2.8.14.3. Deleting a Form

To delete a capture form, select the icon in the row of the form you would like to delete.

When you are sure you would like to delete the form, select the *Confirm* button.
Deleting a Capture Form

2.8.15. Retention Policies [Enterprise Edition]

The Retention Policy screen defines the length of time documents of the document type will be retained.

Access it by selecting the icon from the Catalogs & Document Types screen.

With an Enabled policy, documents will expire when their creation date is older than the Length of time documents of this document type will be retained. The Catalog Service is responsible for removing these expired documents from the Content Central database and moving the files to the Deleted Content folder specified in the Configuration Manager. The document destruction process will occur at the frequency, starting day, and starting hour specified.

Users with the Allow Retention Overrides permission can override the default document-type retention policy and specify custom retention policies on individual documents of the document type.

When you've finished defining the policy for this document type, select the button to save your changes.
2.8.16. Default Search Fields

The Default Search Fields screen allows you to select the default fields a user can search within this document type. Access it by selecting the icon from the Catalogs & Document Types screen.

Select fields in the Available Fields box and move them to the Default Search Fields box using the icon, then use the and icons after selecting one or more fields to change the order the fields will appear on the screen.

If you need to remove a field from the Default Search Fields box, use the icon.

Tip

Select Add Capture/Edit Fields below the Default Search Fields box to save time and add the fields from the document type with the Use this field when capturing/editing option enabled.

When you've finished, select the button to save your changes.
2.8.17. Default Results Fields

The Default Search Results Fields screen allows you to select the default fields a user will see in the results grid after a search is performed for documents of this document type. Access it by selecting the icon from the Catalogs & Document Types screen.

Select fields in the Available Fields box and move them to the Default Results Fields box using the ➔ icon, then use the ↑ and ↓ icons after selecting one or more fields to change the order the fields will appear in the grid.

If you need to remove a field from the Default Results Fields box, use the 🚣 icon.

Tip

Select Add Search Fields below the Default Results Fields box to save time and add the fields from the Default Search Fields selection.

When you've finished, select the Apply button to save your changes.
Selecting Default Search Results Fields

2.9. Packet Templates [Corporate Edition and higher]

Several documents can be grouped together as a packet with nothing more than a field value shared among them. A Packet Template determines the Key Field and document types that comprise these packets. These templates provide user access to packets via the area and the Packet menu item from the View menu. They also provide a mechanism to efficiently produce QCards™ for each of the document types in one step.

Access the Packet Templates screen by selecting the icon from the Admin main menu.
2.9.1. Adding or Modifying a Packet Template

Templates are based on a key field, and this key field is based on one of any available Global Fields. After confirming at least one global field exists, and these global fields have been used in one or more document types, select the button to add the template.

To modify an existing template, select the icon in the appropriate row.

Selecting the Enabled checkbox will allow the template to be accessed by users. Provide a Name and optional Description for the template, followed by selecting the Key Field from the list of available global fields.

Select one or more document types that apply to the particular packet. Only document types containing the selected Key Field will be available for selection.

The Req'd checkbox in each row determines whether or not a given document type will be required for packet completion. When at least one document exists for each of the required document types, the packet will be considered complete, and this will be indicated when a user views a packet using the Packet menu item from the View menu.

The Lookup checkbox in each row determines whether field lookups will be available for a given document type. Fields common to the packet can be automatically populated based on the Key Field. The lookup will source the primary document type to obtain these values.

The Primary Document Type should be set to the document type that is captured first or represents the core document type around which all the others in the packet are based. The selected document type is the one that will appear in users' Approval Queue when a packet is assigned to an approval process. It is also the document type that must be used when assigning a packet to an approval process.

Selecting the Enable System Field checkbox will create a searchable System Field that also can be used as a results-grid column and informational document property.

After selecting the appropriate data for the template, select to save your changes.
2.9.2. Deleting a Packet Template

To delete a template, select the icon in the appropriate row.

When you are sure you would like to delete the template, select the button.

![Deleting a Packet Template](image)

2.10. Message Templates [Enterprise Edition]

Message Templates can be generated to help make users more efficient and provide actions for Workflow.

Access it by selecting the icon from the main menu or from the Workflow menu.

The filter lists located at the top of the page will help you navigate through existing message templates. You can also filter by name, description, recipients, subject, and body using the filter textbox below the list of templates. Select the Hide system records checkbox to hide system-generated templates.

![Manage Message Templates](image)
2.10.1. Adding or Modifying Message Templates

To add a message template, select the [Add Template] button from the Message Templates screen. To modify an existing template, select the [ ] icon in the row of the template you would like to modify.

2.10.2. Message-Template Details

Selecting the Enabled checkbox will cause this template to be active.

Message-Template Details

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Template Name (required)</td>
<td>This is a descriptive name for the template.</td>
</tr>
<tr>
<td>Description (optional)</td>
<td>This provides a more detailed description of the template.</td>
</tr>
<tr>
<td>Message Type</td>
<td>Message Types</td>
</tr>
<tr>
<td>E-mail</td>
<td>These templates can be used to send e-mails.</td>
</tr>
<tr>
<td>Fax</td>
<td>These templates can be used to send faxes.</td>
</tr>
<tr>
<td>Internal</td>
<td>These templates can be used to send messages to other users in Content Central.</td>
</tr>
<tr>
<td>Scope (Defaults to Document type when in a document type)</td>
<td>Scope Type</td>
</tr>
<tr>
<td>Global</td>
<td>The template will be available to all catalogs and document types.</td>
</tr>
<tr>
<td>Document Type</td>
<td>The template will be available to only a single document type.</td>
</tr>
<tr>
<td>Catalog &amp; Document type (Document type scope only)</td>
<td>Visibility Type</td>
</tr>
<tr>
<td>The template will be available to only the selected document type.</td>
<td>E-mail &amp; Fax (required)</td>
</tr>
</tbody>
</table>
| E-mail & Fax                 | Enter one or more e-mail addresses or fax numbers, respectively, each separated by a semicolon. You may also use Message-Template Codes.
Web Site Administration

Internal

Select one or more users and/or groups from the Available boxes and add them to the Selected boxes using the ➫ icon. If you need to remove one or more recipients, select the recipient(s) from the Selected box followed by the ➫ icon.

CC: (E-mail, optional)

A copy of the e-mail will be sent to these e-mail addresses. You may use Message-Template Codes.

To: (Fax, optional)

The fax-recipient's name goes here. You may use Message-Template Codes.

Company: (Fax, optional)

The fax-recipient's company name goes here. You may use Message-Template Codes.

Subject (required)

The subject identifies the message body in short. You may use Message-Template Codes.

Body (optional)

The body contains the details of the message. You may use Message-Template Codes.

Allow users to customize recipients, subject, and body during manual send (E-mail and Fax)

Selecting this checkbox allows users to modify the identified template items.

When you've finished, select the ➤ button to save the template.

Message-Template Details

2.10.3. Duplicating a Message Template

This feature saves you time when you need to create multiple templates with only a small difference among them. To duplicate a message template, select the ➫ icon in the row of the template you would like to copy.

When you are sure you would like to duplicate the template, select the ➤ Confirm button.
2.10.4. Deleting a Message Template

To delete a message template, select the icon in the row of the template you would like to delete.

When you are sure you would like to delete the template, select the button.

2.10.5. Message-Template Codes

The following list of codes may be entered in any of the text boxes in a message template. These codes are case insensitive.

**Codes**

{Catalog;} The catalog name for the document
Web Site Administration

{!DocType;} The document type name for the document
{!DocName;} The base file name of the document (does not include the version)
{!DocFolder;} The folder path for the current version of the document
{!DocFileName;} The file name for the current version of the document
{!DocPath;} The full path to the current version of the document
{!DocId;} The internal identifier for the document
{!DocCreatedDate;} The local creation date of the document
{!DocModifiedDate;} The local modification date of the document
{!DocVersion;} The current version of the document
{!Field:Field Name;} The value for the specified field (Replace Field Name with a real field name,) in a document

{!PacketName;} The name of the packet template
{!PacketFieldName;} The name of the key field of the packet template
{!PacketFieldValue;} The value of the key field of the packet
{!PacketStatus;} One of the following indicators for the packet
Packet is complete.
Packet is incomplete. The following document types are missing: doctype1, doctype2...doctypeN.

{!ActingUserUserName;} The username of the user causing the action
{!ActingUserFirstName;} The first name of the user causing the action
{!ActingUserLastName;} The last name of the user causing the action
{!ActingUserEmailAddress;} The e-mail address of the user causing the action
{!APName;} The name of the approval process when the workflow trigger is of type: Approval Process: Movement on Process
{!APAction;} One of the following approval-process actions when the workflow trigger is of type: Approval Process: Movement on Process
Assigned to Process
Approved
Rejected
Process Completed
Rejected from Process
Removed from Process

{!APDate;} The date of the approval-process event when the workflow trigger is of type: Approval Process: Movement on Process
2.11. Workflow [Enterprise Edition]

2.11.1. Introduction

Workflow, composed of Triggers, Actions, and Rules, allows for complex operations to take place automatically in Content Central. Workflow Triggers are based on live events or schedules. Workflow Actions operate on documents, Coding Queue items, or numbers. Workflow Rules combine Workflow Triggers with Workflow Actions to perform automated operations within the system.

Example 4.2. Placing Captured Documents on an Approval Process and Notifying Users

A Workflow Trigger has been created to respond when any Application for Admission has been captured in the system. A Workflow Action has been created to place matching documents on an approval process. An additional Workflow Action has been created to send any matching documents as an attachment in e-mail addressed to several school administrators to notify them of the new applications. A Workflow Rule has been created to link the Trigger with the two Actions.

Access the Workflow main menu by selecting the icon from the main menu.
2.11.2. Workflow Triggers

The Manage Workflow Triggers page handles the creation, modification, and deletion of Workflow Triggers. Access it by selecting the icon from the Workflow main menu.

The filter lists located at the top of the page will help you navigate through existing triggers. You can also filter by name and description with the filter textbox below the list of triggers. Select the Hide system records checkbox to hide system-generated triggers.

2.11.2.1. Adding or Modifying Workflow Triggers

To add a trigger, select the button from the Workflow Triggers page. To modify an existing trigger, select the icon in the row of the trigger you would like to modify.
When you've finished configuring the trigger, select the **Apply** button to save it.

### 2.11.2.2. Duplicating a Workflow Trigger

This feature saves you time when you need to create multiple triggers with only a small difference among them. To duplicate a workflow trigger, select the **icon** in the row of the trigger you would like to copy.

When you are sure you would like to duplicate the trigger, select the **Confirm** button.

### 2.11.2.3. Deleting a Workflow Trigger

To delete a workflow trigger, select the **icon** in the row of the trigger you would like to delete.

When you are sure you would like to delete the trigger, select the **Confirm** button.
### 2.11.3. Workflow-Trigger Types

<table>
<thead>
<tr>
<th>Trigger Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approval Processes: Age of Process</td>
<td>This trigger returns documents on an approval process that have reached the provided age.</td>
</tr>
<tr>
<td>Approval Processes: Age of Stage</td>
<td>This trigger returns documents on an approval process stage that have reached the provided age.</td>
</tr>
<tr>
<td>Approval Processes: Assignment Update</td>
<td>This trigger returns documents that have had one or more approval-process assignments updated.</td>
</tr>
<tr>
<td>Approval Processes: Items in Process</td>
<td>This trigger returns the number of documents on an approval process.</td>
</tr>
<tr>
<td>Approval Processes: Items in Stage</td>
<td>This trigger returns the number of documents on an approval process stage.</td>
</tr>
<tr>
<td>Approval Processes: Movement on Process</td>
<td>This trigger returns documents that arrive on, move through, or leave an approval process determined by the selected movement.</td>
</tr>
<tr>
<td>Coding-Queue Age: Age of All Content in the Coding Queue</td>
<td>This trigger returns documents in the Coding Queue that have reached the provided age.</td>
</tr>
<tr>
<td>Coding-Queue Age: Age of Catalog Content in the Coding Queue</td>
<td>This trigger returns documents in the Coding Queue matching the specified catalog that have reached the provided age.</td>
</tr>
<tr>
<td>Coding-Queue Age: Age of Document-Type Content in the Coding Queue</td>
<td>This trigger returns documents in the Coding Queue matching the specified document type that have reached the provided age.</td>
</tr>
<tr>
<td>Coding-Queue Arrival: All Arrivals</td>
<td>This trigger returns newly arrived documents in the Coding Queue.</td>
</tr>
<tr>
<td>Coding-Queue Arrival: Arrival in a Catalog</td>
<td>This trigger returns newly arrived documents in the Coding Queue matching the specified catalog.</td>
</tr>
<tr>
<td>Trigger Type</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Coding-Queue Arrival: Arrival in a Document Type</td>
<td>This trigger returns newly arrived documents in the Coding Queue matching the specified document type.</td>
</tr>
<tr>
<td>Coding-Queue Commit: All Commits</td>
<td>This trigger returns documents committed in the Coding Queue.</td>
</tr>
<tr>
<td>Coding-Queue Commit: Committed in a Catalog</td>
<td>This trigger returns documents committed in the Coding Queue matching the specified catalog.</td>
</tr>
<tr>
<td>Coding-Queue Commit: Committed in a Document Type</td>
<td>This trigger returns documents committed in the Coding Queue matching the specified document type.</td>
</tr>
<tr>
<td>Coding-Queue Deletion: All Content Deleted in the Coding Queue</td>
<td>This trigger returns documents deleted in the Coding Queue.</td>
</tr>
<tr>
<td>Coding-Queue Deletion: Catalog Content Deleted in the Coding Queue</td>
<td>This trigger returns documents deleted in the Coding Queue matching the specified catalog.</td>
</tr>
<tr>
<td>Coding-Queue Deletion: Document-Type Content Deleted in the Coding Queue</td>
<td>This trigger returns documents deleted in the Coding Queue matching the specified document type.</td>
</tr>
<tr>
<td>Coding-Queue Field Values: Age of a Field Value Assigned to Coding-Queue Content</td>
<td>This trigger returns documents in the Coding Queue when the specified field value has reached the provided age.</td>
</tr>
<tr>
<td>Coding-Queue Field Values: Field Value Updated in the Coding Queue</td>
<td>This trigger returns documents in the Coding Queue when the specified field is updated.</td>
</tr>
<tr>
<td>Coding-Queue Query: All Coding-Queue Content</td>
<td>This trigger returns documents in the Coding Queue.</td>
</tr>
<tr>
<td>Coding-Query Query: Coding-Queue Content in a Catalog</td>
<td>This trigger returns documents in the Coding Queue matching the specified catalog.</td>
</tr>
<tr>
<td>Coding-Queue Query: Coding-Queue Content in a Document Type</td>
<td>This trigger returns documents in the Coding Queue matching the specified document type.</td>
</tr>
<tr>
<td>Content Age: Age of All Content</td>
<td>This trigger returns documents in the system that have reached the provided age.</td>
</tr>
<tr>
<td>Content Age: Age of Content in a Catalog</td>
<td>This trigger returns documents in the system matching the specified catalog that have reached the provided age.</td>
</tr>
<tr>
<td>Content Age: Age of Content in a Document Type</td>
<td>This trigger returns documents in the system matching the specified document type that have reached the provided age.</td>
</tr>
<tr>
<td>Content Capture: All Captured Content</td>
<td>This trigger returns captured documents in the system.</td>
</tr>
<tr>
<td>Content Capture: Content Captured in a Catalog</td>
<td>This trigger returns captured documents in the system matching the specified catalog.</td>
</tr>
<tr>
<td>Content Capture: Content Captured in a Document Type</td>
<td>This trigger returns captured documents in the system matching the specified document type.</td>
</tr>
<tr>
<td>Trigger Description</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Content Check-In: All Checked-In Content</td>
<td>This trigger returns checked-in documents in the system.</td>
</tr>
<tr>
<td>Content Check-In: Checked-In Content in a Catalog</td>
<td>This trigger returns checked-in documents in the system matching the specified catalog.</td>
</tr>
<tr>
<td>Content Check-In: Checked-In Content in a Document Type</td>
<td>This trigger returns checked-in documents in the system matching the specified document type.</td>
</tr>
<tr>
<td>Content Check-Out: All Checked-Out Content</td>
<td>This trigger returns checked-out documents in the system.</td>
</tr>
<tr>
<td>Content Check-Out: Checked-Out Content in a Catalog</td>
<td>This trigger returns checked-out documents in the system matching the specified catalog.</td>
</tr>
<tr>
<td>Content Check-Out: Checked-Out Content in a Document Type</td>
<td>This trigger returns checked-out documents in the system matching the specified document type.</td>
</tr>
<tr>
<td>Content Delay: Lack of Content Added in the System</td>
<td>This trigger returns true when a document has not been added to the system within the duration specified.</td>
</tr>
<tr>
<td>Content Delay: Lack of Content Added in a Catalog</td>
<td>This trigger returns true when a document has not been added to the specified catalog within the duration specified.</td>
</tr>
<tr>
<td>Content Delay: Lack of Content Added in a Document Type</td>
<td>This trigger returns true when a document has not been added to the specified document type within the duration specified.</td>
</tr>
<tr>
<td>Content Deletion: All Deleted Content</td>
<td>This trigger returns documents deleted in the system.</td>
</tr>
<tr>
<td>Content Deletion: Content Deleted in a Catalog</td>
<td>This trigger returns documents deleted in the system matching the specified catalog.</td>
</tr>
<tr>
<td>Content Deletion: Content Deleted in a Document Type</td>
<td>This trigger returns documents deleted in the system matching the specified document type.</td>
</tr>
<tr>
<td>Content DocType Change: All Document-Type Changes</td>
<td>This trigger returns documents in the system when they have been changed to any other document type.</td>
</tr>
<tr>
<td>Content DocType Change: Document-Type Change in a Catalog</td>
<td>This trigger returns documents in the system when they have been changed to any document type in the specified catalog.</td>
</tr>
<tr>
<td>Content DocType Change: Changed to Specified Document Type</td>
<td>This trigger returns documents in the system when they have been changed to the specified document type.</td>
</tr>
<tr>
<td>Content Field Values: Age of a Field Value Assigned to Content</td>
<td>This trigger returns documents in the system when the specified field value has reached the provided age.</td>
</tr>
<tr>
<td>Content Field Values: Field Value Updated in a Document Type</td>
<td>This trigger returns documents in the system when the specified field is updated.</td>
</tr>
<tr>
<td>Content Field Values: Global-Field Value Updated in the System</td>
<td>This trigger returns documents in the system when the specified global field is updated.</td>
</tr>
<tr>
<td>Content Field Values: Global-Field Value in DocType Updated in the System</td>
<td>This trigger returns documents in the system when the specified global field in the specified document type is updated.</td>
</tr>
<tr>
<td>Trigger</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Content Query: All Content</td>
<td>This trigger returns documents in the system.</td>
</tr>
<tr>
<td>Content Query: Content in a Catalog</td>
<td>This trigger returns documents in the system matching the specified catalog.</td>
</tr>
<tr>
<td>Content Query: Content in a Document Type</td>
<td>This trigger returns documents in the system matching the specified document type.</td>
</tr>
<tr>
<td>Content Revision Upload: All Revised Content</td>
<td>This trigger returns documents in the system revised by upload.</td>
</tr>
<tr>
<td>Content Revision Upload: Revised Content in a Catalog</td>
<td>This trigger returns documents in the system revised by upload matching the specified catalog.</td>
</tr>
<tr>
<td>Content Revision Upload: Revised Content in a Document Type</td>
<td>This trigger returns documents in the system revised by upload matching the specified document type.</td>
</tr>
<tr>
<td>Packet Query: Complete Packets</td>
<td>This trigger returns packets in the system that have all its required document types fulfilled.</td>
</tr>
<tr>
<td>Packet Query: Incomplete Packets</td>
<td>This trigger returns packets in the system that do not have all its required document types fulfilled.</td>
</tr>
<tr>
<td>Reports: Report Scheduler</td>
<td>This trigger provides scheduling for running reports in the system.</td>
</tr>
<tr>
<td>Queue Items: All Coding-Queue Items</td>
<td>This trigger returns the total number of documents in the Coding Queue.</td>
</tr>
<tr>
<td>Queue Items: All Approval-Queue Items</td>
<td>This trigger returns the total number of documents in the Approval Queue.</td>
</tr>
<tr>
<td>Queue Items: All Work-Queue Items</td>
<td>This trigger returns the total number of documents in the Work Queue.</td>
</tr>
<tr>
<td>Queue Items: Coding-Queue Items in a Catalog</td>
<td>This trigger returns the total number of documents in the Coding Queue matching the specified catalog.</td>
</tr>
<tr>
<td>Queue Items: Coding-Queue Items in a Document Type</td>
<td>This trigger returns the total number of documents in the Coding Queue matching the specified document type.</td>
</tr>
<tr>
<td>Queue Items: Approval-Queue Items in a Catalog</td>
<td>This trigger returns the total number of documents in the Approval Queue matching the specified catalog.</td>
</tr>
<tr>
<td>Queue Items: Approval-Queue Items in a Document Type</td>
<td>This trigger returns the total number of documents in the Approval Queue matching the specified document type.</td>
</tr>
<tr>
<td>Queue Items: Work-Queue Items in a Catalog</td>
<td>This trigger returns the total number of documents in the Work Queue.</td>
</tr>
<tr>
<td>Queue Items: Work-Queue Items in a Document Type</td>
<td>This trigger returns the total number of documents in the Work Queue matching the specified document type.</td>
</tr>
<tr>
<td>System Query: Items Queued in the Capture Service</td>
<td>This trigger returns the total number of items queued for processing in the Capture Service.</td>
</tr>
<tr>
<td>System Query: Users Logged-In to the System</td>
<td>This trigger returns the total number of users logged-in to Content Central.</td>
</tr>
</tbody>
</table>
Work-Queue Age: Age of All Content in the Work Queue
This trigger returns documents in the Work Queue that have reached the provided age.

Work-Queue Age: Age of Catalog Content in the Work Queue
This trigger returns documents in the Work Queue matching the specified catalog that have reached the provided age.

Work-Queue Age: Age of Document-Type Content in the Work Queue
This trigger returns documents in the Work Queue matching the specified document type that have reached the provided age.

Work-Queue Arrival: All Arrivals
This trigger returns newly arrived documents in the Work Queue.

Work-Queue Arrival: Arrival in a Catalog
This trigger returns newly arrived documents in the Work Queue matching the specified catalog.

Work-Queue Arrival: Arrival in a Document Type
This trigger returns newly arrived documents in the Work Queue matching the specified document type.

Work-Queue Departure: All Departures
This trigger returns documents removed from the Work Queue.

Work-Queue Departure: Departure in a Catalog
This trigger returns documents removed from the Work Queue matching the specified catalog.

Work-Queue Departure: Departure in a Document Type
This trigger returns documents removed from the Work Queue matching the specified document type.

2.11.4. Workflow-Trigger Requirements and Options

Common Selections

• Trigger Name (required)

• Description (optional)

• Catalog

• Document Type

Common Requirements

Minimum Age This is the minimum age for which the trigger will consider matching records.

Minimum Items This is the minimum number of items for which the trigger will consider a match.

Approval-Process Requirements

Approval-Process Evaluation This evaluation method determines whether a single approval-process or member of an approval-process group will be queried.

Single Approval Process A single approval process will be evaluated.

Approval-Process Group All approval-process members of the selected approval-process group will be queried.
### Approval Process
This is the approval process that this trigger will query.

### Approval-Process Group
This is the approval-process group containing an approval process that this trigger will query.

### Approval-Process Evaluation
This evaluation method determines whether all approval-processes or a single approval process in the selected group will be queried.

<table>
<thead>
<tr>
<th>Evaluation Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Approval Processes in Group</td>
<td>All approval processes in the selected group will be queried.</td>
</tr>
<tr>
<td>Selected Approval Processes in Group</td>
<td>Only the selected approval process from the group will be queried.</td>
</tr>
</tbody>
</table>

### Stage
This is the approval process stage that this trigger will query.

### Process Evaluation
This identifies the movement(s) that will execute this trigger.

### Movement Type

<table>
<thead>
<tr>
<th>Movement Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Movement</td>
<td>All movement (forward and backward) on the approval process will execute this trigger.</td>
</tr>
<tr>
<td>New Arrival on Process</td>
<td>All arrivals on the approval process will execute this trigger.</td>
</tr>
<tr>
<td>Approval by Final Member</td>
<td>An approval by the final member on the approval process will execute this trigger.</td>
</tr>
<tr>
<td>Rejection by First Member</td>
<td>A rejection by the first member on the approval process will execute this trigger. In a group-member scenario, a rejection by any user in the group will execute this trigger.</td>
</tr>
<tr>
<td>All Approvals</td>
<td>All approvals on the approval process will execute this trigger.</td>
</tr>
<tr>
<td>All Rejections</td>
<td>All rejections on the approval process will execute this trigger.</td>
</tr>
<tr>
<td>Single Approval</td>
<td>An approval by a selected member on the approval process will execute this trigger.</td>
</tr>
<tr>
<td>Trigger Type</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Single Rejection</td>
<td>A rejection by a selected member on the approval process will execute this trigger.</td>
</tr>
<tr>
<td>Arrival to Stage</td>
<td>All arrivals to the specified stage, regardless of approved or rejected status, will execute this trigger.</td>
</tr>
<tr>
<td>Removal by Administrator</td>
<td>All administrator removals will execute this trigger.</td>
</tr>
</tbody>
</table>

**Stage Change**
This is the stage change that this trigger will query. This only appears on Stage-Change Types *Single Approval* and *Single Rejection*.

**Minimum Age**
This is the minimum age for which the trigger will consider matching records.

**Minimum Items**
This is the minimum number of items for which the trigger will consider a match.

**Capture/Arrival/Commit Requirements**

**Source Evaluation**
This determines which capture source(s) will be queried.

**Source Type**

<table>
<thead>
<tr>
<th>Source Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Sources</td>
<td>All capture sources will execute this trigger.</td>
</tr>
<tr>
<td>Capture-Form Submission</td>
<td><em>Capture Form</em> submissions will execute this trigger.</td>
</tr>
<tr>
<td>Catalog Service Folder Scan</td>
<td>Documents added to the system by the Catalog Service will execute this trigger.</td>
</tr>
<tr>
<td>DirectScan Upload</td>
<td>Documents uploaded using the DirectScan™ applet will execute this trigger.</td>
</tr>
<tr>
<td>Drag-and-Drop Upload</td>
<td>Documents uploaded using any drag-and-drop applet will execute this trigger.</td>
</tr>
<tr>
<td>Electronic Upload</td>
<td>Documents uploaded using the <em>Electronic Capture Type</em> will execute this trigger.</td>
</tr>
<tr>
<td>No-Descriptor Capture Job</td>
<td>Documents added to the system by any <em>Capture Job</em> not using a descriptor will execute this trigger.</td>
</tr>
</tbody>
</table>
### Web Site Administration

<table>
<thead>
<tr>
<th>QCard Scan</th>
<th>Documents added to the system by any descriptor will execute this trigger.</th>
</tr>
</thead>
<tbody>
<tr>
<td>XML Capture Job</td>
<td>Documents added to the system by any XML descriptor will execute this trigger.</td>
</tr>
</tbody>
</table>

#### Format Evaluation

This optional evaluation method determines the file formats that will be queried. When **Selected Formats** is chosen, enter one file extension (with or without period prefix) per line. Only captured documents with matching file extensions will be queried.

#### Field Evaluation

This optional evaluation method determines the specified field's value or presence of a value that will satisfy this trigger. When **Selected Field Value(s)** is chosen, select a **Field** from the list and the value(s) that will execute this trigger. When **Selected Field Has Value** is chosen, the selected **Field** must have a value before the trigger will execute. When **Selected Field Lacks Value** is chosen, the selected **Field** must be empty before the trigger will execute.

#### Field Type - for Selected Field Value(s)

<table>
<thead>
<tr>
<th><strong>Text</strong></th>
<th><strong>Field-Value Type</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field</strong></td>
<td><strong>Value</strong></td>
</tr>
</tbody>
</table>

**Field-Value Type**

- Uses Field Entry Choices for Drop-Down list (see Section 2.6.2, “Field Details”)

- Select one or more choices from the **Available Choices** box that should execute this trigger and add them to the **Selected Choices** box using the ➡️ icon. If you need to remove one or more choices, select the choice(s) to remove from the **Selected Choices** box followed by the ⬅️ icon.

- Does Not Use Field Entry Choices for Drop-Down list

<table>
<thead>
<tr>
<th><strong>Date</strong></th>
<th><strong>Field-Match Type</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field</strong></td>
<td><strong>Value</strong></td>
</tr>
</tbody>
</table>

**Field-Match Type**

- **Equals**

- Enter the field value that will execute this trigger.

- **Equal to Current Date**

- The trigger will execute for all field values equal to the current date.

- **Less Than or Equal to Current Date**

- The trigger will execute for all field values less than or equal to the current date.
Web Site Administration

Less Than or Equal to (Current Date Plus Offset Days)  The trigger will execute for all field values less than or equal to a static number of days added to the current date. This evaluation type is useful for processing items that will expire in the future.

Numeric  **Field-Match Type**

Equals  Enter the field value that will execute this trigger.

Range  Enter the field-value range that will execute this trigger.

User Evaluation  This optional evaluation method determines the acting user(s) and/or group(s) that will be queried.

All Users and Groups  All acting users will be queried.

Selected User(s)  Select one or more users from the **Available Users** box that should be queried and add them to the **Selected Users** box using the * icon. If you need to remove one or more users, select the user(s) to remove from the **Selected Users** box followed by the * icon.

Selected Group(s)  Select one or more groups from the **Available Groups** box that should be queried and add them to the **Selected Groups** box using the * icon. If you need to remove one or more groups, select the group(s) to remove from the **Selected Groups** box followed by the * icon.

Selected User(s) and Group(s)  Follow the procedure for both the **Selected User(s)** and **Selected Group(s)** items above.

**Content-Age Requirements**

Age Type  This evaluation method selects how the age of a document will be determined.

**Age of Content**  The creation date of the document will be used.

**Age of Current Version of Content (Major and Minor)**  The date of the most recent version (all revisions) will be used.

**Age of Current Version of Content (Major Only)**  The date of the most recent version (major revision only) will be used.
Content-Delay Requirements

No Content Added Within

This is the content delay upon which the trigger will return true.

Content-Query Requirements

Query Type

This determines the type of query that will be performed.

- All Content
  - All documents will be returned.
- by Full Text
  - Only those documents containing the specified Full-Text Query will be returned. This option is not available for the Coding Queue.
- by Field Value
  - Only those documents matching the specified Field Value will be returned.

Return Type

This determines the type of content that will be returned. This option is not available when the query type is full text.

- All Matching Content (Multiple Records)
  - All documents matching the criteria will be returned.
- Newest Matching Content (Single Record)
  - Only the newest document will be returned.

Full-Text Evaluation

Full-Text Query

This query will be used to search all text content within the documents.

Maximum Records To Return

This determines the maximum number of documents that will be returned from the search.

Packet-Template Requirements

Packet Template

This is the packet template that this trigger will query.

Work-Queue Assignment Requirements

Work-Queue Assignment Evaluation

This optional evaluation method determines which queues will be queried.

- All Users and Groups
  - All user and group queues will be queried.
- Selected User(s)
  - Select one or more users whose queue should be queried from the Available Users box and add them to the Selected Users box using the ➡️ icon. If you need to remove one or more users, select the user(s) to remove from the Selected Users box.
Users box followed by the icon.

Selected Group(s) Select one or more groups whose queue should be queried from the Available Groups box and add them to the Selected Groups box using the icon. If you need to remove one or more groups, select the group(s) to remove from the Selected Groups box followed by the icon.

Selected User(s) and Group(s) Follow the procedure for both the Selected User(s) and Selected Group(s) items above.

Note
The users and/or groups selected represent the actual Work Queue assignments. Selected users will not validate against a group-assigned Work Queue and vice versa.

Work-Queue Departure Requirements

Work-Queue Evaluation This optional evaluation method determines which queues will be queried.

All Users and Groups All user and group queues will be queried.

Selected User(s) Select one or more users whose queue should be queried from the Available Users box and add them to the Selected Users box using the icon. If you need to remove one or more users, select the user(s) to remove from the Selected Users box followed by the icon.

Selected Group(s) Select one or more groups whose queue should be queried from the Available Groups box and add them to the Selected Groups box using the icon. If you need to remove one or more groups, select the group(s)
to remove from the Selected Groups box followed by the icon.

Selected User(s) and Group(s) Follow the procedure for both the Selected User(s) and Selected Group(s) items above.

**Note**

This trigger will execute when users belonging to any selected group remove a document from their own Work Queue. It will also execute for the selected group when all users of the selected group have removed a document.

### Schedule Requirements

**Process Interval**

This determines how often the trigger executes.

**Process Start**

This determines when the first trigger execution will take place. This only appears on process intervals of Every Hour or larger.

- **On First Interval**
  - The trigger will first execute at its selected Process Interval.

- **On Workflow-Service Start**
  - The trigger will first execute when the Workflow Service is started.

**Reprocess Matching Records After**

This determines how often workflow actions will operate on matching records that have been processed at least one time.

**Note**

Schedule Requirements are ignored/unnecessary when the current trigger is used as a secondary trigger in a workflow rule.

### 2.11.5. Workflow Actions

The **Manage Workflow Actions** page handles the creation, modification, and deletion of Workflow Actions. Access it by selecting the icon from the Workflow main menu.

The filter lists located at the top of the page will help you navigate through existing actions. You can also filter by name and description with the filter textbox below the list of actions. Select the **Hide system records** checkbox to hide system-generated actions.
2.11.5.1. Adding or Modifying Workflow Actions

To add an action, select the Add Action button from the Workflow Actions page. To modify an existing action, select the icon in the row of the action you would like to modify.

When you've finished configuring the action, select the Apply button to save it.

2.11.5.2. Duplicating a Workflow Action

This feature saves you time when you need to create multiple actions with only a small difference among them. To duplicate an action, select the icon in the row of the action you would like to copy.

When you are sure you would like to duplicate the action, select the Confirm button.
2.11.5.3. Deleting a Workflow Action

To delete an action, select the icon in the row of the action you would like to delete.

When you are sure you would like to delete the action, select the button.

2.11.6. Workflow-Action Types

Approval Process - Change Priority
This action updates the priority of a document on an approval process.

Approval Process - Change Stage
This action changes the stage of a document on an approval process.

Approval Process - Start Process
This action places a document or packet on the specified approval process.
<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Coding Queue - Delete</td>
<td>This action moves a document from the Coding Queue to the Deleted Content folder.</td>
</tr>
<tr>
<td>Coding Queue - Update Field</td>
<td>This action updates a field value for a document in the Coding Queue.</td>
</tr>
<tr>
<td>Content - Change Document Type</td>
<td>This action changes the document type of a document. When Folder or File Building Rules are enabled for the new document type, the document may be moved to a different folder and may be renamed. The document will always move to a different folder when the source and destination catalogs are different. This action is not available from document-type configuration.</td>
</tr>
<tr>
<td>Content - Check Out</td>
<td>This action checks out a document to the specified user if it is not already checked out to a user.</td>
</tr>
<tr>
<td>Content - Copy to Folder</td>
<td>This action copies a document or all the documents in a packet to the specified folder. When File Building is enabled for the document type, its file name may change.</td>
</tr>
<tr>
<td>Content - Delete</td>
<td>This action moves a document or all the documents in a packet from its catalog to the Deleted Content folder.</td>
</tr>
<tr>
<td>Content - Calculate Field-Value Range</td>
<td>This action updates a memo field on a document with a range of numeric values or dates using the start and end values from two other fields on the document type.</td>
</tr>
<tr>
<td>Content - Combine Global-Field Values</td>
<td>This action combines values from two global fields on a document and places the result in a third global field.</td>
</tr>
<tr>
<td>Content - Merge Field Values</td>
<td>This action matches documents in a single document type by a common global-field value and then updates a secondary global-field value using the value from the source document.</td>
</tr>
<tr>
<td>Content - Move to Folder</td>
<td>This action moves a document or all the documents in a packet to the specified folder. When File Building is enabled for the document type, its file name may change.</td>
</tr>
<tr>
<td>Content - Perform Field Lookup</td>
<td>This action updates a field value for a document by performing a field lookup defined in the document type.</td>
</tr>
<tr>
<td>Content - Update Field</td>
<td>This action updates a field value for a document or all the documents in a packet in a catalog.</td>
</tr>
<tr>
<td>Export Data</td>
<td>This action exports one or more field values for a document using the specified Export-Data Template.</td>
</tr>
<tr>
<td>Generate Report</td>
<td>This action generates reports using the specified Report Template.</td>
</tr>
<tr>
<td>Packet - Merge Field Values</td>
<td>This action updates a field value for each document in a packet using the value from the specified source document type in the packet.</td>
</tr>
<tr>
<td>Run External Application</td>
<td>This action runs an External Application.</td>
</tr>
<tr>
<td>Send E-mail</td>
<td>This action sends an e-mail using a Message Template.</td>
</tr>
</tbody>
</table>
Send Fax: This action sends a fax using a Message Template.
Send Internal Message: This action sends an internal message using a Message Template.
Work Queue - Assign: This action sends a document to the Work Queue of each user and/or group selected.
Work Queue - Remove: This action removes a document from the Work Queue of each user and/or group selected.

2.11.7. Workflow Rules

The Manage Workflow Rules page handles the creation, modification, and deletion of Workflow Rules. Access it by selecting the icon from the Workflow main menu. The filter lists located at the top of the page will help you navigate through existing rules.

2.11.7.1. Adding or Modifying Workflow Rules

To add a rule, select the button from the Workflow Rules page. To modify an existing rule, select the icon in the row of the rule you would like to modify.

2.11.7.2. Workflow-Rule Details

To enable or disable the rule in the Workflow Service, select the Enabled checkbox. Provide a descriptive Rule Name for the rule. You may optionally provide a more detailed Description. Workflow Rules require at least one Workflow Trigger and one Workflow Action.

To use more than one trigger, select the Use Multiple Triggers checkbox. Triggers may be combined in one of two ways:
Combine Methods

OR The actions on the rule will be performed when *any* of the triggers on the rule comply independently.

AND The actions on the rule will be performed when *all* of the triggers on the rule comply.

When using multiple triggers, the **Primary Trigger** determines the available actions.

**Note**

Live-event triggers, such as document captures, field updates, and approval-process stage changes, cannot be **Secondary Trigger(s)**.

One or more actions may be performed as a result of the trigger(s) complying. Multiple actions will be performed in the order they appear in the list. To change the order of the actions, use the ↑ and ↓ icons in the left portion of the action list.

When you've finished configuring the rule, select the ![Apply](image) button to save it.

**Workflow-Rule Details**

2.11.7.3. Duplicating a Workflow Rule

This feature saves you time when you need to create multiple rules with only a small difference among them. To duplicate a rule, select the ![Copy](image) icon in the row of the rule you would like to copy.

When you are sure you would like to duplicate the rule, select the ![Confirm](image) button.
2.11.7.4. Deleting a Workflow Rule

To delete a rule, select the \( \text{\textbf{\textbullet}} \) icon in the row of the rule you would like to delete.

When you are sure you would like to delete the rule, select the \( \text{Confirm} \) button.

2.12. Export-Data Templates [\textit{Enterprise Edition}]

The Export-Data Templates screen allows you to create templates that can be used to export document information using workflow rules. An export-data template must be integrated with the Export Data workflow action for data to be exported. For more information, see Section 2.11.5, “Workflow Actions”.

Access the Export-Data Templates screen by selecting the \( \text{\textbf{\textbullet}} \) icon from the Admin main menu.
2.12.1. Adding or Modifying Templates

Before creating a template, you must specify one or more export files using the Configuration Manager. For more information, see Section 5.6, “Export Data [Enterprise Edition]”.

To add a new export-data template to the system, select the button. To modify an existing template, choose a template from the list of templates and select the button.

Provide a Name and optional Description to identify your template.

Select an available Export Data Path. Content Central will append document information to this file from a configured workflow action.

Choose whether you want the output type to be CSV or TXT. A CSV output type will write the document information in a comma-delimited format with fields separated with commas and line breaks automatically added at the end of each line. A TXT output type writes data in a continuous stream; you will need to use special characters to format the file as needed.

Select a Catalog and Document Type for this template. The template will be available to workflow actions from the selected Document Type.

When you've finished, select the button to save your changes.
2.12.2. Adding or Modifying Data Elements

Each added element is output in sequence each time a workflow action associated with the template is called.

To add an element, select the **Add Element** button.

Provide an **Element Description** to identify this element. Choose a **Content Type** from the following list.

**Content Types**

- **Use a Field**: This allows you to select a field from the same document type as the template you are working on. For any given document, the value for the selected field will be output to the export file.

- **Use Text**: When selected, enter static **Text** that will be output to the file.

- **Use Special Character**: Special characters can help format the data file. You can choose **Newline**, **Tab**, **Space**, or **Custom**. For example, to create a tab-delimited file, add a **Tab** character between each field and a **Newline** character as the last element.

To create a fixed-length file, check the **Fixed Length** checkbox for each field element, provide a value for the length in the accompanying textbox, and select whether you would like to **Left Fill** or **Right Fill** with the specified **Fill Character**. The default **Fill Character** is a space.

When you've finished configuring an element, select the **Apply** button to save your changes.
2.12.3. Changing the Order of Data Elements

Each element can be ordered using the ⬆ and ⬇ icons in the Elements grid. The order the elements are listed determines the order that each element is written to the output file.

2.12.4. Deleting a Data Element

To delete an element, select the ✗ icon in the row of the element you would like to remove.

When you are sure you would like to delete the element, select the Confirm button.

2.12.5. Renaming a Template

To rename an export-data template, choose a template from the list of templates and select the Rename button. Enter a New Name.
Select the button to rename the template.

Renaming an Export-Data Template

2.12.6. Deleting a Template

To delete an export-data template, choose a template from the list of templates and select the button.

When you are sure you would like to delete the template, select the button.

Deleting an Export-Data Template


The Report Templates screen allows you to create templates that can be used to create reports using workflow rules.

Generated reports will be output to a subfolder (named after your report template) inside the Reports root folder specified in the Configuration Manager. For more information, see Section 5.2, “System Folders”.
Each report template must be integrated with the Generate Report workflow action for a report to be generated. For more information, see Section 2.11.5, “Workflow Actions”.

Access the Report Templates screen by selecting the icon from the Admin main menu.

**2.13.1. Adding or Modifying Templates**

To add a new report template to the system, select the button. To modify an existing template, select the icon in the row of the template you would like to modify.

Provide a Report Name and optional Description to identify your template.

Choose from one of the following Report Types:
Report Types

Documents This report type outputs individual document records.
Documents by Approval Process This report type outputs document records that have or have had an association with one or more approval processes.
Total Documents This report type outputs captured document totals.
Total Pages This report type outputs captured page totals.

Note

Total pages are calculated as documents are captured. Image files that are converted to PDF files will be precisely calculated. Page numbers for electronic files that are not PDF files cannot be accurately determined. Each of these documents will be considered to have 1 page.

You can specify one or more Filters on a report template. A filter limits the number of records that your report will contain. The following types of filters can be added to a template:

Filter Types

Catalog A catalog filter limits reports to only the document types and documents contained within the chosen catalogs.
Document Type A document-type filter limits reports to only the documents associated with the selected document types. You must specify at least one catalog filter before choosing a document-type filter.
Index Field An index-field filter limits reports to only those documents whose index-field values match the values in the report template. You can choose only the index fields that are common to all the selected catalog and/or document-type filters previously selected in the template. Depending on the type of field, there are several ways to match field values.

Field-Match Types - Text

Equals Any field value must match the text entered or selected in the textbox.
Contains Any field value must contain the text entered or selected in the textbox.
Starts With Any field value must start with the text entered in the textbox.
Ends With Any field value must end with the text entered in the textbox.

Field-Match Types - Numeric

Equals Any field value must match the number entered in the textbox.
<table>
<thead>
<tr>
<th>Field-Match Types - Date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Is Greater Than or Equal To</strong></td>
<td>Any field value must be greater than or equal to the number entered in the textbox.</td>
</tr>
<tr>
<td><strong>Is Less Than or Equal to</strong></td>
<td>Any field value must be less than or equal to the number entered in the textbox.</td>
</tr>
<tr>
<td><strong>Is Between and Including</strong></td>
<td>Any field value must be between and including the numbers entered in the two textboxes.</td>
</tr>
<tr>
<td><strong>Equals</strong></td>
<td>Any field value must match the date entered in the textbox.</td>
</tr>
<tr>
<td><strong>Is Between and Including</strong></td>
<td>Any field value must be between and including the dates in the two textboxes.</td>
</tr>
<tr>
<td><strong>Is The Previous n Days</strong></td>
<td>Any field value must be within the number of previous days entered in the textbox.</td>
</tr>
<tr>
<td><strong>Is The Previous n Weeks</strong></td>
<td>Any field value must be within the number of previous weeks entered in the textbox.</td>
</tr>
<tr>
<td><strong>Is The Previous n Months</strong></td>
<td>Any field value must be within the number of previous months entered in the textbox.</td>
</tr>
<tr>
<td><strong>Is Today</strong></td>
<td>Any field value must match today's date.</td>
</tr>
<tr>
<td><strong>Is Yesterday</strong></td>
<td>Any field value must match yesterday's date.</td>
</tr>
<tr>
<td><strong>Is This Week</strong></td>
<td>Any field value must match the current week (Sunday to Saturday).</td>
</tr>
<tr>
<td><strong>Is Last Week</strong></td>
<td>Any field value must match the previous week (Sunday to Saturday).</td>
</tr>
</tbody>
</table>
Is This Month          Any field value must match the current calendar month.

Is Last Month         Any field value must match the previous calendar month.

Is This Quarter       Any field value must match the current calendar quarter.

Is Last Quarter       Any field value must match the previous calendar quarter.

Is This Year          Any field value must match the current calendar year.

Is Last Year          Any field value must match the previous calendar year.

System Field          A system-field filter limits the report to documents that matches a system field having the value specified.

Date Created          This system field reflects the date that any given document was added to the database. Field-match types are the same as those for date fields.

Approval Process      An approval-process filter limits the report to documents that have had any association with the selected approval process. This filter type is available only when the Report Type is Documents by Approval Process.

Approval-Process Timeframe Approval-process timeframe filters limits the report to documents of a specific timeframe as it relates to an associated approval process. This filter type is available only when the Report Type is Documents by Approval Process.

Documents Active on Process The only document records output will be those that are currently on an approval process.

Specific Timeframe of Most Recent Event Records will be output based on timeframe of the most recent event on an associated approval process. Field match types are the same as those for date fields.

To add a filter, select the button. To remove a filter, select the icon in the row of the filter you want to remove.

Segments allow you to create divisions in the report by grouping records together. You can specify one or more segments on a report template, and the combined segment selections determine how the data will
be grouped and displayed. Selecting the Create Segment Headers checkbox will clearly identify each segment in the report by providing an empty row followed by one row with the combined values for each selected segment and one header row containing the names of each output column. The following types of segments can be selected:

**Segment Types**

- **Catalog**
  The catalog segment causes the report generator to group and sort records by catalog.

- **Document Type**
  The document-type segment causes the report generator to group and sort records by document type.

- **Index Field**
  An index-field segment causes the report generator to group and sort records by the selected index field. You can choose only the index fields that are common to all the selected catalog and/or document-type filters previously selected in the template.

- **Approval Process**
  The approval-process segment causes the report generator to group and sort records by approval process. This segment type is available only when the Report Type is Documents by Approval Process.

To add a segment, select the **Add Segment** button. To remove a segment, select the **X** icon in the row of the segment you want to remove.

The Report Output section allows you to specify a Filename for your report and choose a Write mode. There are three write modes:

**Write Modes**

- **Append**
  The report generator will append to the file specified each time a report is output by the workflow engine.

- **Replace**
  The report generator will replace the file specified each time a report is output by the workflow engine.

- **Keep All**
  The report generator will append a timestamp suffix to the end of the specified filename. A new file will be created each time the workflow engine outputs a report.

Output Columns determine the actual information output on a report. You can provide custom Header Text for each output column. Leaving any Header Text textbox blank will cause the report generator to use the default name for the column based on the source of the information. Selectable Output Columns can be added only on report types that provide individual document records.

**Output-Column Types**

- **Report Type (Required)**
  These output columns cannot be removed but can be ordered. These columns are added automatically to your report based on the selected Report Type.

**Required Columns by Report Type**

- **Documents**
  **Document Name:** The document filename as it would appear in a results grid.
Documents by Approval Process

**Approval-Process Name:** The name of the approval process associated with a given document.

**Approval-Process Status:** The approval-process status, as it would appear in Document Properties, of a given document.

**Total Documents**

**Total Documents Captured:** The total number of documents for a given segment of a report.

**Total Pages**

**Total Pages Captured:** The total number of pages for a given segment of a report.

**Segment**

These output columns are added automatically to your report based on the selected Segments. They cannot be removed or ordered. These columns must always be the first columns output on the report.

**Report Type**

These output columns are specific to the selected Report Type.

### Report-Type Columns for Approval-Process Report Type

**Process-Start DateTime**

This column represents the date and time a document first arrived on a given approval process.

**First Approval to Stage (DateTime)**

This column represents the date and time a document was first approved to the specified Stage.

**First Rejection to Stage (DateTime)**

This column represents the date and time a document was first rejected to the specified Stage.

**Latest Approval to Stage (DateTime)**

This column represents the date and time a document was most recently approved to the specified Stage.

**Latest Rejection to Stage (DateTime)**

This column represents the date and time a document was most recently rejected to the specified Stage.
### Web Site Administration

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Latest Approval to Stage (DateTime)</td>
<td>This column represents the date and time a document was most recently approved to the specified Stage. It is only output when a given document has been approved to the specified Stage more than once.</td>
</tr>
<tr>
<td>Latest Rejection to Stage (DateTime)</td>
<td>This column represents the date and time a document was most recently rejected to the specified Stage. It is only output when a given document has been rejected to the specified Stage more than once.</td>
</tr>
<tr>
<td>Process-End DateTime</td>
<td>This column represents the date and time a document was rejected from, completely approved on, or forcefully removed from a given approval process.</td>
</tr>
<tr>
<td>Index Field</td>
<td>These output columns will contain the field value for the specified index field on a given document. You can select any field available from any selected catalog or document-type filter.</td>
</tr>
<tr>
<td>System Field</td>
<td>These output columns represent system information that can be found only in the database.</td>
</tr>
</tbody>
</table>

### System-Field Output Columns

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Catalog</td>
<td>This column represents the catalog name for a given document.</td>
</tr>
<tr>
<td>Catalog ID</td>
<td>This column represents the catalog database identifier for a given document.</td>
</tr>
<tr>
<td>Document Type</td>
<td>This column represents the document-type name for a given document.</td>
</tr>
<tr>
<td>Document-Type ID</td>
<td>This column represents the document-type database identifier for a given document.</td>
</tr>
<tr>
<td>Document ID</td>
<td>This column represents the database identifier for a given document. Adamant.</td>
</tr>
</tbody>
</table>
Document Creator This column represents the user who added a given document to the system.

Document Folder This column represents the folder location on the server for a given document.

Document Filename This column represents the current-version filename on the server for a given document.

Document Path This column represents the complete file path on the server for a given document.

Document Creation Date This column represents the creation date for a given document.

Document Modified Date This column represents the modification date for a given document.

Document Version This column represents the current major and minor versions for a given document.

To add a column, select the Add Column button. To remove a column, select the icon in the row of the column you want to remove. Most columns can be ordered using the and icons in the Output Columns grid.

When you've finished configuring your report template, select the Apply button to save your changes.

### 2.13.2. Downloading a Report

All reports can be found on the server inside the Reports root folder; however, the most recently generated report can be downloaded from the Report Templates screen by selecting the icon in the row of the template that matches the report you would like to download.

### 2.13.3. Deleting a Template

To delete a report template, select the icon in the row of the template you would like to delete.

When you are sure you would like to delete the template, select the Confirm button.
2.14. Custom Menu Items [Corporate Edition and higher]

Custom menu items can be defined to provide additional functionality to the user interface, such as launching an external Web page using field data from a document. Enabled custom menu items are available to all users in the system.

Access the Custom Menu Items screen by selecting the icon from the Admin main menu.

2.14.1. Adding or Modifying Custom Menu Items

To add a menu item, select the button from the Custom Menu Items screen. To modify an existing menu item, select the icon in the row of the item you would like to modify.
Selecting the Enabled checkbox will make the menu item available in the user interface. The required Title textbox represents the menu-item title that will be displayed to users. The Parent Menu selection determines the menu that will contain this item.

**Menu-Item Types**

**Launch Web Page**

The specified URL will be built dynamically as the user selects the menu item. A new browser window will be launched using the URL.

The URL is built using a combination of Static Values and Values from Fields (global fields). To add additional items to the URL builder, select the button. To remove a URL item select the icon next to the item you would like to remove.

**Run External Application**

The selected External Application will be executed on the server when a user selects this menu item. For more information, see Section 5.5, “External Applications [Enterprise Edition]”.

When you’ve finished, select the button to save your changes.

---

**2.15. Themes [Enterprise Edition]**

The Themes screen allows you to create, modify, save, upload, and delete themes used to modify the visual appearance of the user interface.

Access the Themes screen by selecting the icon from the Admin main menu. To create a new theme, select the Add Theme button from the Themes screen. To modify an existing theme, select the icon in the row of the theme you would like to modify. To save a theme, select the icon in the row of the theme you would like to save. To upload a theme, select the Upload New button, Browse to the location of the saved theme, and select the button.
2.15.1. Adding or Modifying Themes

Selecting the Active Theme checkbox will cause this theme to be the active theme for Content Central.

First, provide a descriptive Theme Name to help identify this theme from others. Next, Choose a component from the drop-down list to configure that component. When you've finished configuring each component, select the button to save your changes.

2.15.1.1. Login Page Body

This component configures the full body of the login page.

Background Color  
If enabled, this color will be used to paint the background of the login page. Either select a preset color, or enter a color manually in hexadecimal format #RRGGBB.
Background Image  If enabled, the uploaded image will be placed under the login page island. The image can be optionally tiled horizontally, vertically, or in both directions.

### 2.15.1.2. Login Page Island

This component configures the login page island containing the username and password prompts.

- **Background Color**
  - If enabled, this color will be used to paint the background of the island. Either select a preset color, or enter a color manually in hexadecimal format #RRGGBB.

- **Background Image**
  - If enabled, the uploaded image will be placed under the username and password prompts. The image can be optionally tiled horizontally, vertically, or in both directions.

- **Location, Size, & Positioning (in pixels)**
  - **Alignment**
    - Defines the alignment of the login page island to the login page body.
  - **Width**
    - Defines the width of the island. When using a background image, this should match the image width.
  - **Height**
    - Defines the height of the island. When using a background image, this should match the image height.
  - **Top Margin**
    - Defines the margin (gap) between the top of the page and the top of the island.
  - **Position of Inputs: Left**
    - Defines the left position of the username and password inputs in relation to the left edge of the island.
  - **Position of Inputs: Top**
    - Defines the top position of the username and password inputs in relation to the top edge of the island.

### 2.15.1.3. Main Menu

This component configures the main menu frame.

- **Background Color**
  - If enabled, this color will be used to paint the background of the main menu. Either select a preset color, or enter a color manually in hexadecimal format #RRGGBB.

- **Logo Image (50 pixels high max)**
  - If enabled, the uploaded image will be placed in the main menu frame starting at position 0,0 (top-left corner).
Background Image (50 pixels high max)  If enabled, the uploaded image will be placed under the main menu logo image and buttons. The image can be optionally tiled horizontally, vertically, or in both directions.

2.15.1.4. Side Bar

This component configures the left frame (search, capture, folders), the right frame (document properties), and the popup windows (check-out, e-mail, etc.).

Background Color  If enabled, this color will be used to paint the background of the component. Either select a preset color, or enter a color manually in hexadecimal format #RRGGBB.

Logo Image (50 pixels high max)  If enabled, the uploaded image will be placed at the bottom of only the left frame.

Background Image (50 pixels high max)  If enabled, the uploaded image will be placed under the component’s content. The image can be optionally tiled horizontally, vertically, or in both directions.

2.15.1.5. Results

This component configures all results grids.

Even Row Color  This color will be used to paint the background of the even rows. Either select a preset color, or enter a color manually in hexadecimal format #RRGGBB.

Odd Row Color  This color will be used to paint the background of the odd rows. Either select a preset color, or enter a color manually in hexadecimal format #RRGGBB.

Selected Row Color  This color will be used to paint the background of the selected row. Either select a preset color, or enter a color manually in hexadecimal format #RRGGBB.

2.15.1.6. General

This component configures colors of global objects.

Font Color  This color will be used for all text labels. Either select a preset color, or enter a color manually in hexadecimal format #RRGGBB.

Font Highlight Color  This color will be used for all highlighted text. It will also be used for the border lines within popup windows. Either select a preset color, or enter a color manually in hexadecimal format #RRGGBB.

Menu Font Color  This color will be used for the text of menus and headers. Either select a preset color, or enter a color manually in hexadecimal format #RRGGBB.

Menu Background Color  This color will be used to paint the background of menus and headers. Either select a preset color, or enter a color manually in hexadecimal format #RRGGBB.

2.15.1.7. Membership

This component defines the users that will see this theme. Only users without a specified theme will be available to select. If the theme is the system default, all users without a specified theme will also see this theme.
To add users to the theme, select the button and select the appropriate users followed by the button to add the user(s) to the theme.

To remove a user from the theme, select the icon in the user's row.

2.15.2. Deleting a Theme

To delete a theme, select the icon in the row of the theme you would like to delete.

When you are sure you would like to delete the theme, select the button.

2.16. Event Viewer

The event viewer allows you to track actions that each user has performed while logged in to Content Central. The event log also maintains records of documents that have been captured. Access it by selecting the icon from the Admin main menu.

The following actions are logged:

- Append
- Capture
- Check In
- Check Out
- Delete
- E-mail
- Fax
- Login
- Logout
- PreCapture
- Properties Update
- Replace
- Rename
You may filter your view by selecting any combination of options from the drop-down list above the log table. Select the button to update the log table after you’ve chosen your filters. Use the paging bar below the log table to view additional pages of log entries.

**Note**

Only users with an entered first name will be displayed in the "User by First Name" drop-down list. Only users with an entered last name will be displayed in the "User by Last Name" drop-down list.

---

### The Event Viewer

#### 3. Finishing Up

This completes both the administration portion of the documentation and the installation of Content Central. At this point you should have a production-ready implementation of Content Central for your users to begin capturing and managing documents.

There are only a few remaining items that you, as an administrator, should be aware of.

**Check-In Requests**

As an administrator of Content Central, you may occasionally receive requests in your **Messages** screen (which can also be sent to your e-mail address) from your users to check in documents that others users have checked out. Once you locate the item(s) in question, you have a unique button in the **Check Out/In Document(s)** screen to check in the item(s). These requests will be sent to any user that belongs to the **Administrators** group.

**Unprocessed Document Notifications**

When the Capture Service has trouble processing one or more image files, it will send notifications in your **Messages** screen (which can also be sent to your e-mail address) containing the full path to the problem file. These notifications will be sent to any user
that belongs to the *Administrators* group and has the user option set to notify when documents cannot be processed. The following types of messages can be sent:

<table>
<thead>
<tr>
<th>Message Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Invalid File Type</td>
<td>The file was not a valid image file type, or the image file could not be read.</td>
</tr>
<tr>
<td>Missing QCard</td>
<td>The file was placed in the <code>IncomingScansQCard</code> folder, but the file did not begin with a QCard™.</td>
</tr>
<tr>
<td>Invalid EOD QCard</td>
<td>An End-of-Document QCard™ cannot begin a file or new document.</td>
</tr>
<tr>
<td>Checked Out</td>
<td>The file to be appended or replaced is currently checked out by another user.</td>
</tr>
<tr>
<td>Not a PDF</td>
<td>The document to append is not a PDF.</td>
</tr>
</tbody>
</table>
Part III. User Guide
Chapter 5. Introduction

In this chapter you will become familiar with the user interface of Content Central and gain an understanding of the basic procedures and abilities you will have. It's a good idea to read through the entire User Guide; however, if you will only be designated to a single operation, such as Document Capture, then you may wish to read only the section that pertains to you.

1. User Interface

To access Content Central you will need to launch your preferred Web browser and enter the URL (address) provided by your administrator. Once you've successfully accessed Content Central, you will need to provide your Username and Password (you should have received from your administrator) to login to the system.

If you would like to prevent having to log in each time, select the Keep me logged in check box.

Note

This option may not be available in all configurations. Selecting the Logout button on the main menu will require you to log in again.

Logging In to Content Central

2. The Main Menu

The main menu is always located at the top of Content Central. From the main menu you can access the Search, Folders, and Capture areas. You can also Search All Catalogs, access your Options, Logout of Content Central, and get Help. Administrators can access the administration menu with the Admin button.

3. The Dashboard

The Dashboard displays your most recent Messages, Approval Queue documents, Work Queue documents, and Coding Queue documents. Clicking on any of these panels will take you to that specific
area in Content Central. Access the **Dashboard** at any time by selecting the logo located in the far-left area of the main menu.

![Dashboard Screenshot]

**The Dashboard**

### 4. The Results Grid

The results grid displays information about documents and other content in the right frame (the **Results Frame**) below the main menu.

Each row in the grid contains a checkbox at the beginning of the row. These checkboxes may be selected to perform document actions on multiple documents at once. Use the **Check** menu to check **All**, check **None**, or **Invert** the value of each checkbox.

Next to each checkbox is a status icon. This icon displays the **Approval-Queue**, **Work-Queue**, or **Check-Out** status of each document in most results grids as defined below:

- ![Document in approval queue](image)
  - Document is in your approval queue.
- ![Document in work queue](image)
  - Document is in your work queue.
- ![Document is available for check out](image)
  - Document is available for check out.
- ![Document is currently checked out by another user](image)
  - Document is currently checked out by another user.
- ![Document is currently checked out by you](image)
  - Document is currently checked out by you.
- ![Your permissions do not allow you to check out this document](image)
  - Your permissions do not allow you to check out this document.

For icons displayed in the **Messages** folder, see Chapter 9, *The Messages Folder*. For icons displayed in the **Approval Queue**, see Section 17, “The Approval Queue [Enterprise Edition]”. For icons displayed in the **Coding Queue**, see Section 8, “The Coding Queue”.

Other features of the grid may be useful to you:

**Column Sorting** To sort the grid either ascending or descending based on the data in any particular column, click the header for that column (the cell containing the field name). Click it again to alternate the sort direction (ascending vs. descending). The column sorted, as well as the direction sorted, is indicated...
on the grid header with the ▲ and ▼ icons. To remove sorting, select the Remove Sorting link next to the menu bar.

Field Grouping You may group the results by one of the columns for a different view of your results. Click and hold the column header you would like to group by, and drag it into the area above the header with the message, "Drag a column header here to group by that column". To revert to the original results view, click and hold the column header again and drag it back into the results grid.

Column Arrangement You can rearrange the order of the columns in the grid by clicking and holding a column header then moving it to the left or right until two red arrows appear. The new order will be saved for future results.

Column Resizing You can resize columns in most grids by clicking and holding a column-header divider (the area between two column headers) followed by moving it to the left or right.

Refresh Select the icon to refresh the grid at any time.

Export to Excel The information contained within the grid can be exported to Microsoft® Excel® by selecting the icon in the upper-right portion of the results-grid frame.

5. User Options

The Options screen lets you update many settings specific to your user account. Access it by selecting the button on the main menu.

5.1. User Profile

You may update your profile information by selecting the icon in the Options screen. You can change your name, e-mail address, and password depending on your security level.
5.2. Preferences

There are several system preferences you can configure by selecting the icon in the Options screen. The following list explains each of the preferences.

Language Select the language that you prefer to use while navigating the application. Default uses the language setting configured in your Web browser.

Default Capture Catalog This selection determines the default Catalog selection when accessing the Capture area.

Automatically open the first document in any results grid. When selected, the first document in a results grid will be opened.

Require a double-click to open a document. By default, a single click on any results-grid row will open the document. This preference will require a double click to open a document.

Refresh grid when changing document properties. Enabling this feature will cause any list of results to immediately update after document properties have been committed.

Disable PDF Streaming This option appears when administrators have enabled PDF streaming. Select this checkbox if you wish to disable PDF streaming for your personal account.

Send a copy of each Content Central message to the e-mail address defined in my User Profile. When selected, a copy of each Content Central message will be sent to your e-mail address.

Notify me when a new document arrives in my Approval Queue. [Enterprise Edition] When selected, a message will be sent to you every time a document lands in your Approval Queue.
Notify me when a new document arrives in my Work Queue. [Enterprise Edition] When selected, a message will be sent to you every time a document lands in your Work Queue.

Notify me when a document arrives in my Coding Queue due to Zonal OCR processing. [Enterprise Edition] When selected, a message will be sent to you when a document lands in your Coding Queue because of a potential problem with Zonal OCR processing.

Notify me when a document cannot be processed by the Capture Service. [Administrators] When selected, a message will be sent to you when a document cannot be captured.

Automatically print QCards™. When selected, Content Central will launch the print dialog in your PDF viewer when you select the Create button to produce a QCard™.

Use default printer without prompting. If the previous and current selections are enabled, the print dialog will be bypassed, and your default printer will receive the print job containing the QCards™. Your PDF viewer may require a confirmation for security reasons.

User Preferences

5.3. Downloads and Installers

Select the icon in the Options screen to download and/or install helper applications.

Install Content Central Search Provider

Select this link to install Content Central as one of the search providers in your Web browser. With this feature installed, you will be able to use your Web browser's Search function to search for information within Content Central. Your query will be used to search all catalogs where you have the search permission.

Download Content Central Content Director

Select this link to install the Content Director application on your local desktop computer. This application allows you to edit
Introduction

documents directly from the Content Central browser interface. Saving a document upon exiting its native application will automatically upload it to the Content Central server. For more information see Section 9, “Editing Documents”.

5.4. Address Book

Select the icon in the Options screen to access your personal Address Book.

Contacts in your address book can be used when sending documents via e-mail or fax or sharing documents. Records are stored unique by Contact Name.
5.4.1. Adding or Modifying a Contact

To modify an existing contact, double click the row you would like to modify, make changes, and click off the row to save the changes.

To add a new contact, double click the last row displayed on the current page. You must provide a valid Contact Name for each record. All additional columns are optional. When you have finished adding a record, click off the row or select the button to return to the Options screen.

You can upload a comma-delimited text file containing a list of contacts by selecting the button, browsing to the file, and selecting the button to process the file. Do not include a header record. Duplicate contacts will be discarded. The required format for the file is as follows:

Contact Name (required),Company Name (optional),E-mail Address (optional),Fax Number (optional)

5.4.2. Deleting One or More Contacts

To remove one or more contacts from your address book, select the checkbox in the row or rows you would like to delete from the current page, and select the button.

5.5. Saved Searches

Manage your saved searches by selecting the icon in the Options screen.

To automatically perform a search when a saved search has been selected from the Search area, select Auto-execute searches upon selection. Select the button to apply your changes and return to the Options screen.

5.5.1. Modifying a Saved Search

To modify a search query, select the icon in the appropriate row. Here you can edit the Title, determine whether the query will be Enabled and available for searching, and select whether the query will be
available for other users by making it Public. Select the Apply button when you have finished modifying the query.

5.5.2. Deleting a Saved Search

To delete a search query, select the icon in the appropriate row, followed by selecting the Confirm button to permanently delete the saved search.

5.6. Default Document Types

Choose your Default Document Types for each catalog by selecting the icon in the Options screen. A default document type is used for the following:

- Determines the document type of one or more uploaded files when using the results-grid drag-and-drop tool in the Catalog Browser.
- Determines the document type used when pasting one or more documents in the Catalog Browser.
- Appears first in document-type drop-down lists in the Capture frame and in the Drag & Drop Upload applet.

When you have finished selecting a default document type for a catalog, select the Apply button to save the changes. Select the Back button to return to the Options screen.

5.7. Search Fields

You may pick the fields you wish to use during a search by selecting the icon in the Options screen. Select the catalog and document type that you would like to manage.

Use the icon to add fields from the Available Fields box to the Search Fields box.
Use the ▲ and ▼ icons to change the order that the fields will appear on the screen.

The administrator may have defined a default set of fields that you can remove, if desired, using the ❯ icon.

Tip

Select Add Capture/Edit Fields below the Search Fields box to save time and add the fields designated as capture fields.

When you have finished selecting fields for a document type, select the ➤ button to save the changes. Select the ➤ button to return to the Options screen.

5.8. PIN

Define your personal identification number by selecting the padlock icon in the Options screen.

Your PIN will be needed when approving or rejecting documents. For more information, see Section 17.1, “Approving”.

When you have finished adding or modifying your PIN, select the ➤ button to save the changes. Select the ➤ button to return to the Options screen.

5.9. DocType Results Fields

You may pick the document-type fields you wish to see in the results grid by selecting the icon in the Options screen.

Select the catalog and document type that you would like to manage.

Use the ➡ icon to add fields from the Available Fields box to the Results Fields box.
Use the ↑ and ↓ icons to change the order that the fields will appear in the grid.

The administrator may have defined a default set of fields that you can remove, if desired, using the icon.

### Tip

Select Add Search Fields below the Results Fields box to save time and add the fields from the Search Fields option.

When you have finished selecting fields for a document type, select the button to save the changes. Select the button to return to the Options screen.

#### User Results Fields

### 5.10. Grid Results Fields

You may pick the grid-specific fields and system fields you wish to see in each results grid by selecting the second icon in the Options screen.

Each grid type can have its own unique set of fields displayed as columns. Select the type of grid you would like to configure by selecting it from the drop-down list under the Grid-Specific Fields label.

Use the icon to add fields from the Grid-Specific Fields and System Fields boxes to the Results Fields box.

Use the ↑ and ↓ icons to change the order that the fields will appear in the grid.

When you have finished selecting fields for a grid type, select the button to save the changes. Select the button to return to the Options screen.
5.11. Event Viewer

The event viewer allows you to track actions that you have performed while logged in to Content Central.

The event log also maintains records of documents that you have captured. Access it by selecting the icon from the Options screen.

You may filter your view by selecting any combination of options from the drop-down list above the log table. Select the button to update the log table after you've chosen your filters. Use the paging bar below the log table to view additional pages of log entries.

Select the button to return to the Options screen.
6. Getting Help

If you get stuck or need to reference this documentation at any time, select the button at the top of the current dialog.
Chapter 6. Capturing Documents

This chapter will teach you how to capture both paper documents (from a scanning device) and electronic documents. If you haven't read the introductory sections, Capture Types and Coding Methods, you should do that now.

Access the Capture frame by selecting the Capture button from the main menu.

1. Capturing Paper Documents - DirectScan™

The DirectScan applet allows you to capture paper documents from a scanning device connected to your computer. The following describes each of the coding methods available when capturing with DirectScan.

1.1. Pre-Capture Coding

Use this method of capture when you wish to capture a paper document and provide the document properties for that document before scanning.

1. Select the DirectScan Capture Type.
2. Select the Pre-capture coding Coding Method.
3. Select a catalog and document type to add the document to.
4. Enter information about the document into the appropriate field text boxes. If any key icons are displayed next to a field, you may select the Perform key-field lookup link to perform a real-time field lookup. One or more of the fields will be updated.
5. Optional: You can scan several documents with the same number of pages by selecting the Fixed Page Count checkbox and providing a number of pgs per document.
6. Select the button to launch the DirectScan applet.
7. Scan the document as described in Section 1.5, “Using The DirectScan™ Applet.”
Pre-Capture Coding with DirectScan

1.2. Post-Capture Coding

Use this method of capture when you wish to capture a paper document and provide the document properties for that document after scanning. Several documents may be scanned together when using the Fixed Page Count option as long as each document in the batch consists of the number of pages specified.

1. Select the DirectScan Capture Type.
2. Select the Post-capture coding Coding Method.
3. Select a catalog and document type to add the document to.
4. Optional: You can scan several documents with the same number of pages by selecting the Fixed Page Count checkbox and providing a number of pgs per document.
5. Select the button to launch the DirectScan applet.
6. Scan the document as described in Section 1.5, “Using The DirectScan™ Applet”.

Post-Capture Coding with DirectScan

1.3. Versatile Coding

Use this method of capture when you wish to capture a paper document and provide the document properties for that document before scanning, after scanning, or at both times. Several documents may be scanned together when using the Fixed Page Count option as long as each document in the batch consists of the number of pages specified.

1. Select the DirectScan Capture Type.
2. Select the Versatile coding Coding Method.
3. Select a catalog and document type to add the document to.
4. Choose whether you want this document to be sent to your Personal Queue or the Shared Queue.
Capturing Documents

Note

The Personal Queue is visible to you only. The Shared Queue is visible to you and others with permission to add documents for the selected document type.

5. Enter information about the document into the appropriate field text boxes. If any key icons are displayed next to a field, you may select the Perform key-field lookup link to perform a real-time field lookup. One or more of the fields will be updated.

6. Optional: You can scan several documents with the same number of pages by selecting the Fixed Page Count checkbox and providing a number of pgs per document.

7. Select the button to launch the DirectScan applet.

8. Scan the document as described in Section 1.5, “Using The DirectScan™ Applet”.

Versatile Coding with DirectScan

1.4. OCR Only

Use this method of capture when you wish to capture only the (typed) full-text of a document. Several documents may be scanned together when using the Fixed Page Count option as long as each document in the batch consists of the number of pages specified.

1. Select the DirectScan Capture Type.

2. Select the OCR only Coding Method.

3. Select a catalog and document type to add the documents to.

4. Optional: You can scan several documents with the same number of pages by selecting the Fixed Page Count checkbox and providing a number of pgs per document.

5. Select the button to launch the DirectScan applet.
6. Scan the document as described in **Section 1.5, “Using The DirectScan™ Applet”**.

1.5. Using The DirectScan™ Applet

This Java® applet allows you to capture paper documents with a TWAIN-compliant scanner connected to your computer. Once you've selected the **Continue** button from within the **Capture** frame, the DirectScan™ applet will launch in the right frame of Content Central. You may be asked to allow the applet to launch from within your browser. This is normal behavior. Once the applet has launched, perform the following steps:

1. Select the appropriate scanning device from the **Scanner** list.

2. Place the documents in your scanner's document feeder.

3. **Optional** If you would like to bypass your scanner's software dialog, select the **Hide Scan Dialog** checkbox and then select the **Scan** button to choose the scan settings.

4. Select the **Scan** button.

5. Choose the appropriate settings and options (if any) for your scanner and initiate the scanning process. When the scanner has completed, the images will appear in the DirectScan™ applet.

6. Review the scanned images (see **Section 1.5.1, “Image Reviewing Tools”**). Use the horizontal scroll bar at the bottom of the image-preview frame to view images outside of the viewing area. Images will be grouped in sets of 25. To move from one group of images to another, select the **Prev Set** or **Next Set** buttons. If you wish to rescan the images, select the **Scan** button and repeat steps 2 through 4.

7. Once you are satisfied with the scanned images, select the **Finish** button. The images will be uploaded to the Content Central server. The bar to the left of the button will indicate progress of the upload process.
1.5.1. Image Reviewing Tools

The following tools, located above the image-preview frame, can be used to assist with the quality assurance process.

- **Zoom In**
  Increases the visible dimensions of all images in the current image set.

- **Zoom Out**
  Decreases the visible dimensions of all images in the current image set.

- **Rotate**
  Rotates the selected image(s) 90 degrees clockwise.

- **Move**
  Moves the selected image before the previous image.

- **Move**
  Moves the selected image after the next image.

- **Delete**
  Deletes the selected image(s) from the current image set.

2. Capturing Paper Documents - QCards™

The following describes each of the coding methods available when capturing paper documents with QCards™.

2.1. Pre-Capture Coding

Use this method of capture when you wish to capture a paper document and provide the document properties for that document before scanning.

1. Select the QCard Capture Type.
2. Select the **Pre-capture coding Coding Method**.

3. Select a catalog and document type to add the document to.

4. Enter information about the document into the appropriate field text boxes. If any key icons are displayed next to a field, you may select the **Perform key-field lookup** link to perform a real-time field lookup. One or more of the fields will be updated.

5. Optional: You can make this a Fixed Page Count QCard™ by selecting the checkbox and providing a number of **pgs per document**.

6. Optional: You can allow field values for the documents to be obtained from an *External Data Source* when captured by selecting the **Perform key-field lookup at capture time** checkbox. The key field must be available on the QCard™.

7. Optional: You can include an End-of-Document QCard™ by selecting the checkbox.

8. Select the **Create** button to generate the QCard™.

9. Print the QCard™.

10. Place the QCard™ on top of the document to be scanned. Place the optional End-of-Document QCard™ at the end of the document.

11. Scan the documents using your scanning device.

---

*A Pre-Capture Coding QCard™*
2.2. Post-Capture Coding

Use this method of capture when you wish to capture a paper document and provide the document properties for that document after scanning. This QCard™ may be used as a Fixed Page Count QCard™ allowing you to scan multiple documents in with only one QCard™ as long as each document consists of the number of pages specified.

1. Select the QCard Capture Type.

2. Select the Post-capture coding Coding Method.

3. Optional: You can make this a Fixed Page Count QCard™ by selecting the checkbox and providing a number of pgs per document.

4. Optional: You can allow field values for the documents to be obtained from an External Data Source when captured by selecting the Perform key-field lookup at capture time checkbox. The key field must be available on the QCard™.

5. Optional: You can include an End-of-Document QCard™ by selecting the checkbox.

6. Select the Create button to generate the QCard™.

7. Print the QCard™.

8. Place the QCard™ on top of the [first] document to be scanned. Place the optional End-of-Document QCard™ at the end of the last document.

9. Scan the documents using your scanning device.
2.3. Versatile Coding

Use this method of capture when you wish to capture a paper document and provide the document properties for that document before scanning, after scanning, or at both times. This QCard™ may be used as a Fixed Page Count QCard™ allowing you to scan multiple documents in with only one QCard™ as long as each document consists of the number of pages specified.

1. Select the QCard Capture Type.
2. Select the Versatile coding Coding Method.
3. Select a catalog and document type to add the documents to.
4. Choose whether you want this document to be sent to your Personal Queue or the Shared Queue.

   Note
   
   The Personal Queue is visible to you only. The Shared Queue is visible to you and others with permission to add documents for the selected document type.

5. Enter information about the document into the appropriate field text boxes. If any key icons are displayed next to a field, you may select the Perform key-field lookup link to perform a real-time field lookup. One or more of the fields will be updated.

6. Optional: You can make this a Fixed Page Count QCard™ by selecting the checkbox and providing a number of pgs per document.

7. Optional: You can allow field values for the documents to be obtained from an External Data Source when captured by selecting the Perform key-field lookup at capture time checkbox. The key field must be available on the QCard™.

8. Optional: You can include an End-of-Document QCard™ by selecting the checkbox.

9. Select the button to generate the QCard™.
10. Print the QCard™.

11. Place the QCard™ on top of the [first] document to be scanned. Place the optional End-of-Document QCard™ at the end of the last document.

12. Scan the documents using your scanning device.

2.4. OCR Only

Use this method of capture when you wish to capture only the (typed) full-text of a document. This QCard™ may be used as a Fixed Page Count QCard™ allowing you to scan multiple documents in with only one QCard™ as long as each document consists of the number of pages specified.

1. Select the QCard Capture Type.

2. Select the OCR only Coding Method.

3. Select a catalog and document type to add the documents to.

4. Optional: You can make this a Fixed Page Count QCard™ by selecting the checkbox and providing a number of pgs per document.

5. Optional: You can allow field values for the documents to be obtained from an External Data Source when captured by selecting the Perform key-field lookup at capture time checkbox. The key field must be available on the QCard™.

6. Optional: You can include an End-of-Document QCard™ by selecting the checkbox.

7. Select the button to generate the QCard™.

8. Print the QCard™.

9. Place the QCard™ on top of the [first] document to be scanned. Place the optional End-of-Document QCard™ at the end of the last document.

10. Scan the documents using your scanning device.
3. Capturing Paper Documents - Document-Type QCard™

Document-Type QCards™ can be printed and used to change the document type within a batch of paper documents sharing the same document properties.

Note

A Document-Type QCard™ can be used more than once and is compatible with any coding method.

Example 6.1. Document-Type QCard™ Example

A user creates a Pre-capture coding QCard™ for the primary (first) document type in the batch to be scanned. This QCard™ specifies document properties for all documents in the batch to be scanned.

A Document-Type QCard™ is printed for every additional document type in the batch. These QCards™ are placed in front of the document they represent.

The user scans the batch of documents. The Capture Service splits the batch into individual PDF documents based on the document type represented by each QCard™, and all documents receive the document properties represented by the Pre-capture coding QCard™.

3.1. Creating a Document-Type QCard™

1. Select the Document-Type QCard Capture Type.
2. Select a catalog and document type.
3. Select the Create button to generate the QCard™.
4. Print the QCard™.
5. Place the QCard™ on top of its document to be scanned.
6. Assemble the batch of documents, making sure the first QCard™ for the batch is a regular QCard™, and scan the documents using your scanning device.

4. Capturing Paper Documents - QCard™ Packet

QCard™ Packets are based on packet templates defined by your administrator. This capture type allows you to produce multiple QCards™ in one step.

4.1. Creating a QCard™ Packet

Use this method of capture when you wish to capture a packet of paper documents.

1. Select the QCard Packet Capture Type.
2. Select the Packet template.
3. Enter information about the documents into the field text boxes. Only the fields shared among all the document types in the packet template will be visible. If any key icons are displayed next to a field, you may select the Perform key-field lookup link to perform a real-time field lookup. One or more of the fields will be updated.
4. Optional: You can allow field values for the documents to be obtained from an External Data Source when captured by selecting the Perform key-field lookup at capture time checkbox. The key field(s) must be available on the QCards™.
5. Optional: You can include one End-of-Document QCard™ at the end of the packet by selecting the checkbox.
6. Select the Create button to generate the packet of QCards™.
7. Print the QCards™.
8. Place each QCard™ on top of its document to be scanned. Place the optional End-of-Document QCard™ at the end of the packet.
9. Scan the documents using your scanning device.

5. Capturing Paper Documents - Custom Barcode

You can scan documents containing custom barcodes with the Custom Barcode Capture Type, utilizing the DirectScan™ applet.

1. Select the Custom Barcode Capture Type.

2. Select a catalog and document type to add the document to.

3. Select the Continue button to launch the DirectScan applet.

4. Scan the document as described in Section 1.5, “Using The DirectScan™ Applet”.

A QCard™ Packet

QCARD

AC2301

000000PC

Document Properties
Student ID: 3004100320
Student Name: Josh Powers

QCard Packet
6. Capturing Electronic Documents

If you would like to capture documents and/or other files that you have local access to, you may use these features to import those documents or files into Content Central. Single files can be uploaded using the **Capture** frame, and multiple files can be uploaded using the **Drag & Drop Upload** applet in the **Catalog Browser**.

### 6.1. Using the Capture Frame

Files can be individually uploaded using the **Electronic Capture Type** in the **Capture** frame. The following sections describe the various **Coding Methods** available when uploading documents.

**Note**

When uploading an existing **PDF** document, you will be presented with three upload options before the document is committed to the catalog.

- **Capture file in original form**: The document will be left as-is and committed to the catalog with the document properties supplied. If the document does not already contain OCR text for full-text searching, the only information that will be searchable will be the document properties.

- **Convert to a fully-searchable PDF**: The document will be converted to a new **PDF** containing document properties and OCR for full-text searches.

- **Make fully-searchable, but leave file in original form**: Images will be processed for OCR text, but the file will remain in its original format. The OCR and document properties will be stored only in the Content Central database.

The document may be viewed in the area below these options by selecting the **View Document** link. After choosing an upload option, select the **Apply** button to complete the upload process.
6.1.1. Pre-Capture Coding

Use this method of capture when you wish to capture an electronic document and provide the document properties for that document before uploading.

1. Select the **Electronic Capture Type**.

2. Select the **Pre-capture coding Coding Method**.

3. Select a catalog and document type to add the document to.

4. Enter information about the document into the appropriate field text boxes. If any key icons are displayed next to a field, you may select the **Perform key-field lookup** link to perform a real-time field lookup. One or more of the fields will be updated.

5. Browse to the location of the local file.

6. Select the **Upload** button to begin the upload process.
6.1.2. Post-Capture Coding

Use this method of capture when you wish to capture an electronic document and provide the document properties for that document after uploading.

1. Select the Electronic Capture Type.
2. Select the Post-capture coding Coding Method.
3. Select a catalog and document type to add the document to.
4. Browse to the location of the local file.
5. Select the button to begin the upload process.

6.1.3. Versatile Coding

Use this method of capture when you wish to capture an electronic document and provide the document properties for that document before uploading, after uploading, or at both times.

1. Select the Electronic Capture Type.
2. Select the Versatile coding Coding Method.
3. Select a catalog and document type to add the document to.
4. Choose whether you want this document to be sent to your Personal Queue or the Shared Queue.
   
   Note
   
   The Personal Queue is visible to you only. The Shared Queue is visible to you and others with permission to add documents for the selected document type.
   
   5. Enter information about the document into the appropriate field text boxes. If any key icons are displayed next to a field, you may select the Perform key-field lookup link to perform a real-time field lookup. One or more of the fields will be updated.
6. Browse to the location of the local file.

7. Select the **Upload** button to begin the upload process.

6.1.4. **Capture Only**

Use this method of capture when you wish to capture an electronic document without providing any document properties.

1. Select the **Electronic Capture Type**.

2. Select the **Capture only coding Coding Method**.

3. Select a catalog and document type to add the document to.

4. Browse to the location of the local file.

5. Select the **Upload** button to begin the upload process.
Capturing an Electronic File As Is

6.2. Using the Drag & Drop Upload Applets

Documents and other content can be uploaded in three different ways using the Catalog Browser. To access the Catalog Browser, select the button from the main menu followed by the icon in the left frame. Next, select a folder to upload one or more documents into. The following sections describe how to upload documents and other content inside the Catalog Browser.

Selecting a Folder to Upload Documents in the Catalog Browser

6.2.1. Using the Context Menu or File Menu

Any folder in the Catalog Browser tree can be right-clicked to produce a context menu containing the Add Document(s) menu item. This same menu item can be accessed from the File menu in the Results Frame. After selecting this menu item, the Drag & Drop Upload applet will appear in a new window.

The Catalog Browser Context Menu
Files can be queued for upload in two ways. Selecting the Add button will provide you with a browse dialog used to choose one or more files you have local access to.

Select the appropriate Document Type from the drop-down list.

You can also drag folders and files from your computer desktop or a system file explorer and drop them into the area labeled Drop Files Here.

Use the Remove button to remove one or more files from the queue.

After queuing one or more files or folders, select the Upload button to upload the files to the Content Central server. Select the Cancel button to cancel the upload.

The Drag & Drop Upload Dialog

6.2.2. Using the Results-Frame Upload Area

One or more folders or files can be dragged from your computer desktop or system file explorer and dropped into the area of the Results Frame labeled Drop files here to upload.

The upload process will begin immediately after files have been dropped into the designated area. Select the icon to cancel the upload.

Note

The default document type chosen for the catalog will be used to identify the uploaded documents. For more information, see Section 5.6, “Default Document Types”.
7. Creating New Documents From PDF-Form Templates

Use this capture type when you want to generate a new document from a PDF-Form template.

1. Select the **Form Capture Type**.

2. Select a catalog and document type to add the document to.

3. Enter information about the document into the appropriate field text boxes.

4. Select the **Continue** button to load the form.

5. Fill out the form as required.

6. Select the proper submission button in the form to complete the process.
Creating New Documents using a PDF Form

A new document will be created and stored in the selected catalog immediately after submitting the form. When accessed inside Content Central, this new document can be modified and re-submitted to generate a new version of the document automatically.

8. The **Coding Queue**

Any documents that have been captured using *Post-Capture coding* or *Versatile coding* must be fully coded before they will be routed to their appropriate storage area. The *Coding Queue* in your Folders frame holds these documents for you to code.

Two types of documents can exist within the *Coding Queue*. Personal documents are identified by the icon and shared documents are identified by the icon.

**Personal Documents**

Documents captured using the *Post-capture* coding method and documents captured using the *Versatile* coding method with a *Personal Queue* destination will become personal documents. These documents will only appear to the user who captured the documents.

**Shared Documents**

Documents captured using the *Versatile* coding method with a *Shared Queue* destination will become shared documents. These documents will appear to all users who have permission to add documents for the document type selected during the capture process.

Access the Folders frame by selecting the button from the main menu. Select the icon in the Folders frame to obtain the list of documents awaiting the coding process.

The Coding Queue

To begin coding these documents, select the Code Document(s) menu item from the Modify menu. The Document Properties frame will appear on the right side of your browser. Select the catalog and document type, enter appropriate information for any fields listed, then select the button to save changes to the properties and route the document from the queue to the catalog, or select the button to save changes and leave the document in the Coding Queue. When committing the document to the catalog,
Content Central will route the file to the appropriate storage area, and the next document in the results grid will load for coding.

If any key icons are displayed next to a field, you may select the **Perform key-field lookup** link to perform a real-time field lookup. One or more of the fields will be updated.

If a **Use Filing Rules** checkbox is presented, you may choose whether or not the field information will cause the file name to change.

![Coding Documents in the Coding Queue](image-url)
Chapter 7. Searching for Documents

1. Search Procedures

A very common operation for users of a document management system is searching for documents. Search queries are performed in the left frame, results will be displayed in the upper-right frame, and documents will be displayed in the lower-right frame (for document formats having browser plugins).

The Search Frame

Performing a search is as simple as selecting one or more catalogs and document types, entering criteria in one or more field search textboxes, and selecting the button. Some search boxes contain predefined choices that you can select from a list. The most efficient searches result from searching document properties such as Name or Number. These searches will narrow your results down considerably.

You can instead choose to select an existing query from the Saved Searches drop-down list, if available. The saved query will be entered automatically, and the search will be performed automatically if the appropriate option has been enabled. For more information, see Section 5.5, “Saved Searches”.

166
Searching for Documents

A Document properties Search

You may also search for documents using full-text information. This can be used as the only method to search, or it can be combined with document properties. When searching for full text, every occurrence of the word or phrase you use to search will be highlighted when retrieving PDF documents. For more information on full-text searching, see Appendix B, Advanced Search Syntax.

A Full-Text and Document properties Search

To search all versions of documents that match your search criteria, select the Search all versions checkbox.
Searching for Documents

To save your search query, select the Save this search checkbox, provide a Saved-Search Title, and select the Apply button. You can manage these saved searches from your options. See Section 5.5, “Saved Searches”.

2. Searching by Packet

If one or more packet templates have been defined in the system, you will see a checkbox at the top of the search frame named, Search by Packet. Selecting this checkbox will present you with one or more packet templates you can search on. The key field will be displayed depending upon the packet template selected. Enter the key-field value you are searching for, and select the Search button to perform the search. All of the documents in the packet will be returned.

3. QuickSearch

The QuickSearch box in the right-center area of the main menu can be accessed from any location in Content Central. Enter your query in the QuickSearch box and the information provided will be used to search all document types where you have the search permission.

4. Saving Search Results

You may export the full list of search results, which may extend beyond the number of results displayed in the results grid, by selecting the Save Results menu item from the File menu. The data will be exported to an XML file based on the columns visible in the results grid. You will be provided with a dialog box to Open or Save the file to your local machine. Two fields, DocFilename and DocPath, will be included with each result, referencing the real filename and path to the document.
The Open/Save Dialog for Search Results
Chapter 8. Managing Documents

1. Introduction

Documents can be retrieved and managed in several ways using the File, Edit, Modify, View, and Approval Queue menus at the top of the results-grid frame. Some of these menus may not always be available.

2. Viewing a Document in the Browser

The default behavior when selecting a row in the results grid is to open the associated document in the preview area below the results grid. To change this behavior, see Section 5.2, “Preferences”.

A PDF Document Viewed in the Web Browser
3. Streaming a PDF Document

If your administrator has enabled PDF Streaming, only the first page of PDF files will be sent to the preview area. The top of the image will include a watermark indicating PDF Streaming Enabled and the page number(s) that you are viewing from the original.

To view other pages, select one of the menu items from the PDF Streaming menu located above the results grid. You can move forward and backward and also select a specific range of pages to view. To download the original file in the preview area, select Show Full-Page Original from the menu.

4. Downloading Documents

When a browser plugin doesn’t exist for the document you’ve retrieved, you will be provided with a dialog box to Open or Save the document to your local machine. You can also access this dialog by selecting the Download menu item from the File menu.

To save multiple documents, select the checkbox in each document row, and select the Zip & Save menu item in the File menu.
5. E-mailing Documents

You may send one or more documents in the results grid to one or more e-mail recipients by selecting the E-mail menu item from the File menu. When the E-mail Document(s) dialog appears, you may select an available message template from the drop-down list in the top right of the dialog (if visible), or manually add the recipient(s)' E-mail Address(es), a Subject line, and an optional Message.

Selecting the To: or CC: buttons will load your address book. Use this list of contacts to quickly add recipients to your e-mails. After you have selected one or more recipients from the list, select the To: or CC: buttons to queue the recipients. When you are satisfied with your selections, select the button to add them to your e-mail. For information on managing your address book, see Section 5.4, “Address Book”.

When your e-mail is complete, select the button. Recipients are automatically saved to your address book when you send an e-mail.
6. Faxing Documents

You may send one or more documents in the results grid to one or more fax recipients by selecting the Fax menu item from the File menu. When the Fax Document(s) dialog appears, you may select an available message template from the drop-down list in the top right of the dialog (if visible), or manually add the recipient(s)' Fax Number(s), an optional Recipient Name and Company, a Subject line, and some optional Message Text.

Selecting the To: button will load your address book. Use this list of contacts to quickly add recipients to your faxes. After you have selected one or more recipients from the list, select the To: button to queue the recipients. When you are satisfied with your selections, select the button to add them to your fax. For information on managing your address book, see Section 5.4, “Address Book”.

Select the button when finished. Recipients are automatically saved to your address book when you send a fax.
7. Appending to a Document

To append additional pages to an existing document, you will need to first locate the document. When the document is in your results grid, select the appropriate row and select the **Append** menu item from the **Modify** menu. You can append to the document using DirectScan™, QCard™, or **Electronic Upload** by selecting the appropriate menu item.

### 7.1. Appending by DirectScan™

The DirectScan™ applet will launch in a new window. Use this applet to append pages to the document by scanning additional pages. For more information, see [Section 1.5, “Using The DirectScan™ Applet”](#).
7.2. Appending by QCard™

A new window will appear containing an Append Document QCard™. Print this QCard™, place it on top of the additional pages, and scan the document. Content Central will create a new version of the document containing the pages from the most-recent version combined with the scanned pages.

![An Append Document QCard™](image)

7.3. Appending by Electronic Upload

When the Append window appears, Browse to the file containing the additional pages and select the button.

![Appending using Electronic Upload](image)

8. Replacing a Document

To replace the current version of an existing document, you will need to first locate the document. When the document is in your results grid, select the appropriate row and select the Replace menu item from the Modify menu. You can replace a document using DirectScan™, QCard™, or Electronic Upload by selecting the appropriate menu item.
8.1. Replacing by DirectScan™

The DirectScan™ applet will launch in a new window. Use this applet to replace the document by scanning new pages. For more information, see Section 1.5, “Using The DirectScan™ Applet”.

8.2. Replacing by QCard™

A new window will appear containing a Replace Document QCard™. Print this QCard™, place it on top of the new set of pages, and scan the document. Content Central will create a new version of the document containing only the pages scanned.
8.3. Replacing by Electronic Upload

When the Replace window appears, Browse to the new file and select the Upload button.

Replacing using Electronic Upload

9. Editing Documents

Documents can be edited easily using native applications on your Microsoft® Windows® workstation. This requires the Content Director application installed on your local computer.

Note

It's possible to edit documents without the Content Director by manually checking-out, downloading, editing, and checking-in the documents. For more information, see Section 16, “Checking Out/Checking In Documents”.

The Content Central Office Integration application can be installed on any workstation containing Microsoft® Office® to further assist in the document capture and editing process within applications like Word®, Excel®, and Outlook®.

Note

Both Content Director and Content Central Office Integration are client-side applications, and each must be installed on user workstations where their functionality is desired.

9.1. Content Director

The Content Director is responsible for directing documents and other content between the Content Central server and your local computer.

9.1.1. Installation

The installation package for the Content Director application can be accessed from the Options area by selecting the button on the main menu followed by selecting the icon for Downloads and Installers.

Note

The Content Director application runs on only the Microsoft® Windows® platform.
Select *Download Content Central Content Director* to download and/or begin the installation package. Follow the prompts to complete the installation.

The installation package will automatically configure your computer to launch the *Content Director* each time your computer is started. This default behavior can be changed in the settings dialog.

### 9.1.2. Settings

You can access the settings of the *Content Director* by locating the icon in the system tray of your Windows® application bar and right-clicking it followed by selecting the *Settings* menu item.

![The Content Director Settings Dialog](image)

The **Local Document Folder** points to a location on your local computer that will temporarily store documents while they are being edited. When an edited document has been uploaded to the server, the *Content Director* will automatically remove it from this location.

The **Port** setting determines the local Windows® port that will be used for communication to and from the server.

You may select the checkbox labeled **Do not show informational balloon tips** if you do not wish to see notices of downloads and uploads. You may also choose whether the application will automatically **Check for updates** and **Run at Windows startup**.

When you have finished making changes, select the **OK** button to close the settings dialog.

### 9.2. Content Central Office Integration

The *Content Central Office Integration* application (*CCOI*) integrates with your implementation of Office® 2003, 2007, 2010 32-bit, or 2010 64-bit in the form of a custom toolbar that communicates with the Content Central server.
9.2.1. Settings

You can access CCOI settings by clicking the **Settings** button on the CCOI toolbar within your Office® application. This should be accessed the first time CCOI is used.

Service Locations

**CCOI** connects to the Content Central server using Web services. The service locations can be entered in one of two ways.

- **Auto Discover Service URLs**: In most cases, you can provide the URL to Content Central (example: http://servername/ContentCentral) and CCOI will automatically determine the service locations.

- **Manually Configure Services**: The services may need to be entered manually if the server configuration has been customized.

Select the **Test Services** button to verify the service locations entered are valid.

Log in

You must provide your Content Central login information for CCOI to authenticate with the Content Central server. Select the **Test Log In** button to verify these entries.

You may select the checkbox labeled **Notify when working on Read Only files** if you wish to see notices when opening a document that cannot be edited. You may also choose whether the application will **Use temporary folder for new and read only files**. When this option is checked, the application will automatically save new documents to a temporary folder prior to uploading them to Content Central. These files will be automatically deleted when the application is closed.

When you have finished making changes, select the **Save Settings** button to save the settings and close the dialog.
9.2.2. Capturing New Documents

You can capture any Office® document that has not been previously captured by selecting the **Capture New** button on the toolbar. The **Check-In** dialog will launch, allowing you to choose the appropriate destination and document properties for the document.

**Note**

To capture e-mails using Outlook®, select the **Capture emails to Content Central** menu item from the **Content Central** menu.

**Destination**

This selection determines whether the document will be sent directly to a **Catalog** or to the **Coding Queue** for review.

- **Catalog**: The document will be routed to the selected **Catalog**. Any required document properties must be provided before you can **Upload**. These document properties are indicated with bold text.

- **Personal Coding Queue**: The document will be routed to the **Coding Queue**, visible only to you.

- **Shared Coding Queue**: The document will be routed to the **Coding Queue**, visible to you and others with permission to add documents for the document type selected.

**Catalog and Document Type**

Select an appropriate **Catalog** and **Document Type** for the document. These selections can be changed later in the **Coding**
Managing Documents

Queue when the Destination is set to Personal Coding Queue or Shared Coding Queue.

Document Properties

Enter appropriate document properties for the document. Any required fields are indicated with bold text. All fields are optional when the Destination is set to Personal Coding Queue or Shared Coding Queue.

When all selections have been made, select the Upload button to route the document to the Content Central server. You will be prompted to save the file locally if it has not been saved and you have not chosen to use a temporary folder (see Section 9.2.1, “Settings”).

9.2.3. Checking Out a Local Document

If you've loaded an Office® document outside of the Content Central Web application and the document has been previously added to Content Central, you can check out the document by selecting the Check Out button on the CCOI toolbar. This will notify other users in Content Central that you are editing the document.

9.3. Editing a Document

To edit a document, select the results-grid row of a document to modify followed by the Edit Document menu item from the Modify menu. The document will be checked-out from the system automatically and routed to your local machine via the Content Director. Once the file has been downloaded, its native application will launch and load the document.

After modifications have been completed, the document needs to be uploaded to the document server.

9.4. Uploading Changes using CCOI

Use this method of uploading if your document is a Microsoft® Office® document and you have installed CCOI.

After making necessary changes to the document, select the Update Document button on the CCOI toolbar. The new version will be uploaded, and the document will be checked in if previously checked out.
9.5. Uploading Changes without using CCOI

After making necessary changes to the document, close the application, making sure to choose Yes when asked if you would like to save the changes. The Content Director will provide a dialog allowing you to choose your preferred action.

Select the appropriate action, and select the OK button to complete the editing process. If you have chosen to upload the local copy, the Content Director will send the modified document to the server and perform an automatic check in.

The Content Director Upload Dialog

10. Editing Document Properties

If you would like to view or modify document properties for a document, select the results-grid row of a document to modify followed by the Document Properties menu item from the Modify menu. Your left frame will disappear and the right frame containing the Document Properties will appear.

If any key icons are displayed next to a field, you may select the Perform key-field lookup link to perform a real-time field lookup. One or more of the fields will be updated.

If a Use Filing Rules checkbox is presented, you may choose whether or not the updated field information will cause the document folder and file name to also update.

When changing the document type, you will not be able to modify the fields until the document has moved.

Make the necessary changes to the document properties and then click when finished.

Note

System fields appear below the button and are presented for informational purposes only.
11. Viewing Document Version History

Content Central keeps track of document revisions and changes. The current version of a document will always be displayed in results grids. To view all versions of a document, select the Document History menu item from the View menu.

The number to the left of the decimal is the Major Version. The number to the right of the decimal is the Minor Version. The following table outlines how versions are generated.

<table>
<thead>
<tr>
<th>Major Version</th>
<th>Added</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Added as Copy</td>
</tr>
<tr>
<td></td>
<td>Moved</td>
</tr>
<tr>
<td></td>
<td>Checked In</td>
</tr>
<tr>
<td></td>
<td>Appended</td>
</tr>
<tr>
<td></td>
<td>Replaced</td>
</tr>
<tr>
<td></td>
<td>Uploaded Revision</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Minor Version</th>
<th>Properties Updated</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Begin Approval Process</td>
</tr>
<tr>
<td></td>
<td>Approved</td>
</tr>
<tr>
<td></td>
<td>Voted for Approval</td>
</tr>
<tr>
<td></td>
<td>Rejected</td>
</tr>
<tr>
<td></td>
<td>End Approval Process</td>
</tr>
<tr>
<td></td>
<td>Set Priority</td>
</tr>
<tr>
<td></td>
<td>Added/Updated Retention Policy</td>
</tr>
<tr>
<td></td>
<td>Removed Retention Policy</td>
</tr>
</tbody>
</table>
12. Viewing a Packet

Packets are collections of documents that share a key-field value. One or more packet templates can be defined by your administrator and used to link these related documents together in a packet. To view other documents linked to the currently selected document, select the **Packet** menu item from the **View** menu. When more than one packet exists for the source document, you can choose the packet to view by selecting the appropriate packet template from the drop-down menu in the header.

An informational message appears to the right of the menu indicating whether the packet is **Complete** or **Incomplete**. When a packet is incomplete, rows representing the missing document types will appear at the end of the current page of packet documents.
13. Renaming a Document File Name

To rename a document file name, select the **Rename** menu item from the **Modify** menu.

Provide a **New Name** for the file. Select the **Apply** button to rename the file.

![Renaming Document](image)

14. Deleting Documents

To delete one or more documents in your results grid, add a check to each row of the documents you would like to delete. When deleting only one document in your results grid, select that row.

**Note**

If you wish to delete multiple documents and the selected row does not contain a check in its checkbox, Content Central will only delete that selected row's document.

Once you've selected and/or checked the appropriate row(s), select the **Delete** menu item from the **Document Actions** menu. The **Delete Document(s)** dialog will appear.

Review your selections, then select the **Delete** button if you wish to continue. The documents will be removed from the system and the **Delete Document(s)** dialog will close.

![Deleting Multiple Documents](image)
15. Uploading Revisions

To upload a revision, select the **Upload Revision** menu item from the **Modify** menu. **Browse** to the local file for each document you want to upload as a revision. After choosing your files, select the **button to begin the upload process. A new version will be created for each uploaded document.**

![Upload Revised Document(s)](image)

**Uploading Revised Documents**

16. Checking Out/Checking In Documents

16.1. Checking Out Documents

When you need to make changes to the content of one or more documents in your results grid, add a check to each row of the documents you would like to check out. When checking out only one document in your results grid, select that row.

Note

If you wish to check out multiple documents and the selected row does not contain a check in its checkbox, Content Central will only check out that selected row's document.

Once you've selected and/or checked the appropriate row(s), select the **Check Out/In** menu item from the **Modify** menu. The **Check Out/In Document(s)** dialog will appear.

Review your selections, then select the **button if you are satisfied. The Check Out/In Document(s) dialog will reload and those documents that were checked out will allow you to undo the check out process.**

Note

Multiple documents will be compressed into a **ZIP** file for download.
Checking Out Multiple Documents

If any of the documents you selected for check-out were already checked out by another user, you may request that those documents be checked in. You can send a notice to both the user and administrators.

Requesting Documents to be Checked In

If you do not have permission to check out any of the selected documents, you will receive a message listing those documents. You will not be able to check out those documents.
16.2. Checking In Documents

After you've finished modifying documents, you may upload the new file(s) back to Content Central. The easiest way to accomplish this is by accessing these checked-out documents from your Folders frame.

Access the Folders frame by selecting the button from the main menu.

Select the icon in the Folders frame to obtain the list of documents you currently have checked out.
The Checked Out Document List

Just as before when checking out documents, add a check to each row of the documents you would like to check in. When checking in only one document in your results grid, select that row.

Once you've selected and/or checked the appropriate row(s), select the Check Out/In menu item from the Modify menu. The Check Out/In Document(s) dialog will appear.

Review your selection(s), then browse to each document location on your local machine.

Select the button when you are ready to upload the modified documents. The Check Out/In Document(s) dialog will reload after uploading completes, and those documents that were checked in will now be allowed for check-out once more. If you are finished, close the Check Out/In Document(s) dialog.
17. The Approval Queue [Enterprise Edition]

Your Approval Queue contains documents or packets that have been routed to you based on an approval process. Access it by first selecting the Folders button from the main menu followed by the icon from the Folders frame.

Icons displayed in the Approval Queue are as follows:

- Document or packet is a new arrival to the approval process.
- Document or packet has been approved.
- Document or packet has been rejected.

To narrow your view by catalog or document type, select from the drop-down list at the top of the results frame.

After you've performed your designated task(s) related to a document or packet, you can either Approve it or Reject it from the Approval Queue menu. One or more documents and packets can be approved or rejected at the same time.

Note

You may be able to select only the first item in the queue. This is an administrator preference.

If you have permission to set priorities, you may select the Set Priority menu item from the Approval Queue menu.

Most documents or packets arrive on an approval process because they match certain criteria during the capture process or match criteria in a workflow rule; however, it's sometimes necessary to manually place an existing document or packet on an approval process. To accomplish this, select one or more documents or packets from your results grid, and then select the Start Approval Process menu item from the File menu.

When you are viewing a packet, you may choose the Start Packet Approval Process menu item from the File menu to assign the packet to an approval process.
The Approval Queue

17.1. Approving

You can provide a note for the next user or completion of the process for each item you are approving.

If you are presented with a Send to user drop-down list, select one user from the list to be the recipient of the item.

If you are presented with a PIN Required message, you must provide your personal identification number, which can be defined in your options. See Section 5.8, “PIN” for more information.

Confirm your selections and select the button to move the item(s) forward on the approval process. The item(s) will be removed from your Approval Queue.

17.2. Rejecting

You can provide a note for the previous user or completion of the process for each item you are rejecting.

If you are presented with a Send to user drop-down list, select one user from the list to be the recipient of the item.

If you are presented with a PIN Required message, you must provide your personal identification number, which can be defined in your options. See Section 5.8, “PIN” for more information.

Confirm your selections and select the button to send the item(s) backward on the approval process. The item(s) will be removed from your Approval Queue.
17.3. Assigning to an Approval Process

If one or more items to assign are the primary document type for one or more packets, you may choose whether the Assignment Type is for only the Document or for the entire Packet. If the Packet option is selected, choose a packet from the accompanying list. You can select the View Packet link to view all documents in the selected packet.

Select the appropriate approval process for each document you’ve chosen for assignment. You may optionally set the priority for the item and provide a note for the first member in the approval process. If you are presented with a Send to user drop-down list, select one user from the list to be the recipient of the item.

After confirming your selections, select the Assign button. The item(s) will be placed on the respective approval process.
17.4. Setting Priorities

Select the appropriate priority for each item listed. After confirming your selections, select the Assign button. The item(s)' priority will be updated.

17.5. The Admin Queue [Administrators]

The Admin Approval Queue provides a view of all items on all approval processes for document types you can administer. As an administrator you can approve, reject, or set priority on any of the items listed. You can also remove any of the items from their approval process using the Remove from process menu item on the Approval Queue menu.

To enter this view select the Admin Queue link at the top of the results frame. To narrow the view by document type, select a document type from the drop-down list at the top of the results frame.

To return to your personal Approval Queue, select the My Queue link.

17.6. History [Administrators]

The History area provides a view of items that have been previously approved, rejected, or removed from approval processes of all document types you can administer.

To enter this view select the History link at the top of the results frame. To narrow the view by document type, select a document type from the drop-down list at the top of the results frame.

To return to your personal Approval Queue, select the My Queue link.


Your Work Queue contains documents that have been routed to you on an ad hoc basis. Access it by first selecting the Folders button from the main menu followed by the icon from the Folders frame.
Managing Documents

To narrow your view by catalog or document type, select from the drop-down list at the top of the results frame.

After you've performed your designated task(s) related to a document, you can either Move it or Remove it using the Work Queue menu. One or more documents can be moved or removed at the same time.

The Work Queue

18.1. Assigning or Moving Documents to a Work Queue

To assign one or more documents to one or more users or groups, select one or more documents from your results grid, and then select the Send to Work Queue menu item from the File menu.

Note

When assigning a document to a Work Queue from the Work Queue, select the Copy to Queue menu item from the Work Queue menu instead.

To move documents from your Work Queue to another user or group, select the Move to Queue menu item from the Work Queue menu.

Documents are grouped by document type. You can choose one or more users or groups to assign each document group if your administrator has provided you with permission to assign to other users and groups. Selecting the Send to My Queue checkbox will send the document group to only your Work Queue.

You can choose to set an expiration on the selected documents. Each expired document will be automatically removed from the Work Queue. You may be limited on how long a document can exist in the Work Queue.

After confirming your selections, select the Assign button. The documents will be sent to the user(s) and/or group(s) selected. When moving one or more documents, the documents will be removed from your Work Queue.
18.2. Sharing Documents

To share documents with guests or users, select one or more documents from your results grid, and then select the **Share** menu item from the **File** menu.

Select the **Add Recipient** button to add one or more recipients by e-mail address. While adding recipients, you can select the **Address Book** link to access existing e-mail addresses. When providing more than one e-mail address at a time, separate each with a semicolon.

You can choose to set an expiration on the selected documents. Each expired document will be automatically removed from the **Work Queue**. You may be limited on how long a document can exist in the **Work Queue**.

After confirming your selections, select the **Share** button. The documents will be sent to the recipient(s) selected. If any of the recipients do not exist in the system, a new guest user will be created, and an invitation containing login details will be sent to the e-mail address provided.
18.3. Removing Documents

To remove one or more documents from your Work Queue, select the appropriate documents in your results grid followed by the Remove from Queue menu item from the Work Queue menu. Confirm your selections and select the button. The documents will be removed from your Work Queue.

18.4. The Admin Queue [Administrators]

The Admin Work Queue provides a view of all documents in each user's Work Queue for document types you can administer. As an administrator you can assign or remove any of the documents listed.

To enter this view select the Admin Queue link at the top of the results frame. To narrow the view by document type, select a document type from the drop-down list at the top of the results frame.

To return to your personal Work Queue, select the My Queue link.

18.5. Changing Expirations

To change the expiration of one or more documents in the Admin Work Queue, select the appropriate documents in your results grid followed by the Set Expiration menu item from the Work Queue menu. You may be limited on how long a document can exist in the Work Queue. Confirm your selections and select the button. The new expirations will be set on the selected documents.

The Custom Policies folder contains documents having retention policies differing from the document-type retention policy. Access it by first selecting the button from the main menu followed by selecting the icon from the Folders frame.

19.1. Defining Custom Retention Policies

To override the default retention policy for one or more documents, select the Set Retention Policy menu item from the Modify menu.
First, choose the length of time each document should be retained in the catalog. You can alternatively select the **Retain Indefinitely** checkbox to prevent the document from being removed at any time. To remove a custom retention policy, select the **Remove policy** checkbox.

Select the **Apply** button to save your changes.

![DocumentRetentionPolicyOverride](image)

**Defining Custom Retention Policies**

### 20. The Catalog Browser

The **Catalog Browser** within the **Folders** frame displays documents as they appear on the file system. Access the **Folders** frame by selecting the **Folders** button from the main menu. Select the **Folder** icon in the left frame to display the browser tree.

Files within the selected folder will appear in the results grid, and document actions may be performed on one or more selected documents. Navigate the browser tree by selecting the expand (+) and collapse (-) icons. If your administrator has enabled paging, you may see an additional row indicating the current page number of subfolders along with **Prev** and **Next** controls to navigate through the subfolder list. You can also enter a number in the empty textbox to advance to a specific page of subfolders.
20.1. Cut, Copy, & Paste

The **Edit** menu can be used to **Cut & Paste** or **Copy & Paste** selected documents in the results grid from one folder to another.

20.1.1. Cut & Paste (Move)

1. Select one or more documents from the results grid displaying the items to cut.
2. Select the **Cut** menu item from the **Edit** menu.
3. Select the new folder to move the documents into.
4. Select the **Paste** menu item from the **Edit** menu.
20.1.2. Copy & Paste (Copy)

1. Select one or more documents from the results grid displaying the items to copy.
2. Select the Copy menu item from the Edit menu.
3. Select the new folder to copy the documents into.
4. Select the Paste menu item from the Edit menu.

20.2. The Context Menu

Access the context menu by right-clicking any folder in the Catalog Browser tree in the left frame. The following operations can be performed using the context menu:

- **New Folder**: Creates a subfolder within the selected folder. After selecting this menu item, you need to enter a name for the new folder.
- **Rename Folder**: Allows you to rename the selected folder. After selecting this menu item, you need to enter the new name for the existing folder.
- **Delete Folder**: Removes the selected folder from the selected catalog. The folder must be empty.
- **Add Document(s)**: Loads the Drag & Drop Upload applet to upload new documents or other content. For more information, see Section 6.2.1, “Using the Context Menu or File Menu”.
- **Properties (Administrators)**: Allows the folder selected to be assigned to a specific document type. For more information, see Section 20.3, “Assigning Document Types to Folders [Administrators]”.

20.3. Assigning Document Types to Folders [Administrators]

The Folder Properties dialog allows administrators to assign a document type to the folder selected.
If the **Inherit Settings** checkbox is selected, the selected folder will use the settings of its parent.

To assign a document type, uncheck the **Inherit settings** checkbox and choose the appropriate document type.

Selecting the **Hide folder** checkbox will hide the selected folder from any user who does not have the **View** permission for the selected document type.

Selecting the **Apply to all subfolders** checkbox will apply the selections to all subfolders.

Select the **Apply** button when you are finished.

After assigning a document type, documents landing in this folder from a drag-and-drop upload will inherit the document type assigned.

**Note**

Assigning a document type to a folder overrides each user's default document type for the catalog when performing a drag-and-drop upload.
Chapter 9. The Messages Folder

The Messages folder contains system message and notifications. Access it by first selecting the button from the main menu. Select the icon in the Folders frame to display the Messages folder. A copy of each message can be automatically sent to your e-mail address. For more information, see Section 5.2, “Preferences”.

Icons displayed in the Messages folder are as follows:

- Message Unread
- Message Read

The following are some of the message types that can exist in your Messages folder:

**Document Check-In Request**

This message will be sent to you when another user has requested that a checked-out document be checked in, and you are the user who has previously checked out the document. Some of these documents may be in your Approval Queue [Enterprise Edition].

**New Document in Approval Queue [Enterprise Edition]**

This message will be sent to you when a document arrives in your Approval Queue. This notification can be enabled or disabled in your User Preferences.

**Zonal OCR Warning [Enterprise Edition]**

When the Capture Service processes a captured document with zonal OCR, and the extracted text does not match the format of the document-type field, a message will be sent to you indicating the document to find in your Coding Queue. This notification can be enabled or disabled in your User Preferences.

**Unprocessed File Notification (Administrators only)**

When the Capture Service has trouble processing one or more image files, a message will be sent to you indicating the problem encountered along with the full path to the problem file(s). This notification can be enabled or disabled in your User Preferences.

The Message Actions menu allows you to mark one or more messages as Read or Unread. You may also Delete one or more messages from the list.
The Messages Folder

MThomas:
CMorgan has requested you check-in the document "Josh Powers - Application for Admission.pdf" from catalog "Student Records" to Content Central.

This is an automated message. Please do not reply to this message.

--Content Central
Chapter 10. Mobile Site

The Content Central Mobile site is designed for mobile devices like smart phones and tablets. It contains a subset of tools that are available in the full application.

1. Connecting to the Mobile Site

To access Content Central Mobile you will need to launch your preferred Web browser on your mobile device and enter the URL (address) for Content Central. In most cases, your mobile device will be automatically detected, and the mobile version of Content Central will be launched.

To access the mobile site manually, enter /mobile at the end of the URL for Content Central. For example, if your Content Central URL is http://contentcentral.domain.comm/, the mobile site will be located at http://contentcentral.mydomain.comm/mobile/.

Once you've successfully accessed Content Central Mobile, you will need to provide your Username and Password. Use the same credentials you would use for the full site and select the Login button. To navigate to the full version of Content Central, select the Full Site button.

If you would like to prevent having to log in each time, select the Keep me logged in checkbox.

**Note**

This option may not be available in all configurations. Selecting the Logout button on the main menu will require you to log in again.

2. The Main Menu

The main menu is displayed after you login. From the main menu you can access the mobile versions of the Approval Queue and the Catalog Browser. You can also Logout of the mobile site.
3. The Approval Queue

Your Approval Queue contains documents or packets that have been routed to you based on an approval process. Access it by selecting Approval Queue button from the main menu.

Only one document at a time is displayed in this mobile version of the Approval Queue. Use the Previous and Next buttons at the top of the page or the navigation menu on the next line to access other documents in your queue.

Select the View/Save button to download the current document.

The center portion of the page describes various aspects of the current document as it relates to the approval process.

To approve or reject a document, enter an optional Note for approval/rejection and select the Approve or Reject button.

In some cases, you may need to select a specific user recipient for approval or rejection and/or enter your personal PIN.

To return to the main menu, select the Home button. To logout, select the Logout button.
4. The Catalog Browser

The Catalog Browser allows you to navigate through folders of documents you can access in the system. Access it by selecting Catalog Browser button from the main menu.

4.1. Folder View

The Catalog Browser is divided into two views: folder and file. The folder view is displayed when you first enter the Catalog Browser. The navigation area at the top of the page keeps track of your location. You can select an individual folder from this panel to jump directly to that folder.

To navigate into a folder, select any link from the left column. To view a list of documents for the listed catalog folder, select the Documents link in the right column.

To move back one folder level, select the Back button at the bottom of the page. To return to the main menu, select the Home button. To logout, select the Logout button.

4.2. File View

When selecting a Documents link, you will be presented with the file view. Just as in folder view, the navigation area at the top of the page displays your current location. You can select an individual folder from this panel to jump directly to that folder view.

Only one document is displayed at a time in file view. The navigation area below your current location allows you to move to the Previous or Next document in the folder. The center portion of the page describes the name of the current document as well as its catalog and document type.

Select the View/Save button to download the current document.

To move back to folder view, select the Back button at the bottom of the page. To return to the main menu, select the Home button. To logout, select the Logout button.
Part IV. Advanced Features
Chapter 11. Creating Multiple Catalogs from a Template (Batch Creation)

Some environments will require a large number of catalogs to be created at the point of installation. An example of this would be a corporation made up of independent branch locations across a wide area. In this setting, it may be desirable to create a unique catalog for each of the branches, while storing the documents from each branch at the corporate headquarters. The Batch New option from within the Catalog Manager will help you accomplish this task more efficiently.

Prior to the batch creation of catalogs, you will need a template catalog and a load file. Create this catalog as described in Section 2.1, “Creating a New Catalog”.

The following items contained in the template catalog will be copied to each generated catalog:

- All document types and their settings
- Advanced Settings (in Catalog Manager)
- Update Schedule (in Catalog Manager)

In addition existing users and groups can be included in the generated catalogs.

The final requirement necessary to generate multiple catalogs is a comma-delimited load file containing your desired catalog names (and optional descriptions), each on its own line.

**Example 11.1. Sample Load File**

Branch100,"West Palm Beach - Mgr. Mark Thomas"
Branch120,"Salt Lake City - Mgr. Herb Mylett"
Branch240,"Los Angeles - Mgr. Cindy Morgan"
Branch268,"New York - Mgr. Jorge Cruz"

Once you've created a template catalog and load file, you may launch the Catalog Manager from the desktop shortcut labeled Catalog Manager.

Select the Manage Catalogs button. The management dialog will load.

Select the Batch New button. The Batch Catalog Creation Wizard will load. Choose the catalog you wish to use as the template, and then Browse to the location of your load file. If you wish to modify
the base folder for any of the data folders, you may **Browse** to each of the locations. Subdirectories will be created within these base folders using the name of each new catalog. You can also edit the template **Capture Jobs** or add new ones. Select the **Next** button to continue.

The **Batch Catalog Creation Wizard**

You are now given four options dealing with new user and group creation. Only one user and/or group will be created for each catalog, each of which will use the same name as the new catalog. When choosing to create a new user, you may specify if the newly created users will be allowed to update their profile and/or password. Choose your desired option (no user or group, user only, group only, or both) and select **Next** to continue.

Selecting the New User and Group Creation Option

If you previously chose the option to create a new user for each catalog, you will now be given the ability to define the users’ permissions within the catalog they will belong to. If you chose to specify both a user and group, you may not need to define permissions for the user, as the user will be assigned to the new group and you may wish to define permissions at the group level. You can also choose to **Add** each new user to an existing group in the system. When you’ve finished, select **Next** to continue.
Selecting the New Users' Catalog Permissions

If you previously chose the option to create a new group for each catalog, you will now be given the ability to define the groups' permissions within the catalog they will belong to. You can also choose to Add existing users in the system to the each of the new groups. When you've finished, select Next to continue.

Selecting the New Groups' Catalog Permissions

Now you may choose to Add existing users in the system to each of the new catalogs' membership. You may define permissions to the generated catalogs for each user. Simply select a user in the list followed by the permissions to be granted for that user. Repeat for each user in the list as necessary, then select Next to continue.
Creating Multiple Catalogs from a Template (Batch Creation)

Adding Existing Users to the New Catalogs

Now you may choose to **Add** existing groups in the system to each of the new catalog's membership. You may define permissions to the generated catalogs for each group. Simply select a group in the list followed by the permissions to be granted for that group. Repeat for each group in the list as necessary, then select **Next** to continue.

Adding Existing Groups to the New Catalogs

You will now see a summary of the items you selected in the batch-creation wizard. If you are satisfied with the selections, you may select the **Finish** button. A progress dialog will launch and the batch-creation process will begin.
Creating Multiple Catalogs from a Template (Batch Creation)

If new users were generated, you must **Save Passwords** before exiting the wizard. Once you’ve saved the passwords, you may select the **OK** button to return to the management dialog. You should now have multiple catalogs listed in the management dialog with names matching what was in your load file.
Appendix A. Supported File Types with Existing Content

As of version 6.5.x these are the supported file types that the Catalog Service will recognize for existing content and metadata.

Adobe Acrobat (*.pdf)
Ami Pro (*.sam)
Ansi Text (*.txt)
ASCII Text
ASF media files (metadata only) (*.asf)
CSV (Comma-separated values) (*.csv)
DBF (*.dbf)
EBCDIC
EML files (emails saved by Outlook Express) (*.eml)
Enhanced Metafile Format (*.emf)
Eudora MBX message files (*.mbx)
GZIP (*.gz)
HTML (*.htm, *.html)
JPG (*.jpg)
Lotus 1-2-3 (*.wk?, *.123)
MBOX email archives (including Thunderbird) (*.mbx)
MHT archives (HTML archives saved by Internet Explorer) (*.mht)
MIME messages
MSG files (emails saved by Outlook) (*.msg)
Microsoft Access MDB files (*.mdb)
Microsoft Document Imaging (*.mdi)
Microsoft Excel (*.xls)
Microsoft Excel 2003 XML (*.xml)
Microsoft Excel 2007 (*.xlsx)
Microsoft Outlook/Exchange
Microsoft Outlook Express 5 and 6 (*.dbx) message stores
Microsoft PowerPoint (*.ppt)
Microsoft PowerPoint 2007 (*.pptx)
Microsoft Rich Text Format (*.rtf)
Microsoft Searchable Tiff (*.tiff)
Microsoft Word for DOS (*.doc)
Microsoft Word (*.doc)
Microsoft Word 2003 XML (*.xml)
Microsoft Word 2007 (*.docx)
Microsoft Works (*.wks)
MP3 (metadata only) (*.mp3)
Multimate Advantage II (*.dox)
Multimate version 4 (*.dox)
Quattro Pro (*.wb1, *.wb2, *.wb3, *.qpw)
TAR (*.tar)
TIF (*.tif)
TNEF (winmail.dat)
Ttreepad HJT files (*.hjt)
Unicode (UCS16, Mac or Windows byte order, or UTF-8)
Windows Metafile Format (*.wmf)
WMA media files (metadata only) (*.wma)
WMV video files (metadata only) (*.wmv)
WordPerfect 4.2 (*.wpd, *.wpf)
WordPerfect (5.0 and later) (*.wpd, *.wpf)
WordStar versions 1, 2, 3 (*.ws)
WordStar versions 4, 5, 6 (*.ws)
WordStar 2000
Write (*.wri)
XBase (including FoxPro, dBase, and other XBase-compatible formats) (*.dbf)
XML (*.xml)
XML Paper Specification (*.xps)
XSL
XyWrite
ZIP (*.zip)
Appendix B. Advanced Search Syntax

1. Search Requests

Content Central supports three types of full-text search requests:

Any Words An *any words* search is any sequence of text, such as a sentence or question. In this type of search, use quotation marks around phrases, place a + in front of any word or phrase that is required, and place a - in front of a word or phrase to exclude it.

**Example B.1. Any-Words Request**

banana pear "apple pie"
"apple pie" -salad +"ice cream"

All Words An *all words* search request is similar to an *any words* request expect that all of the words in the search request must be present for a document to be found.

Boolean A search request consists of word or phrase groups linked by connectors such as *AND* and *OR*, which indicate the relationship between them.

**Table B.1. Boolean Search Requests**

<table>
<thead>
<tr>
<th>Request</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>apple and pear</td>
<td>both words must be present</td>
</tr>
<tr>
<td>apple or pear</td>
<td>either word can be present</td>
</tr>
<tr>
<td>apple w/5 pear</td>
<td>apple must occur within 5 words of pear</td>
</tr>
<tr>
<td>apple not w/5 pear</td>
<td>apple must occur, but not within 5 words of pear</td>
</tr>
<tr>
<td>apple and not pear</td>
<td>only apple must be present</td>
</tr>
</tbody>
</table>

If you use more than one connector, use parentheses to indicate precisely what you want to search for. For example, *apple and pear or orange* could mean *(apple and pear) or orange*, or it could mean *apple and (pear or orange)*.

Noise words, such as *if* and *the*, are ignored.

Search terms may include the following special characters:

**Table B.2. Special Characters**

<table>
<thead>
<tr>
<th>Character</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>?</td>
<td>matches any character</td>
</tr>
<tr>
<td>=</td>
<td>matches any single digit</td>
</tr>
<tr>
<td>*</td>
<td>matches any number of characters</td>
</tr>
<tr>
<td>~~</td>
<td>range search</td>
</tr>
</tbody>
</table>

2. Words and Phrases

To search for a phrase, use quotation marks around it.
Example B.2. Phrase Search

apple w/5 "fruit salad"

If a phrase contains a noise word, the search engine will skip over the noise word when searching for it. For example, when search for *statue of liberty*, the engine would retrieve documents containing the word *statue*, any intervening word, and the word *liberty*.

Punctuation inside of a search word is treated as a space. Example: *can't* would be treated as a phrase consisting of two words: *can* and *t*.

3. Wildcards

A search word can contain the wildcard characters * and ?. A ? in a word matches any single character, and a * matches any number of characters. The wildcard characters can be in any position in a word. For example:

*appl* would match *apple*, *application*, etc. *cipl* would match *principle*, *participle*, etc. *appl?* would match *apply* and *apple* but not *apples*. *ap*ed would match *applied*, *approved*, etc.

Use of the * wildcard character near the beginning of a word will slow searches somewhat.

The = wildcard matches any single digit. For example: *N===* would match *N123* but not *N1234* or *Nabc*.

4. Fuzzy Searching

Fuzzy searching will find a word even if it is misspelled. For example, a fuzzy search for *apple* will find *apppe*. Fuzzy searching can be useful when you are searching text that may contain typographical errors, or for text that has been scanned using optical character recognition (OCR).

Add fuzziness selectively using the % character. The number of % characters you add determines the number of differences the search engine will ignore when searching for a word. The position of the % characters determines how many letters at the start of the word have to match exactly. Examples: *ba%nana*: Word must begin with *ba* and have at most one difference between it and *banana*. *b%%anana*: Word must begin with *b* and have at most two differences between it and *banana*.

5. Phonic Searching

Phonic searching looks for a word that sounds like the word you are searching for and begins with the same letter. For example, a phonic search for *Smith* will also find *Smithe* and *Smythe*.

To ask the search engine to search for a word phonically, put a # in front of the word in your search request. Examples: *#smith*, *#johnson*

6. Stemming

Stemming extends a search to cover grammatical variations on a word. For example, a search for *fish* would also find *fishing*. A search for *applied* would also find *applying*, *applies*, and *apply*.

To add stemming selectively, add a ~ at the end of words that you want stemmed in a search. Example: *apply~* The stemming rules included with the search engine are designed to work with the English language.
7. Numeric Range Searching

A numeric range search is a search for any numbers that fall within a range. To add a numeric range component to a search request, enter the upper and lower bounds of the search separated by `~~` like this: `apple w/5 12~~17`. This request would find any document containing `apple` within 5 words of a number between 12 and 17.

**Note**

A numeric range search includes the upper and lower bounds (so 12 and 17 would be retrieved in the above example).

**Note**

Numeric range searches only work with positive integers.

**Note**

For purposes of numeric range searching, decimal points and commas are treated as spaces and minus signs are ignored. For example, `-123,456.78` would be interpreted as: `123 456 78` (three numbers). Using alphabet customization, the interpretation of punctuation characters can be changed. For example, if you change the comma and period from space to ignore, then `123,456.78` would be interpreted as `12345678`.

8. AND Connector

Use the **AND** connector in a search request to connect two expressions, both of which must be found in any document retrieved. For example: `apple pie and poached pear` would retrieve any document that contains both phrases. `(apple or banana) and (pear w/5 grape)` would retrieve any document that (1) contains either `apple` OR `banana`, AND (2) contains `pear` within 5 words of `grape`.

9. OR Connector

Use the **OR** connector in a search request to connect two expressions, at least one of which must be found in any document retrieved. For example, `apple pie or poached pear` would retrieve any document that contained `apple pie`, `poached pear`, or both.

10. W/N Connector

Use the **W/N** connector in a search request to specify that one word or phrase must occur within N words of the other. For example, `apple w/5 pear` would retrieve any document that contained `apple` within 5 words of `pear`. The following are examples of search requests using **W/N**:

(1) (apple or pear) w/5 banana
(2) (apple w/5 banana) w/10 pear
(3) (apple and banana) w/10 pear

The **pre/N** connector is like **W/N** but also specifies that the first expression must occur before the second. Example:
(apple or pear) pre/5 banana

Some types of complex expressions using the W/N connector will produce ambiguous results and should not be used. The following are examples of ambiguous search requests:

(apple and banana) w/10 (pear and grape)
(apple w/10 banana) w/10 (pear and grape)

In general, at least one of the two expressions connected by W/N must be a single word or phrase or a group of words and phrases connected by OR. Example:

(apple and banana) w/10 (pear or grape)
(apple and banana) w/10 orange tree

11. **NOT and NOT W/N**

Use NOT in front of any search expression to reverse its meaning. This allows you to exclude documents from a search. Example:

apple sauce and not pear

NOT standing alone can be the start of a search request. For example, not pear would retrieve all documents that did not contain pear.

If NOT is not the first connector in a request, you need to use either AND or OR with NOT:

apple or not pear
not (apple w/5 pear)

The NOT W/ ("not within") operator allows you to search for a word or phrase not in association with another word or phrase. Example:

apple not w/20 pear

Unlike the W/ operator, NOT W/ is not symmetrical. That is, apple not w/20 pear is not the same as pear not w/20 apple. In the apple not w/20 pear request, the search engine searches for apple and excludes cases where apple is too close to pear. In the pear not w/20 apple request, the search engine searches for pear and excludes cases where pear is too close to apple.
Appendix C. Supported Bar Code Symbologies

As of version 6.5.x these are the supported bar code symbologies that the Capture Service will recognize when one or more recognition zones have been defined in a document type.

Codabar
Code 11
Code 128
Code 128 (EAN-128)
Code 3 of 9
EAN-13
EAN-8
Industrial 2 of 5 (Code 25)
Interleaved 2 of 5
Matrix 2 of 5
Plessey
UPC-A
UPC-E
Appendix D. Supported ODBC Providers

As of version 6.5.x these are the supported ODBC providers that Content Central can use in External Data Sources.

FoxPro
Microsoft® Access®
Microsoft® Excel®
Microsoft® SQL Server
MySQL
Oracle
Pervasive
ProvideX (Sage)
Quickbooks QODBC (FLEXquarters)